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about this 
guide

About this Guide
About this Guide

This user guide provides information to help you:

■ Understand Web Tools

■ Configure and use Web Tools Fabric View

■ Configure and use Web Tools Port View

■ Contact technical support for additional assistance

“About this Guide” topics include:

■ Overview, page 18

■ Conventions, page 19

■ Getting Help, page 21
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Overview
This section covers the following topics:

■ Intended Audience

■ Related Documentation

Intended Audience
This book is intended for use by system administrators who are experienced with 
the following:

■ HP StorageWorks Fibre Channel SAN switches

■ Fabric Operating System V3.1.x or later

Related Documentation
For a list of related documents included with this product, see the Related 
Documents section of the Release Notes that came with your switch.

For the latest information, documentation, and firmware releases, please visit the 
following StorageWorks website: http://www.hp.com/country/us/eng/
prodserv/storage.html

For information about Fibre Channel standards, visit the Fibre Channel 
Association website, located at: http://www.fibrechannel.org.

http://www.hp.com/country/us/eng/prodserv/storage.html
http://www.hp.com/country/us/eng/prodserv/storage.html
http://www.fibrechannel.org


About this Guide

Web Tools Version 3.1.x/4.1.x User Guide 19

Conventions
Conventions consist of the following:

■ Document Conventions

■ Text Symbols

Document Conventions
The document conventions included in Table 1 apply in most cases.

Text Symbols
The following symbols may be found in the text of this guide. They have the 
following meanings.

WARNING:  Text set off in this manner indicates that failure to follow 
directions in the warning could result in bodily harm or death.

Caution:  Text set off in this manner indicates that failure to follow directions 
could result in damage to equipment or data.

Table 1:  Document Conventions

Element Convention
Cross-reference links Blue text: Figure 1
Key and field names, menu items, 
buttons, and dialog box titles

Bold

File names, application names, and text 
emphasis

Italics

User input, command and directory 
names, and system responses (output 
and messages)

Monospace font

COMMAND NAMES are uppercase 
monospace font unless they are 
case-sensitive

Variables <monospace, italic font>

Website addresses Blue, underlined sans serif font text: 
http://www.hp.com
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Note:  Text set off in this manner presents commentary, sidelights, or interesting points 
of information.
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Getting Help
If you still have a question after reading this guide, contact an HP authorized 
service provider or access our website: http://www.hp.com.

HP Technical Support
Telephone numbers for worldwide technical support are listed on the following 
HP website: http://www.hp.com/support/. From this website, select the country 
of origin.

Note:  For continuous quality improvement, calls may be recorded or monitored.

Be sure to have the following information available before calling:

■ Technical support registration number (if applicable)

■ Product serial numbers

■ Product model names and numbers

■ Applicable error messages

■ Operating system type and revision level

■ Detailed, specific questions

HP Storage Website
The HP website has the latest information on this product, as well as the latest 
drivers. Access storage at: http://www.hp.com/country/us/eng/prodserv/
storage.html. From this website, select the appropriate product or solution.

HP Authorized Reseller
For the name of your nearest HP authorized reseller:

■ In the United States, call 1-800-345-1518

■ In Canada, call 1-800-263-5868

■ Elsewhere, see the HP website for locations and telephone numbers: 
http://www.hp.com.

http://www.hp.com/support/
http://www.hp.com
http://www.hp.com/country/us/eng/prodserv/storage.html
http://www.hp.com/country/us/eng/prodserv/storage.html
http://www.hp.com
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1Introducing HP Web Tools

This chapter provides the following information:

■ Overview, page 24

■ Web Tools Main Views, page 27

■ Web Tools in Secure Mode, page 34
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Overview
Web Tools provides a graphical interface that enables an administrator to monitor 
and manage entire fabrics and individual switches and ports from a standard 
workstation. 

Advantages of Web Tools
Web Tools is an excellent partner to the traditional Fabric OS CLI commands, and 
in many ways can provide faster and more effective results than can be achieved 
strictly through a Command Line Interface. 

The following are some of the features that make Web Tools an important part of 
the switch management and administration process:

■ Web Tools can be used from a standard workstation and provides the user the 
advantage of being “virtually” in front of any fabric, switch, or port. 

■ Web Tools makes zoning a simple “click and drag” process, rather than 
having to tediously type out IP addresses and port numbers to put in a 
configuration. 

■ Web Tools provides the “Performance Monitor” feature. This feature allows 
you to view the status and traffic of a switch or port in seconds by easily 
creating a variety of effective graphs. 

■ Web Tools is easy and intuitive to use. 

■ Web Tools supports Secure Fabric OS. For more information, see the HP 
StorageWorks Secure Fabric OS Version 1.0 User Guide. 

Capabilities of Web Tools
Web Tools provides the following information and capabilities:

■ Monitoring and managing the entire fabric. See “Fabric Management” on 
page 187.

■ Monitoring and managing individual switches. See “Switch Management” on 
page 61.

■ Monitoring and managing individual ports. See “Port Management” on 
page 249.

When monitoring and managing the entire fabric, Web Tools allows you to 
perform the functions shown in Table 2.
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When monitoring and managing individual switches, Web Tools allows you to 
perform the shown in Table 3.

Table 2:  Fabric Management Tasks 

Task Page Number
View the status of all the switches in the 
fabric.

See “Fabric Management” on 
page 187.

Access event logs for entire fabric. See “About Fabric Events” on 
page 190.

Set-up and manage Zoning functions. See “Zone Administration” on 
page 199.

Access to the Name Server Table. See “About the Name Server” on 
page 195.

Access Telnet functions. See “About the Telnet Button” on 
page 71.

View the Topology information for the 
fabric. 

See “About the Fabric Topology” on 
page 192.

Utilize switch beaconing for rapid 
identification of a single switch in large 
fabric environments.

See “About the Beacon Button” on 
page 76.

Create and zone QuickLoops (optionally 
licensed). 

See “Loop Tab Example” on page 260, 
“Using the Network Config Tab” on 
page 102, or “About Zone 
Administration” on page 200.

Table 3:  Switch Management Tasks 

Task Page Number
View summary information about each 
switch.

See “About the Switch Info Button” on 
page 78.

View event logs for individual switches. See “About the Switch Events Button” on 
page 67.

Perform switch configuration and 
administration.

See “Switch Admin Window” on 
page 92 and “About the Switch 
Information Tab” on page 95.
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When monitoring and managing individual ports, Web Tools allows you to 
perform the shown in Table 4.

Monitor switch and port performance. See “Performance Monitoring” on 
page 149.

Utilize the ability to upgrade Fabric OS 
and license key administration.

See “About the License Admin Tab” on 
page 149.

Utilize report capability for switch 
configuration information.

See “About the Switch Information Tab” 
on page 95.

Table 4:  Port Management Tasks 

Task Page Number
View the port status. See “Using the Port Graphic” on 

page 254.
View information about SFP Serial IDs. See “SFP Tab Example” on page 258.
View and manage loop information. See “Loop Tab Example” on page 260, 

“Using the Network Config Tab” on 
page 102, or “Zone Tab Field 
Descriptions” on page 224.

View port performance, including frame 
counts (frames in, frames out) and error 
counts.

See “Performance Monitoring” on 
page 149.

Table 3:  Switch Management Tasks  (Continued)

Task Page Number
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Web Tools Main Views
Web Tools provides access to and information about a fabric through a number of 
separate windows, called “views,” making it possible to manage and monitor 
several aspects of a fabric at the same time.

The Web Tools window is divided into two frames. The main views available 
through Web Tools are:

■ Fabric Tree which displays a list of all the switches in the fabric.

■ Switch View which displays a interactive graphical representation of the 
switch, along with a synopsis of information about the switch including 
information such as: Switch Status, Switch Name, Fabric OS Version, 
Domain ID, IP address, WWN, and current zone configuration.

An example of the Web Tools Switch Explorer View for a Core Switch 2/64 is 
displayed in Figure 1. 
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Figure 1:  Web Tools Switch Explorer View for a Core Switch 2/64

Fabric Tree
The Fabric Tree is the left window of the Switch Explorer and displays:

■ A list of all the switches in the fabric. You can use the drop-down menu to 
view these switches by Switch Name, IP address, or WWN. The background 
color displays the current status of the switch.

■ A Fabric Admin toolbar which provides access to fabric level administration 
functionality including: Fabric Events, Topology, Name Server, and Zoning 
Admin. 
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Note:  The Switch View status is updated approximately once every 15 seconds. The 
Fabric Tree status is updated approximately every 30 seconds. However, the initial 
display of the Switch Explorer may take from 30 to 60 seconds after the switch is 
booted. 

Note:  For all status displays that are based on errors per time interval, errors will not 
cause the status to change to faulty until the entire sample interval has passed.

An example of the Fabric Tree is displayed in Figure 2.

Figure 2:  Fabric Tree

Fabric Management Toolbar
The Fabric Management toolbar enables you to access fabric-wide administration 
tasks quickly and easily. An example of the Fabric Management Toolbar is shown 
in Figure 3.

Figure 3:  Fabric Management Toolbar

The following options are available through the Fabric Management toolbar:
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Switch View
This view displays a graphical representation for the selected switch, including a 
real-time view of switch status. This view is accessed by selecting a switch icon 
on Fabric Tree. The Switch View is also the launch point for the Switch Events 
View, Telnet Interface, Fabric Watch View, Administrative Interface, Performance 
View, and Port Information View. It includes buttons that display the status of the 
switch fans, temperature monitors, switch info, power supply, and beacon.

An example of the Switch View is shown in Figure 4.

Fabric Events

Topology (fabric-wide)

Name Server (fabric-wide)

Zone Admin (displays current zone configuration)



Introducing HP Web Tools

31Web Tools Version 3.1.x/4.1.x User Guide

Figure 4:  Switch View

For information about the functions that are accessible through the Switch View, 
see “About Switch Management” on page 62.

The Switch Management View displays the following options:

■ Status of the switch. See “About the Switch Status Button” on page 65.

■ Switch Event. See “About the Switch Events Button” on page 67.

■ Administrative management. See “About the Admin Button” on page 70.

■ Telnet access. See “About the Telnet Button” on page 71.
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■ Performance Monitoring of the switches. See “About Performance Monitor” 
on page 150.

■ Beaconing switches. See “About the Beacon Button” on page 76.

■ Information on the switch. See “About the Switch Info Button” on page 78.

■ Fabric Watch (alarm settings). See “About Fabric Watch” on page 172.

■ Fan status. See “About the Fan Button” on page 81.

■ Temperature of the switch. See “About the Temp Button” on page 82.

■ Power status. See “About the Power Button” on page 83.

■ Hi Availability. See “About HA Admin” on page 84.
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Port Information View
Access information for a port by clicking on any of the ports in the Switch View. 
This view displays statistics and status for the selected port, SFP, or loop.

For information about the functions that are accessible through the Port View, see 
“Port Management” on page 249.

An example of the Port Information View is shown in Figure 5.

Figure 5:  Port Information View
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Web Tools in Secure Mode
The Security feature may change your ability to access Web Tools functionality 
when Secure Mode is enabled. For more information on the Security feature see 
the HP StorageWorks Secure Fabric OS Version 1.0 User Guide. 

Web Tools Access and the HTTP_POLICY
When Secure Mode is enabled, access to the Web Tools interface is controlled by 
the HTTP_POLICY. If Secure Mode is enabled and an HTTP_POLICY has been 
defined, your workstation IP address must be included in this policy or you will 
not have access to Web Tools for any switch in the fabric. If your workstation IP is 
not included in this policy, the interface disabled page will display when you 
attempt to access a switch. 

Primary FCS Only Functionality
The following Web Tools functionality is reserved for the Primary Fabric 
Configuration Server (FCS) when Secure Mode is enabled:

■ Zoning Administration is only allowed from the Primary FCS switch when 
Secure Mode is enabled. For all other switches in a secure fabric, the Zoning 
Button is disabled. 

■ SNMP Access Control Lists and the SNMP Community Strings can only be 
modified from the Primary FCS switch when Secure Mode is enabled. For 
Non-FCS switches, you can view the SNMP Community Strings but they are 
read only, and the SNMP Access Control Lists are not displayed. 

Disabled Functionality
Telnet access to a switch and the Telnet Button in Web Tools are both disabled 
when Secure Mode is enabled for a fabric. You must use sectelnet or SSH to 
access the Fabric OS command line interface in a secure fabric. These capabilities 
are not accessible from Web Tools. 
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2Installation

This chapter provides the following information:

■ Requirements, page 36

■ Installing Prerequisite Software on a Workstation, page 38

■ Licensing Web Tools on the Switch, page 41

■ Launching HP Web Tools, page 43
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Requirements
The workstation and the switch must meet both specific requirements for the 
correct installation and operation of HP Web Tools.

Switch Requirements
HP Web Tools 3.1 can be used to manage Switches that are running V3.1 
firmware, including HP StorageWorks SAN switches 2/8, 2/8-EL, and 2/16.

Workstation Requirements
The following items are required for the operation of HP Web Tools: 

One of the following operating systems:

■ Sun Solaris 2.7 or 2.8

■ Windows 2000, or Windows XP

■ Windows NT 4.0

Adequate RAM (required for Windows operating systems only):

■ 128 MB or more of RAM for fabrics consisting of 10 switches or less

■ 256 MB or more of RAM for fabrics consisting of 15 switches or less

■ 512 MB or more of RAM for fabrics consisting of more than 15 switches

Adequate RAM for video display:

■ Minimum 8MB of video RAM is recommended

Web Browser Requirements
One of the following web browsers is required: 

■ Microsoft Internet Explorer 5.5 (Service Pack 2 is recommended) or later.

■ Netscape 4.77 for Solaris

The browser must be configured to work with HP Web Tools. For information 
about how to do this, see “Configuring the Web Browser” on page 38.

Note:  Due to decreasing customer demand and an increasing number of significant 
technical incompatibilities, the combination of the Netscape browser running on the 
Windows operating system is no longer supported for use with HP Web Tools.
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Java Plug-in and JRE Requirements
The correct version of the Java Plug-in for your operating system:

■ For Windows XP, NT, or 2000 Java Plug-in version v1.3.1_04 or later. Java 
Runtime Environment v1.3.1_04 is recommended for best results.

■ For Solaris: Java Plug-in version v1.3.1_04 for Solaris, including the Java 
Plug-in patch created by Sun for Solaris. Java Runtime Environment 
v1.3.1_04 is recommended for best results. 
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Installing Prerequisite Software on a Workstation
Perform the following steps before you use HP Web Tools to manage your fabric:

■ Install one of the supported web browsers on a workstation, if not already 
installed.

■ Configure the web browser for use with HP Web Tools.

■ Install the required Java Plug-in on the workstation, if not already installed. 
For some workstations, when you first access the switch using Web Tools, the 
operating system will automatically load the required Java Plug-in and JRE.

■ Install an HP Web Tools license on each switch to be managed from HP Web 
Tools. 

Installing a Web Browser
If not already installed, install one of the following browsers:

■ Internet Explorer 5.5 (with Service Pack 2 is highly recommended)

■ Netscape 4.77 for Solaris

Configuring the Web Browser
Specific browser settings are required for the correct operation of HP Web Tools 
with Netscape Communicator (not supported) or Internet Explorer. 

Configuring Netscape Communicator

Note:  Due to decreasing customer demand and an increasing number of significant 
technical incompatibilities, the combination of the Netscape browser running on the 
Windows operating system is no longer supported for use with HP Web Tools.

Some browsers use local cache copies of .jar files and/or image files to improve 
performance (depending on the options selected in browser), which can cause 
incorrect display in HP Web Tools. The web browser cache must be cleared before 
invoking Web Tools. 

To remove cached files from Netscape Communicator:

1. Select Edit > Preferences. 

2. Click Advanced in the Category box to expand it, then click Cache.
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3. On the Cache panel, click Clear Memory Cache.

4. Click OK.

5. Exit and relaunch the browser.

Configuring Internet Explorer
Correct operation of HP Web Tools with Internet Explorer requires specifying the 
appropriate settings for browser refresh frequency and process model. Browser 
pages should be refreshed frequently to ensure the correct operation of Web Tools.

To set the refresh frequency:

1. Select Internet Options from the Tools menu.

2. Select the General tab and click Settings (under “Temporary Internet Files”). 

3. Under “Check for newer versions of stored pages,” select “Every visit to the 
page.”

Installing the Java Plug-in on the Workstation
A Java Plug-in must be installed on the workstation for the correct operation of 
HP Web Tools. The required version depends on the operating system. 

Installing the Java Plug-in on Solaris
Solaris workstations require both the Java Plug-in version 1.3.1_04 for Solaris and 
the patch created by Sun Microsystems for use with the Java Plug-in on Solaris.

To install the Java Plug-in on Solaris:

1. Locate the Java Plug-in on the internet, such as at the Sun Microsystems 
website.

2. Follow the instructions to install the JRE.

3. Open the .cshrc file and set the path to the Java Plug-in executable file. For 
example:

— If the JRE is installed on /opt/j2re1.4.1_01

— If Netscape is installed on /usr/local/communicator/ver_4.77
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For the Bourne shell, type the following:

For the C shell, type the following:

Installing a Java Patch on Solaris

To install the patch on Solaris:

1. Go to the website at http://access1.sun.com, and search for any patches for 
your current version of the JRE.

2. Follow the link to download the patch, and exit the browser when done.

3. Install the patch and reboot the system.

4. Relaunch the browser and enter the IP Address of the switch.

Installing the Java Plug-in on Windows XP, 2000, or NT
To determine the version of the Java Plug-in installed on Windows XP, NT, or 
2000, and install if necessary:

1. Access the Start Menu > Settings > Control Panel > Java Plug-in version. 
The Java Plug-in Control Panel is displayed. 

2. Select the About tab. 

3. Determine whether the correct Java Plug-in version is installed, and install if 
necessary:

— If the correct version is installed, HP Web Tools is ready to use. 

— If no Java Plug-in is installed, point the browser towards a switch running 
Fabric OS v4.x, follow the link to the Sun Microsystems website, 
download the correct Java Plug-in, then double-click the downloaded file 
to install the plug-in.

— If an outdated version is currently installed, uninstall it, relaunch the 
browser, and enter the address of a switch running Fabric OS v4.0 or later. 
Web Tools will guide you through the steps to download the proper Java 
Plug-in. 

NPX_PLUGIN_PATH=/opt/j2re1.4.1_01/plugin/sparc/ns4:/usr/local/communicator/ve
r_4.77/plugins

export NPX_PLUGIN_PATH

setenv NPX_PLUGIN_PATH 
/opt/j2re1.4.1_01/plugin/sparc/ns4:/usr/local/communicator/ver_4.77/plugins

http://access1.sun.com
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Licensing Web Tools on the Switch
An HP Web Tools license can be installed either through Telnet or over the web. 

To determine whether a license is already installed on a switch, follow the 
instructions provided under “Launching HP Web Tools” on page 43. If a license is 
not installed, contact your switch supplier to obtain a license key. 

Installing a Web Tools License Through Telnet
To install an HP Web Tools license through Telnet:

1. Log onto the switch by Telnet (See the HP StorageWorks Fabric Operating 
System Procedures Version 3.1.x/4.1.x User Guide for more information), 
using an account that has administrative privileges.

2. To determine whether an HP Web Tools license is already installed on the 
switch, type licenseshow on the Telnet command line.

A list displays, showing all the licenses currently installed on the switch.

switch:admin> licenseshow

1A1AaAaaaAAAA1a:

Zoning license

SES license

QuickLoop license

 If the HP Web Tools license is not included in the list or is incorrect, continue 
with step [3].

3. Enter the following on the command line:

licenseadd “key”

where “key” is the license key. The license key value is case-sensitive, and must 
be entered exactly as given.

4. Verify the license was added by entering the following on the command line:

licenseshow

If the HP Web Tools license is listed, the feature is available. If the license is not 
listed, repeat step [3]. 

Note:  The Java Plug-in must also be installed on the client machine to access HP Web 
Tools.
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Installing Web Tools Through the Web
Launching HP Web Tools from any non-licensed switch will automatically 
display the license dialog box. If the fabric already contains at least one licensed 
switch, you can use HP Web Tools to view and license other switches from the 
licensed switch.

To install the first license through the web:

1. Launch the web browser and enter the IP address of the switch in the 
Location/Address field. 
For example: 

http://123.123.123.123

2. Press Enter. If a license is already installed on the switch, HP Web Tools 
launches. If no license is installed, a license dialog displays. You will need to 
login as an admin user to gain access to the Licensing Screen. 

3. If the license dialog displays, follow the instructions provided.

To Install additional Licenses Through the Web
To install additional licenses through the web:

1. Launch the web browser and enter the IP address of the licensed switch in the 
Location/Address field. For example: 

http://123.123.123.123

2. Press Enter. HP Web Tools opens, displaying the Switch Explorer.

3. Click the icon for the switch you want to license. A licensing window 
displays.

4. Follow the instructions provided.
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Launching HP Web Tools
You can launch HP Web Tools once the license is installed on the switch and the 
Java Plug-in and web browser are installed and configured on the client 
workstation.

To launch HP Web Tools:

1. Launch the web browser and enter the IP address of the licensed switch in the 
Location/Address field. For example: 

http://123.123.123.123

2. Press Enter. HP Web Tools opens, displaying the Switch Explorer.
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3Switch Explorer View

This chapter provides the following information:

■ About the Switch Explorer View, page 46

■ Fabric Tree, page 48

■ Switch Graphic, page 51

■ Switch Graphic Buttons, page 54

■ Switch Information Window, page 57

■ Refresh Rates in Web Tools, page 59

■ Accessing the Switch Explorer, page 60
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About the Switch Explorer View
The Switch Explorer View is the first web page that displays when you connect to 
a switch. The Switch Explorer includes:

■ Fabric Tree, displaying a navigation menu of icons for all the switches in the 
fabric.

■ Fabric Management icons, for easy access to fabric-level administration 
tasks.

■ Switch View, displaying real time information about the selected switch. 

■ Switch Information page, displaying a synopsis of useful information about 
the selected switch. 

■ Port Status information, displaying real time information about the port 
including status lights, and in-use lights. 

Every switch in the fabric, including any unlicensed switches, is represented by a 
switch icon in the Fabric Tree. However, only switches with a Web Tools license 
can be managed from Web Tools. To add a license for an unlicensed switch, click 
the corresponding switch icon in Fabric Tree, and a license window automatically 
displays.

An example of the Switch Explorer is shown in Figure 6.
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Figure 6:  Switch Explorer for a Core Switch 2/64
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Fabric Tree
The Fabric Tree displays a list of all the switches in the fabric. When you select a 
switch from this view it is displayed in the Switch View. You can display switches 
in the Fabric Tree list by Name, IP address, or WWN. An example of the Fabric 
Tree is shown in Figure 7.

Figure 7:  List of Switches in the Fabric Tree View

The fields available in the Fabric Tree are described in Table 5.
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Fabric Toolbar
The Fabric Toolbar is located at the bottom left corner of the Switch Explorer. Use 
the Fabric Toolbar to access Fabric Management tools: 

■ Fabric Events

■ Fabric Topology

■ Name Server

■ Zone Admin 

An example of the Fabric Toolbar is displayed in Figure 8.

Figure 8:  Fabric Toolbar

Table 5:  Fabric Tree Field Descriptions 

Field Description
View by: Select the View by drop-down menu to change the way 

switches are displayed in the tree. Select one of the following 
options: Name, IP, or WWN.

Fabric This is a navigation menu that displays all the switches in the 
fabric. Click the “+” sign to display switches within the fabric. 
To collapse a list of switches that is already open, click the “-” 
sign.

Switch Icon The switches can be listed by Name, IP address, or WWN 
depending on what display you choose in the View by 
drop-down menu. When you select a switch from this list it is 
displayed in the Switch View. 
The background color indicates the switch status. Each color 
indicates a different operational state:
■ Green - Healthy
■ Yellow - Marginal (mix of good and faulty readings)
■ Red - Down (more than two faulty readings)
■ Gray - Unknown or unmonitored
Each switch type has its own icon. 

Segmented Switches Displays switches that have lost Fibre Channel connectivity 
(that is, are segmented from the fabric). These switches can 
still be administered if the IP connection is valid.
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The Fabric Toolbar buttons are described in Table 6.

For more information, see “Fabric Management” on page 187. 

Table 6:  Fabric Toolbar Buttons 

Button Description
Fabric Events The Fabric Events View provides a running log of events in 

the fabric. Select to open Fabric Events View (for additional 
information, see “About Fabric Events” on page 190).

Fabric Topology The Fabric Topology View summarizes the physical 
configuration of the fabric from the perspective of the “local 
domain” (the domain of the selected switch). Select to open 
the Fabric Topology View (for additional information, see 
“About the Fabric Topology” on page 192).

Name Server The Name Server Table View provides the name server 
entries listed in the Simple Name Server database. Click to 
open Name Server Table View (for additional information, 
see “About the Name Server” on page 195).

Zone Admin Select to open the Zone Administration View. This button is 
available only if a Zoning license is installed (for additional 
information, see “About Zone Administration” on 
page 200). If the Zoning license is installed but Zoning is not 
implemented this button is grayed out. 

Note:  When Security is enabled, Zone Admin can only be 
performed from the Primary FCS switch. For all other switches 
this button is grayed out.
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Switch Graphic
The Switch View graphic is an interactive display of the particular switch you 
have selected from the Fabric Tree. The Web Tools interface replicates in 
real-time the switch you have selected. The displays in Web Tools correspond to 
the front of the actual switch and its various switch and port LEDs. 

Ports that are in use are displayed as well as unused ports. You can click on a port 
in this window to open a dialog box that displays information about that port. 

For the Core Switch 2/64, blades are displayed or slot spacers corresponding to 
the actual switch. The Active Control Processor (CP) is highlighted with an arrow 
at the bottom of the CP card display. 

An example of the Switch Graphic for a Core Switch 2/64 is shown in Figure 9. 
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Figure 9:  Example Switch View for a Core Switch 2/64
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An example of the Switch Graphic representation for a SAN Switch 2/32 is shown 
in Figure 10. 

Figure 10:  Example Switch View for a SAN Switch 2/32
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Switch Graphic Buttons
There are a number of buttons beneath the Switch Graphic which enable you to 
access various configuration and monitoring functions for the switch. Some of 
these buttons may require a license key to activate. If the appropriate license key is 
not installed for a particular feature, that button may not appear in the Switch 
Graphic display. The buttons available from the Switch Graphic are described in 
Table 7.

Table 7:  Switch Panel Buttons 

Switch Panel 
Button Description

Status: Healthy Select to open Switch Status View, which displays the overall 
status of the selected switch (for information about this view, 
see “Using the Switch Status Button” on page 66). The 
background color indicates the switch status. Each color 
indicates a different operational state:
■ Green - Healthy
■ Yellow - Marginal (mix of good and faulty readings)
■ Red - Down (more than two faulty readings)
■ Gray - Unknown or unmonitored
If no data is available from a switch, the most recent 
background color remains displayed.

Events Select to open Switch Events View to display the switch events 
log (for information about this view, see “About the Switch 
Events Button” on page 67).

Admin Select to open Switch Administration View (for information 
about this view, see “Switch Admin Window” on page 91).

Telnet Select to launch the Fabric OS command line interface for the 
switch (for information about this view, see “About the Telnet 
Button” on page 71).
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Performance 
Monitor

Optional Software. Select to launch the Performance Monitor. 
For more information, see “About Performance Monitor” on 
page 150.

Fabric Watch Optional Software. Select to open the Fabric Watch View (for 
information about this view, see “Fabric Watch” on 
page 171).

Beacon Select to toggle a beacon on a switch. For more information, 
see “About the Beacon Button” on page 76. 

Info Select to display information for the chosen switch. For more 
information, see “About the Switch Info Button” on page 78.

Fan Select to display fan status information for the chosen switch. 
For more information, see “About the Fan Button” on 
page 81. The background color indicates the fan status. 
Each color indicates a different operational state:
■ Green - Healthy
■ Yellow - Marginal
■ Red - Down
■ Gray - Unknown or unmonitored
If no data is available from a switch, the most recent 
background color remains displayed.

Table 7:  Switch Panel Buttons  (Continued)

Switch Panel 
Button Description
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Temperature Select to display the temperature status of the chosen switch. 
For more information, see “About the Temp Button” on 
page 82.The background color indicates the temperature 
status. Each color indicates a different operational state:
■ Green - Healthy
■ Yellow - Marginal
■ Red - Down
■ Gray - Unknown or unmonitored
If no data is available from a switch, the most recent 
background color remains displayed.

Power Select to display the power status of the selected switch. For 
more information, see “About the Power Button” on page 83. 
The background color indicates the power status. Each color 
indicates a different operational state:
■ Green - Healthy
■ Yellow - Marginal
■ Red - Down
■ Gray - Unknown or unmonitored
If no data is available from a switch, the most recent 
background color remains displayed.

Hi Avail Select to display the Hi-Availability window. The Hi 
Availability feature enables you to perform CP failover 
without disrupting traffic on the switch. Hi Availability 
requires that you maintain synchronization of services on 
each CP. 

Table 7:  Switch Panel Buttons  (Continued)

Switch Panel 
Button Description
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Switch Information Window
Table 8 describes the fields displayed in the Switch Information window, which is 
located beside or beneath the switch icon (depending on switch type). Depending 
on the switch type the order of fields displayed may change.

Table 8:  Switch Information Window 

Field Description
Switch Information 
for <switch name>

Displays the name of the switch being displayed. To change 
the name of the switch, see “About the Switch Information 
Tab” on page 95.

Status Displays the status of the switch being displayed. Valid values 
are:
■ Healthy
■ Marginal
■ Down

Polled at: Displays the time of the last status check, or if currently 
unavailable, the time of the last successful status check.

Name: Displays the name of the switch.
Fabric OS version: Displays the Fabric OS version currently installed on the 

switch.
Domain ID: Displays the Domain ID number that uniquely identifies the 

switch within the fabric.
Ethernet IP: Displays the Ethernet IP address.
Ethernet Mask: Displays the Ethernet subnetmask.
FCnet IP: Displays the Fibre Channel IP address.
FCnet Mask: Displays the Fibre Channel subnetmask.
Gateway IP: Displays the Gateway IP address.
WWN: Displays the unique numeric identifier for the switch; 

assigned by manufacturer.
Current Zone 
Config:

Displays the name of the currently enabled Zone 
Configuration. If no Zone Configuration is currently enabled, 
the field displays as none.
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Status Legend
The Status Legend defines the meaning of colors visible in the background of the 
various icons in the Switch Explorer. 

Each color indicates a different operational state:

■ Green - Healthy

■ Yellow - Marginal (mix of good and faulty readings)

■ Red - Down (more than two faulty readings)

■ Gray - Unknown or unmonitored

■ Dark Gray - monitoring is being initiated.

If no data is available from a switch, the status is unmonitored and the switch 
displays as gray.

Note:  For all status displays that are based on errors per time interval, any errors will 
cause the status to show faulty until the entire sample interval has passed.



Switch Explorer View

59Web Tools Version 3.1.x/4.1.x User Guide

Refresh Rates in Web Tools
Different areas of Web Tools refresh at different rates. Table 9 lists the polling 
rates for the various panels in Web Tools.

Table 9:  Polling Rate in the Switch Explorer Window 

Switch Explorer 
Area Polling Rate

Fabric Tree 15 seconds.
Unreachable 
Switches in the 
Fabric Tree

2 minutes.

Switch View 15 seconds during normal operation. From 30 to 60 seconds 
during initialization.

Switch Information 
Panel

15 seconds.

Name Server 15 seconds.
Zone Database 15 seconds.
Fabric Watch 15 seconds.
Performance 
Monitor

The Performance Monitor polling rate is user defined.
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Accessing the Switch Explorer
To access the Switch Explorer, perform the following steps:

1. Launch Web Tools. 

The Switch Explorer appears.

2. Click the “+” sign in the Navigation tree to view nested switches. 

3. Click on the desired switch from the Fabric Tree. 

The selected switch appears in the Switch Graphic view. 
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4Switch Management

This chapter provides the following information:

■ About Switch Management, page 62

■ About the Switch Status Button, page 65

■ About the Switch Events Button, page 67

■ About the Admin Button, page 70

■ About the Telnet Button, page 71

■ About the Performance Monitor Button, page 75

■ About the Beacon Button, page 76

■ About the Switch Info Button, page 78

■ About the Fabric Watch Button, page 80

■ About the Fan Button, page 81

■ About the Temp Button, page 82

■ About the Power Button, page 83

■ About HA Admin, page 84
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About Switch Management
Switch Management is made up of the Switch Graphic area and the Switch 
Information area; it is referred to as the Switch View. 

Switch Explorer for the Core Switch 2/64
An example of the Switch Explorer for the Core Switch 2/64 is displayed in 
Figure 11.

Figure 11:  Example of the Switch Explorer for the Core Switch 2/64
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Note:  The Active CP in the Core Switch 2/64 is labeled with a small arrow at the 
bottom of the CP display.

Switch Explorer for SAN Switch 2/32
An example of the Switch Explorer for the SAN Switch 2/32 is displayed in 
Figure 12.

Figure 12:  Example of the Switch Explorer for the SAN Switch 2/32
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Switch Information Field Descriptions
The Switch Information window is located beneath or beside the graphic 
representation of the switch depending on the switch type (see Figure 11 or 
Figure 12). Use the Switch Summary window to easily glance at vital switch 
information. The fields displayed in the Switch Information view are described in 
Table 10.

Further information about the switch can be located by selecting the Info button 
(see “About the Fan Button” on page 81).

Table 10:  Switch Information View 

Field Description
Switch Information 
for <switchname>

Displays the name of the switch in the upper-left corner of the 
window area. 

Status Displays the status of the switch. Valid values are:
■ Healthy
■ Marginal
■ Down

Polled At Displays the last date and last time the switch was polled for 
information. 

Fabric OS version Displays the version of Fabric OS that is installed on the 
switch. 

Ethernet IP Displays the Ethernet IP address. 
FCNet IP Displays the Fibre Channel IP address. 
Gateway IP Displays the Gateway IP address.
Name Displays the name of the switch. 
Domain ID Displays the Domain ID within the switch (a unique number 

that identifies the switch to the fabric and is used in routing 
frames). 

Ethernet Mask Displays the Ethernet subnet mask address, if one exists. 
FCNet Mask Displays the Fibre Channel subnet mask address, if one 

exists. 
WWN Displays the World Wide Name of the switch. 
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About the Switch Status Button
View or click the status button (see “Switch Graphic Buttons” on page 54) to 
display the switch’s operational state. The background color of the button displays 
the real-time status of the switch. See the list below for the meaning of the 
background colors.

■ Green Healthy

■ Yellow Marginal (mix of good and faulty readings)

■ Red Down (more than two faulty readings)

■ Gray Unknown or unmonitored

If no data is available from a switch, the most recent background color remains 
displayed.

For all statuses that are based on errors per time interval, any errors will cause the 
status to show faulty until the entire sample interval has passed.

Switch Status Example
An example of the Switch Status window is displayed in Figure 13.

Figure 13:  Switch Status Window

This window displays the status of the switch. If the switch is marginal or critical, 
information on the trigger that caused that status is displayed.
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Using the Switch Status Button
To check the physical health of a switch, perform the following procedure.

1. Launch Web Tools. 

2. View the background color (which shows the status) of the desired switch in 
the Fabric Tree. 

For further information, continue to the next step. 

3. Click on the desired switch in the Fabric Tree.

The Switch View displays for that switch. 

4. View the background color of the Status button. See the “Status Legend” on 
page 58.

5. Click the Status button to view a written description of the health status.
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About the Switch Events Button
The Switch Events button (see “Switch Graphic Buttons” on page 54) in the 
Switch View displays a running log of events for the selected switch. 

Switch Events Example
An example of the Switch Events window is shown in Figure 14.

Figure 14:  Switch Events Window

Switch Events Field Descriptions
The Switch Events fields are described in Table 11.

Table 11:  Switch Events Field Descriptions 

Field Description
Switch Displays the name of the switch, if one has been assigned. 
Number Displays the order of the event. 
Time Displays the time the event occurred.
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Count Displays the number of back-to-back occurrences of the same 
event.

Level Displays the severity level of the event:
■ 0 panic (switch reboots)
■ 1 critical
■ 2 error
■ 3 warning
■ 4 information
■ 5 debug

Message Displays a description of the event. 

Table 11:  Switch Events Field Descriptions  (Continued)

Field Description
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Accessing the Switch Events Report
Perform the following steps to access the switch events report.

1. Launch Web Tools. 

2. Select the desired switch from the Fabric Tree.

The Switch View displays. 

3. Select the Switch Events button from the Switch View.

A Switch Events Report appears. 

4. View the switch events and messages. 
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About the Admin Button
Use the Admin button (see “Switch Graphic Buttons” on page 54) of the Switch 
View to access the switch administration functionality. For example:

■ Switch parameter configuration

■ Network configuration

■ Extended Fabric configuration

■ Routing

■ Firmware Download

■ Trunking

For complete information regarding the Admin View, see the “Switch Admin 
Window” on page 91.
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About the Telnet Button
Use the Telnet button (see “Switch Graphic Buttons” on page 54) from the Switch 
View to access the switch using telnet. You must have administrative privileges to 
access the telnet option. For information regarding controlling the switch through 
the Fabric OS command line, see the HP StorageWorks Fabric OS Version 
3.1.x/4.1.x Reference Guide.

Telnet and Security
If secure mode is enabled on the fabric, standard telnet access to switches is 
disabled. You must use the Secure Telnet Application (sectelnet.exe) or SSH to 
access the switch. For more information refer to the HP StorageWorks Secure 
Fabric OS Version 1.0 User Guide for more information.

The following message is displayed if you attempt to open a telnet window from 
Web Tools when secure mode is enabled. 

Figure 15:  Telnet Disabled Banner when in Secure Mode

Telnet Example
A sample telnet session window is displayed in Figure 16.
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Figure 16:  Telnet Sample Window

Telnet Descriptions
The sample Telnet fields are described in Table 12.

Table 12:  Telnet Window Field Descriptions 

Field Descriptions
Fabric OS (tm) Displays the current Fabric OS version that is currently 

installed on the switch. 
login: Displays prompt. Enter Admin level User Name. 
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Password: Displays prompt. Enter Admin level password. 
switch:admin > Displays the switch name and login level prompt after a 

successful login. Enter desired Fabric OS command. 
Sample Command The sample commands used in Figure 16 are 

secmodeshow and configshow. The output displays 
information about the current switch and configuration. See 
the HP StorageWorks Fabric OS Version 3.1.x/4.1.x 
Reference Guide for more information about the Fabric OS 
command line interface.

Table 12:  Telnet Window Field Descriptions  (Continued)

Field Descriptions
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Accessing Telnet Through Web Tools
To access telnet through Web Tools, perform the following steps.

1. Launch Web Tools. 

2. Select the desired switch from the Fabric Tree.

The Switch View displays. 

3. Select the Telnet button from the Switch graphic.

The Telnet window appears.

4. Enter an Admin level user name and password. 

5. Type the exit command to close the telnet session. 
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About the Performance Monitor Button
Use the Performance Monitor button (see “Switch Graphic Buttons” on page 54) 
to graphically display throughput (megabytes per second) for each port and for the 
entire switch. 

For complete information about the Performance Monitor, see “About 
Performance Monitor” on page 150 in this document, or the HP StorageWorks 
Advanced Performance Monitoring Version 3.1.x/4.1.x User Guide. 
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About the Beacon Button
Use the Beacon button (see “Switch Graphic Buttons” on page 54) of the Switch 
View to physically locate a switch in a fabric. The beaconing function helps to 
physically locate a switch by sending a signal to the specified switch, resulting in 
an LED light pattern running back and forth along the switch. To perform 
beaconing, see “About the Switch Info Button” on page 78.
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Beacon Button—Physically Locating a Switch in a Fabric
To physically locate a switch in a fabric, use the Beacon button as described in the 
following steps.

1. Launch Web Tools by entering the IP address of the switch you wish to locate. 

2. Highlight the switch in the Fabric Tree. 

The selected switch appears in the Switch View. 

3. Select the Beacon button on the switch View.

The LED lights on the selected switch light up and run back and forth across 
the switch. 

4. Look at the physical switches in your installation to locate the desired switch. 
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About the Switch Info Button
Use the Switch Info button (see “Switch Graphic Buttons” on page 54) of the 
Switch View to display fundamental switch information such as the WWN, State, 
and Ethernet IP address. 

The Switch Info button fields are described in Table 13.

Table 13:  Info Button Fields Descriptions 

Field Description
WWN Displays the World Wide Name of the switch. 
Domain ID Displays the Domain ID of the switch (a unique number that 

identifies the switch to the fabric and is used in routing 
frames). 

Role Displays whether the switch is a Principal or Subordinate 
switch in the fabric. 

State Displays the state of the switch, whether online or offline. 
Firmware Displays the current version of firmware loaded on the switch. 
Manufacturer
Serial #

Displays the manufacturer serial number of the switch. 

Supplier Serial # Displays the supplier serial number of the switch, if 
applicable. 

Ether IP Displays the Ethernet IP address.
Ether NM Displays the Ethernet Mask
FC IP Displays the Fibre Channel IP address, if one exists.
FC NM Displays the Fibre Channel Mask, if one exists.
Gateway Displays the Gateway address of the switch. 
License ID Displays the License ID of the switch. The license ID number is 

required to get license keys for the switch.
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Accessing Switch Information 
Access switch information by performing the following steps.

1. Launch Web Tools by entering the IP address of the switch you wish to locate. 

2. Highlight the switch in the Fabric Tree. 

The selected switch appears in the Switch View. 

3. View the information listed below the graphic representation of the switch.
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About the Fabric Watch Button
The Fabric Watch button only appears when the optional license is installed on 
the switch. 

For more information, see “Fabric Watch” on page 171. 
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About the Fan Button
The background color of the Fan button indicates the overall status of the fans 
(see “Switch Graphic Buttons” on page 54): 

■ Green Healthy

■ Yellow Marginal (mix of good and faulty readings)

■ Red Down (more than two faulty readings)

■ Gray Unknown or unmonitored

For more information regarding Fan information, refer to the switch installation 
guide supplied with your specific switch (the installation guide is also available on the 
V3.1.x or V4.1.x Software CD)..
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About the Temp Button
The background color of the Temp button (see “Switch Graphic Buttons” on 
page 54) indicates the overall temperature status: 

■ Green Healthy

■ Yellow Marginal (mix of good and faulty readings)

■ Red Down (more than two faulty readings)

■ Gray Unknown or unmonitored

For more information regarding Temp information, refer to the switch installation 
guide supplied with your specific switch (the installation guide is also available on the 
V3.1.x or V4.1.x Software CD).



Switch Management

83Web Tools Version 3.1.x/4.1.x User Guide

About the Power Button 
The background color of the Power button indicates the overall status of the power 
(see “Switch Graphic Buttons” on page 54): 

■ Green Healthy

■ Yellow Marginal (mix of good and faulty readings)

■ Red Down (more than two faulty readings)

■ Gray Unknown or unmonitored

For more information regarding power source information, refer to the switch 
installation guide supplied with your specific switch (the installation guide is also 
available on the V3.1.x or V4.1.x Software CD).
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About HA Admin
The HA Admin window displays information about the status of high availability 
(HA) on the Core Switch 2/64 and each CP. It also enables you to perform tasks 
such as HA Failover or Synchronize Services on the CPs. The HA Admin window 
contains the following information:

■ HA Admin Common Field and Button Descriptions, page 86

■ Service Tab Field Descriptions, page 86

■ HA Admin CP Tab Field Descriptions, page 88

HA Admin Example
An example of the HA Admin window is shown in Figure 17.
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Figure 17:  HA Admin Window

HA Admin Field Descriptions
The common fields available in the HA Admin window are described in Table 14.
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Service Tab Field Descriptions
The fields available in the Service Tab view are described in Table 15.

Table 14:  HA Admin Common Field and Button Descriptions 

Field Description
Chassis Displays the switch type.
HA Summary Displays the HA summary status. Valid values can be:

■ Non-Disruptive Failover Ready
■ Disruptive Failover Ready
■ No Failover

Action Buttons
Synchronize 
Services Button

Click this button to begin a synchronization of services on 
both CPs. Once the services of both CPs are synchronized 
and there is full redundancy then a non-disruptive failover 
can be initiated.

Initiate Failover 
Button

Click this button to initiate a failover from the active CP to the 
standby CP.

Close Button Click this button to close the HA Admin page.
Refresh Button Click this button to refresh the information on this page.

Table 15:  HA Admin Service Tab Field Descriptions 

Field Description
Logical Switch 
selection window

This window enables you to select the RightSwitch service 
view or the LeftSwitch service view. In the Core Switch 2/64 
chassis, logical switch 0 is the leftswitch, and logical switch 1 
is the rightswitch as seen from the cable side of the switch. 
When you select a Switch Service view, the Service status for 
that switch is displayed. 

Active Service Displays information for the Active Service. Depending on 
which service you selected in the Logical Switch window and 
the current configuration of the CPs, valid values can be: 
■ RightSwitchCP0
■ RightSwitchCP1
■ LeftSwitchCP0
■ LeftSwitchCP1

Role Indicates if the Service is Active or Standby.
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CP Tab Field Descriptions
The fields available in the CP Tab view are described in Table 16.

Status Displays the status of the Active Service. Valid values for the 
Active Service are:
■ Non-Disruptive Failover Ready
■ Disruptive Failover Ready
■ No Failover

Location Displays the location of the Active CP as CP0 or CP1.
Event Displays the last event. Valid values for this field are:

■ Failover
■ Arbitration

Event Time Displays the day, date, hour, and year of the last event.
Standby Service Displays information for the Standby Service. Depending on 

which switch you selected in the Logical Switch window and 
the current configuration of the CPs, valid values can be: 
■ RightSwitchCP0
■ RightSwitchCP1
■ LeftSwitchCP0
■ LeftSwitchCP1

Role Indicates if the Service is Active or Standby.
Status Displays the status of the Standby Service. Valid values for 

the Standby Service are:
■ Non-Disruptive Failover Ready
■ Disruptive Failover Ready
■ No Failover

Details Button Displays whether the CP services are in sync. 
Location Displays the location of the Standby CP as CP0 or CP1.
Last Sync Time Displays day, date, hour, and year of the last in-sync time.
Last Out of Sync 
Time

Displays day, date, hour, and year of last out-of-sync time.

Table 15:  HA Admin Service Tab Field Descriptions  (Continued)

Field Description
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Table 16:  HA Admin CP Tab Field Descriptions 

Field Description
Active CP
(CP0 or CP1)

Displays information for the Active CP. The top CP in this view 
is always the Active CP. Depending on the current 
configuration of the CPs this can be:
■ CP0
■ CP1

Role Displays the Role of the selected CP as the Active or Standby.
Status Displays the status of the Active CP. Valid values for the 

Active CP are:
■ Healthy
■ Faulty 

Slot Displays the slot of the Active CP as slot 5 or slot 6. 
Event Displays the last event. Valid values for this field are:

■ Failover
■ Arbitration

Event Time Displays the day, date, hour, and year of the last event.
Standby CP
(CP0 or CP1)

Displays information for the Standby CP. Depending on the 
current configuration of the CPs this can be:
■ CP0
■ CP1

Role Displays the Role of the selected CP as the Active or Standby.
Status Displays the status of the Standby CP. Valid values for the 

Standby CP are:
■ Healthy
■ Faulty 

Details Button Displays the status of faulty devices.
Slot Displays the slot of the Active CP as slot 5 or slot 6. 
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Using HA Admin
The following sections show how to access the HA Admin interface, how to use it 
to synchronize services on the CP, and how to initiate a CP failover.

Accessing the HA Admin Interface
Perform the following steps to access the HA Admin interface.

1. Launch the web browser.

2. Enter the IP address in the Location/Address field and press Enter. 

Example: 

http://123.123.123.123

Web Tools launches, displaying Fabric Tree.

3. Click a switch in the Fabric Tree.

The Switch graphic appears. 

4. Click the Hi Avail icon on the switch panel.

The HA Admin window appears as shown in Figure 17. 

Synchronizing Services on the CP
A non-disruptive CP Failover is only possible when all the services have been 
synchronized. To synchronize the services perform the following:

1. Launch the web browser.

2. Enter the IP address in the Location/Address field and press Enter. 

Example:

http://123.123.123.123

Web Tools launches, displaying Switch Explorer View.

3. Click a switch in the Fabric Tree.

The Switch graphic appears. 

4. Click the Hi Avail icon on the switch panel.

The HA Admin window appears as shown in Figure 17. 

5. Verify that HA Summary field displays Non-Disruptive Failover Ready.
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If the HA Summary field displays Disruptive Failover Ready, click the 
Synchronize Services Button and wait for the CPs to complete a 
synchronization of services, so that a Non-Disruptive Failover is ready.

Once the HA Summary field displays Non-Disruptive Failover Ready a 
failover can be initiated without disrupting frame traffic on the fabric.

Initiating a CP Failover
Perform the following steps to initiate a CP failover.

1. Launch the web browser.

2. Enter the IP address in the Location/Address field and press Enter. 

Example: 

http://123.123.123.123

Web Tools launches, displaying Switch Explorer view.

3. Click a switch in the Fabric Tree.

The Switch graphic appears. 

4. Click the Hi Avail icon on the switch panel.

The HA Admin window appears as shown in Figure 17. 

5. Verify that HA Summary field displays Non-Disruptive Failover Ready or 
Disruptive Failover Ready. See “Synchronizing Services on the CP” on 
page 89 for more information.

6. Click the Initiate Failover button. A non-disruptive failover may take a few 
minutes to complete. You may lose connection to the switch for a few minutes 
during the Failover. Web Tools will automatically resume the connection after 
the failover.
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5Switch Admin Window

This chapter provides the following information:

■ About the Switch Admin Window, page 92

■ Accessing the Switch Admin Window, page 94
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About the Switch Admin Window
The Switch Admin Window can be entered with User level access, but certain 
areas require Admin level access. Use the Switch Admin Window to access the 
following tabs:

■ About the Switch Information Tab, page 95

■ About the Network Config Tab, page 98

■ About the Upload/Download Tab, page 103

■ About the SNMP Tab, page 108

■ About the License Admin Tab, page 112

■ About the Port Setting Tab, page 115

■ About the Configure Tab, page 120

■ About the Routing Tab, page 131

■ About the Extended Fabric Tab, page 142

■ About the Trunk Information Tab, page 146

Switch Admin Window
For examples of the Switch Admin Window tabs, see each specific tab; for 
example: “About the Switch Information Tab” on page 95. 

Switch Admin Window Field Descriptions
The common buttons that appear on most of the tabs in the Switch Admin 
Window are described in Table 17.

Table 17:  Switch Admin Window Field Descriptions 

Field Description
SwitchName Displays the Switch name.
Domain ID Displays the switch Domain ID.
WWN Displays the switch WWN.
Date Displays the current day, date and time.
Apply Click this button to save any changes made to this tab and 

remain in the current tab. Additional changes can be made 
and the Apply button clicked when making changes 
incrementally.
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Close Click this button to exit the Admin Interface. If changes have 
been made and not committed by clicking the Apply button, 
a dialog box is presented. It allows the changes to be 
committed or deleted.

Reset Click this button to reset the field values to the last set of 
committed changes. If the Apply button has not been pressed 
on this tab, the parameters are returned to the original values 
the tab contained when it was initially displayed.

Refresh Click this button to receive the latest switch information. 
Switch Commit 
Messages 

Refers to the small window at the bottom of each tab. 
Displays a log regarding recent switch admin commit 
changes. 

Status Message Appears in the bottom left corner of the tab; displays the type 
of administrative interface being viewed. 

Status Icon Appears in the bottom right corner of the tab; refers to the 
status of the switch. A green square means the switch is 
enabled; a red square means the switch is disabled. 

Table 17:  Switch Admin Window Field Descriptions  (Continued)

Field Description
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Accessing the Switch Admin Window
Use the following steps to access the Switch Admin window.

1. Launch Web Tools by entering the desired IP address in a browser window. 

The Switch Explorer appears. 

2. Select a switch from the Fabric Tree. 

The selected switch appears in the Switch View. 

3. Select the Admin icon from the switch graphic. See “Switch Graphic Buttons” 
on page 54.

The login dialog box appears. 

4. Enter the admin user name and password. 

5. Select the desired tab. 

For reference information on the specific tabs, see the About and Using 
sections of this chapter.
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About the Switch Information Tab
Use the Switch Information tab to manage basic switch setup for items such as 
switch name, switch domain ID and enabling and disabling the switch. For 
additional Switch Setting information, see “Using the Network Config Tab” on 
page 102.

Switch Information Tab Example
An example of the Switch Information tab is shown in Figure 18.

Figure 18:  Switch Information Tab of the Switch Admin Window
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Switch Information Field Descriptions
The Switch Information fields are described in Table 18.

Table 18:  Switch Information Field Descriptions 

Field Description
Name and ID

Name Display or modify the current switch name. The switch name 
can be from 1 to 15 characters in length. 

Domain ID Displays or sets switch domain ID. Domain IDs must be 
unique within a fabric. Domain ID can only be modified 
when the switch is disabled. The switch must be disabled to 
change domain ID.
To change domain ID, enter new domain ID in this field. 
■ Use a number from 1 to 239 for normal operating mode 

(FCSW compatible) 
■ Use a number from 0 to 31 for VC encoded address 

format mode (backward compatible to StorageWorks 
Fibre Channel Switches 8 and 16).

Manufacturers 
Serial # 

Displays the Manufacturer serial number of the switch (Read 
only).

Supplier Serial # Displays the Supplier serial number of the switch, if 
applicable (Read only).

Switch Status
Enable / Disable

Select the Enable radio button to enable the switch, or the 
Disable radio button to disable the switch. 

View Report Click this button to view a report of the selected switch. 
Email Configuration

DNS Server 1 Display or modify the first DNS Server name.
DNS Server 2 Display or modify the second DNS Server name. 
Domain Name Display or modify the Domain name of the DNS Server.
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Using the Switch Information Tab
The following sections show how to use the Switch Information tab to 
enable/disable a switch, and to view/print a switch report.

Enabling/Disabling a Switch
Use the following procedure to enable/disable a switch.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Switch Information tab.

4. Under the Select the (Switch Status) Enable radio button to enable the switch;
or, select the (Switch Status) Disable radio button to disable the switch.

5. Click the Apply button. 

Viewing/Printing a Switch Report
Use the following procedure to view/print a switch report.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Switch Information tab.

4. Click the View Report button.

A switch report appears. 

5. View or print the report using your browser or the Print Screen option of your 
computer. 
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About the Network Config Tab
Use the Network Config tab of the Administrative interface to manage the IP 
networking functionality of the switch.

For more detailed information regarding network configuration, see the HP 
StorageWorks Fabric Operating System Procedures Version 3.1.x/4.1.x User 
Guide or configure command in the HP StorageWorks Fabric OS Version 
3.1.x/4.1.x Reference Guide. 

Syslog IP
Syslog IP represents the IP address of the server that is running the Syslog 
process. The Syslog daemon reads and forwards system messages to the 
appropriate log files and/or users, depending on the system configuration. When 
one or more IP addresses are configured, the switch forwards all error log entries 
to the syslogs on the specified servers. Up to six servers are supported. See the HP 
StorageWorks Fabric Operating System Procedures Version 3.1.x/4.1.x User 
Guide for more information on configuring the Syslog daemon.

Switch Identification
If both the Fibre Channel IP and Ethernet IP are present, the switch is identified by 
the Fibre Channel IP. 

Network Config Tab Example
An example of the Network Config tab is shown in Figure 19.
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Figure 19:  Network Configuration Tab of the Switch Admin Window

An example of the Advanced IP Configuration window (Core Switch 2/64 only) is 
shown in Figure 20.
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Figure 20:  Advanced IP Configuration Window (Core Switch 2/64 only)

Network Config Field Descriptions
The Network Config fields are described in Table 19.

Table 19:  Network Config Field Descriptions 

Field Description
Ethernet IP Displays the Ethernet IP address.
Ethernet Mask Displays the Ethernet SubnetMask address.
Gateway IP Displays the Gateway IP address.
Fibre Channel Net 
IP

Displays the Fibre Channel IP address, if one exists.

Fibre Channel 
NetMask

Displays the Fibre Channel subnet mask address, if one 
exists.

Advanced Button Displays the Advanced IP Configuration window (Figure 20). 
This window displays the IP information configured for each 
network element (CP1, CP1, Logical Switch 0, and Logical 
Switch 1) in the Core Switch 2/64. This window is read-only 
and is only available for the Core Switch 2/64.

Syslog IPs
Syslog IP window Displays the currently configured syslog recipients. See the 

HP StorageWorks Fabric Operating System Procedures 
Version 3.1.x/4.1.x User Guide for more information about 
configuring the Syslog daemon.

Syslog IP Field Enter any valid IP for a host and click the Add button to 
configure that IP as a recipient of syslog messages.
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Add Button Click the Add button to add the IP specified in the Syslog IP 
field to the Syslog IP window. You must click the Apply button 
to make your changes persistent over a switch reboot.

Remove Button Click the Remove button to delete the IP specified in the 
Syslog IP field from the Syslog IP window.You must click the 
Apply button to make your changes persistent over a switch 
reboot. 

Clear All Button Click the Remove button to delete all the configured Syslog 
IPs. You must click the Apply button to make your changes 
persistent over a switch reboot. 

Table 19:  Network Config Field Descriptions  (Continued)

Field Description
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Using the Network Config Tab
Use the Network Config tab to configure Ether

Configuring an Ethernet IP or FC IP Address
1. Access the Switch Admin Window (see “About the Switch Admin Window” 

on page 92).

2. Enter the admin user name and password. 

3. Select the Network Config tab.

4. Select the Ethernet or Fibre Channel IP address you want to configure.

Note:  If both the Fibre Channel IP and Ethernet IP are present, the switch is identified 
by the Fibre Channel IP. 

5. Enter an Ethernet or Fibre Channel address in the appropriate field (for 
example, 123.123.123.123).

6. Click the Apply button.

Configuring a Syslog IP Address
1. Access the Switch Admin Window (see “About the Switch Admin Window” 

on page 92).

2. Enter the admin user name and password. 

3. Select the Network Config tab.

4. Enter a non-null IP address in one of the Syslog IP fields (for example, 
123.123.123.123).

5. Click the Add button. The configured IP is displayed in the Syslog IP 
window.

6. Click the Apply button.
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About the Upload/Download Tab
Use the Upload/Download tab of the Switch Admin window to complete tasks 
such as:

■ Download firmware

■ Upload a Configuration file to the host

■ Download the configuration from a host to the switch

■ Return the switch to the original configuration. 

■ Reboot a switch

You must provide host information for all the upload and download tasks listed 
above.

Upload/Download Tab Example
An example of the Upload/Download tab is shown in Figure 21.
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Figure 21:  Upload/Download Tab of the Switch Admin Window

Upload/Download Field Descriptions
The Upload/Download fields are described in Table 20.
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Table 20:  Upload/Download Field Descriptions 

Field Descriptions
Function

Firmware Download Select the radio button to download firmware. The Fastboot 
After Download option becomes enabled. 

Config Upload to 
Host

Select the radio button to upload the configuration file to a 
specified host. Using this option allows you to save the 
configuration file to the switch using the specified filename 
(full path). The Username and Password must be valid for the 
specified host, and the file path must be read-write capable 
by the user. The switch must be disabled for this option to be 
available.

Config Download to 
Switch

Select the radio button to download a configuration file to 
the switch. The Config Download option requires that the 
switch first be disabled; it will be set to the original switch 
status after the config download is complete. The switch must 
be disabled for this option to be available.

Host Details
Protocol Displays the supported downloading protocol: FTP. 
Full Install This option is a required value for Firmware Download. A full 

install replaces every file rather than only the delta files.
Reboot After 
Download

This option is a required value for Firmware Download. This 
option automatically reboots the switch after the Firmware 
Download is complete. 

AutoCommit This option is a required value for Firmware Download. This 
option automatically commits the firmware download to both 
partitions of a switch or CP in the Core Switch 2/64.

User Name Enter the User Name who owns the firmware package on the 
host.

Host IP Enter the IP address of the host.
Password Enter the password of the User who owns the firmware 

package on the host. 
Filename Enter the file name of the firmware package to be 

downloaded. 
Download/Upload 
Status

Indicates the progress of the firmware download or upload. 
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Using the Upload/Download Tab
The following sections show using the Upload/Download tab to download 
firmware, backup a firmware config file, and perform a config download to a 
switch.

Performing a Firmware Download 
1. Access the Switch Admin Window (see “About the Switch Admin Window” 

on page 92).

2. Enter the admin user name and password. 

3. Select the Upload/Download tab.

4. Click the Firmware Download radio button.

5. Select the FTP transfer protocol from the drop-down menu. 

FTP is the only supported transfer protocol in Fabric OS v4.1. 

6. Enter the User Name, Password, and Host IP information.

7. Enter the fully qualified path to the firmware file.

8. Click the Apply button. 

Backing Up a Firmware Config File
1. Access the Switch Admin Window (see “About the Switch Admin Window” 

on page 92).

2. Enter the admin user name and password. 

3. Select the Upload/Download tab.

4. Click the Config Upload to Host radio button. 

5. Select the FTP transfer protocol from the drop-down menu. 

FTP is the only supported transfer protocol in Fabric OS v4.1. 

6. Enter the User Name, Password, and Host IP information.

7. Click the Apply button. 

Performing a Config Download to Switch
1. Access the Switch Admin Window (see “About the Switch Admin Window” 

on page 92).
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2. Enter the admin user name and password. 

3. Select the Upload/Download tab.

4. Click the Config Download to Switch radio button.

5. Select the FTP transfer protocol from the drop-down menu. 

FTP is the only supported transfer protocol in Fabric OS v4.1. 

6. Enter the User Name, Password, and Host IP information.

7. Enter the fully qualified path to the config file.

8. Click the Apply button. 
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About the SNMP Tab
Use the SNMP tab of the Administrative Interface to perform administration of 
the SNMP Subsystem. Use the SNMP tab to specify the switch community string, 
location, trap level and trap recipients. 

For more detailed information regarding SNMP, see the agtcfgset command 
in the HP StorageWorks Fabric OS Version 3.1.x/4.1.x Reference Guide. 

Security
The SNMP tab is affected by the use of Secure Fabric OS; the ACL list will not be 
visible if security is enabled. For specific information regarding security, refer to 
the HP StorageWorks Secure Fabric OS Version 1.0 User Guide. 

Note:  In order for the switches to send SNMP traps, you must first enter the CLI 
command snmpmibcapset. This enables the MIBs on all switches to be monitored.

SNMP Tab Example
An example of the SNMP window is shown in Figure 22.
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Figure 22:  SNMP Tab of the Switch Admin Window

SNMP Field Descriptions
The SNMP fields are described in Table 21.
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Table 21:  SNMP Field Descriptions 

Field Description
SNMP Information

Contact Name Use to display or configure contact information for switch. 
Default is Field Support. Valid range of values are from 0 to 
255 characters.

Description Use to display or configure system description. Default is 
Fibre Channel Switch.Valid range of values are from 0 to 
255 characters.

Location Use to display or configure the location of switch. Default is 
End User Premise.Valid range of values are from 0 to 255 
characters.

Trap Level Use to set the severity level of switch events that will prompt 
SNMP traps. Default is 0.

Enable 
Authentication Trap

Check box to enable authentication traps; uncheck box to 
disable (disable is recommended).

Community/Trap Recipient Configuration

Note:  The fields described below do not display if security is enabled on the switch. 

Community String Displays the community strings that are available. A 
community refers to a relationship between a group of SNMP 
managers and an SNMP agent, in which authentication, 
access control, and proxy characteristics are defined. A 
maximum of six community strings can be saved to the 
switch. Valid range of values is from 2 to 16 characters.

Recipient Displays the IP address of the Trap Recipient. A trap recipient 
receives the message sent by an SNMP agent to inform the 
SNMP management station of a critical error. 

Permissions Displays the Read/Write access of a particular community 
string. READ ONLY access means that a member of a 
community string has the right to view, but cannot make 
changes. READ/WRITE access means that a member of a 
community string can both view and make changes.
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Using the SNMP Tab to Set Trap Levels
Perform the following procedure to set trap levels.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the SNMP tab.

4. Select a Trap level from the drop-down menu. The level you select refers to 
the Event level that will prompt a trap. See “About the Switch Events Button” 
on page 67.

5. Click the Apply button. 
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About the License Admin Tab
Use the License Administration tab to install and remove license keys that are 
provided to you. 

License Admin Tab Example
An example of the License Admin Tab is shown in Figure 23.

Figure 23:  License Admin Tab of the Switch Admin Window

License Admin Field Description
The License Admin fields are described in Table 22.
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Table 22:  License Admin Field Descriptions 

Field Description
LicenseKey column Displays a list of license keys currently installed on the switch. 
Feature(s) column Displays a list of the feature names associated with the 

license keys installed on the switch.
License Key field Enter a license key to be added or double-click a license key 

from the LicenseKey column to have it display in this field.
Add Click to add the specified license.
Remove Click to remove the specified license.
Close Click to close the Admin window
Refresh Click to refresh the information in the window.
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Using the License Admin Tab
The License Admin tab is used to add licenses to and remove licenses from a 
switch.

Add a License to a Switch
Perform the following steps to add a license to a switch.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the License Admin tab.

4. Enter a new license key in the License Key field.

5. Click the Add button. 

Remove a License From a Switch
Perform the following steps to remove a license from a switch.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the License Admin tab.

4. Enter the license key to remove, or double-click a license key from the 
License Key column to have it display in License Key field.

5. Click the Remove button. 
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About the Port Setting Tab
Use the Port Setting tab of the Administrative interface to perform functions such 
as: disable/enable ports on the switch, set port speed to 1GB/2GB/Negotiate, 
enable/disable Trunking, or name a port.

The port speed is displayed as follows:

■ 1G - 1 Gbit/sec

■ 2G - 2 Gbit/sec

■ N1 - Negotiated 1 Gbit/sec 

■ N2 - Negotiated 2 Gbit/sec

Port Settings Tab Example
An example of the Port Settings Tab is shown in Figure 24.
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Figure 24:  Port Settings Tab of the Switch Admin Window
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Port Settings Field Descriptions
The Port Setting fields are described in Table 23.

Table 23:  Port Setting Field Descriptions 

Field Description
Port Number Displays the Port Number. 
Persistent Disable Check this box to disable the port and maintain this state 

over switch reboot.
Enable Port Check this box to enable a port. You can check both the 

Enable Port and the Persistent Disabled boxes. This currently 
enables the port, but upon a switch reboot the port is 
disabled.

Enable Trunking Check this box to enable trunking on a port. Uncheck the box 
to disable trunking on this port. 

Enable Port Check box to enable the affiliated port. Uncheck box to 
disable the port. 

Port State Displays the state of the port, such as Online, No Light or No 
Module.

Current Speed Displays the speed at which the port is currently set. Valid 
values are:
■ 1G - 1 Gbit/sec
■ 2G - 2 Gbit/sec
■ N1 - Negotiated 1 Gbit/sec 
■ N2 - Negotiated 2 Gbit/sec

Change Speed Use to change the port speed. Port speed can be fixed to 1G, 
2G, or Negotiate (auto-negotiate). If the speed is set to 
Negotiate, the subsequent current speed will display the 
negotiated result. 

Port Name Use optionally to assign a name to a port. The name can be 
from 0 to 32 characters length. Port names do not need to be 
unique. The default value is no port name.
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Using the Port Setting Tab
The Port Setting tab is used to perform the following operations on ports.

Enabling or Disabling a Port
To enable or disable a port, perform the following steps.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Port Setting tab.

4. Check or Uncheck the enabled port box that corresponds to the Port you wish 
to enable/disable. 

5. Click the Apply button. 

6. Check the log at the bottom of the screen for information regarding the switch 
configuration changes. 

Enabling Trunking on a Port
Perform the following steps to enable trunking on a port.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Port Setting tab.

4. Check the Trunk box that corresponds to the port you wish to trunk. 

5. Click the Apply button. 

Configuring Port Speed
The following procedure configures port speed.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Port Setting tab.
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4. Select the desired speed for the corresponding port (see “About the Port 
Setting Tab” on page 115).

5. Click the Apply button. 

Assigning a Name to a Port
You can optionally name a port by performing the following steps.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Port Setting tab.

4. Click in the Name column; select the field that corresponds to the Port you 
want to name. 

5. Enter a name for the port. Port names can be from 0 to 32 alphanumeric 
characters. Port names do not need to be unique.

6. Click the Apply button. 

Disabling a Port over Reboots
To optionally disable a port, so that it is disabled over reboots perform the 
following steps.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Port Setting tab.

4. Select the slot and port you want to disable over reboots.

5. Check the Persistent Disable checkbox for that port.

6. Click the Apply button. 



Switch Admin Window

120 Web Tools Version 3.1.x/4.1.x User Guide

About the Configure Tab
Use the Configure tab of the Administrative Interface to configure Fabric 
Parameters, Virtual Channel parameters, Arbitrated Loop parameters, and System 
Services parameters. For more detailed information regarding the fields available 
in this tab, see the configure command in the HP StorageWorks Fabric OS 
Version 3.1.x/4.1.x Reference Guide. 

Note:  Many parameter fields and checkboxes within the Configure tab can only be 
modified if the switch is disabled. If a parameter value is shaded gray, that value is 
read-only. To modify the value, you must first disable the switch.

Configure (Fabric) Tab Example
An example of the Configure (Fabric) Tab is shown in Figure 25.
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Figure 25:  Configure (Fabric) Tab of the Switch Admin Window
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Configure (Fabric) Field Descriptions
The fields available in the Configure Fabric Tab are described in Table 24

Table 24:  Configure (Fabric) Field Descriptions 

Field Descriptions
Fabric Parameters

BB Credit Use to configure the number of buffers that are available to 
attached devices for frame receipt. The default BB Credit is 
16. The range is 1—16. 

R_A_TOV Use to configure the Resource Allocation Time Out Value in 
milliseconds. This variable works with the E_D_TOV to 
determine switch actions when presented with an error 
condition. The default is 10000. The possible range is 
4000—120000. 

E_D_TOV Use to configure the Error Detect Time Out Value in 
milliseconds. This timer is used to flag a potential error 
condition when an expected response is not received within 
the set time. The valid range is 1000—5000. 

Data Size Use to configure (in bytes) the largest possible data field size. 
The valid range is 256—2112. 

Sequence Switching Select check box to enable frames of the same sequence from 
a particular group to be transmitted together. When this 
option is not selected, frames are transmitted interleaved 
among multiple sequences. Under normal circumstances, 
sequence level switching should be disabled for better 
performance. However, some host adapters have issues when 
receiving interleaved frames among multiple sequences. 

Disable Device 
Probing

Set this mode only if the switch N_Port discovery process 
(PLOGI, PRLI, INQUIRY) causes an attached device to fail.
When set, devices that do not register with the Name Server 
are not present in the Name Server data base. 

Per-Frame Routing 
Priority

Choose to select or deselect Per-Frame Routing Priority. When 
enabled, the virtual channel ID is used in conjunction with a 
frame header to form the final virtual channel ID.

VC Encoded 
Address Mode

 Set this mode only if the fabric includes a StorageWorks 
SAN switch.
When set, the frame source and destination address use an 
address format that is compatible with StorageWorks SAN 
switches.
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Virtual Channels
The switch allows fine tuning for a specific application by configuring the 
parameters for eight virtual channels. 

The default values are set for optimal performance. Changing the default settings 
may improve performance, but may also degrade performance. The default Virtual 
Channel values are as follows:

Suppress Class F 
Traffic

Apply only if VC Encoded Address Mode is also set. When 
checked, translative addressing (which allows private devices 
to communicate with public devices) is disabled.

Always Send RCSN Check this box to issue a Remote State Change notification; 
following the completion of loop initialization, FL_Ports detect 
the presence of new devices or the absence of preexisting 
devices.

Do Not Allow 
ALPA_0x00

Check box to specify that AL_PA value 0x00 is not allowed.

Table 24:  Configure (Fabric) Field Descriptions  (Continued)

Field Descriptions

Table 25:  VC Parameters Default Settings 

Field Default Possible Range
VC Priority 2 2 2 to 3
VC Priority 3 2 2 to 3
VC Priority 4 2 2 to 3
VC Priority 5 2 2 to 3
VC Priority 6 3 2 to 3
VC Priority 7 3 2 to 3
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Configure (Virtual Channel) Tab Example
An example of the Configure (Virtual Channel) Tab is shown in Figure 26.

Figure 26:  Configure (Virtual Channel) Tab of the Switch Admin Window
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Configure (Virtual Channel) Field Descriptions
The fields available on the Configure Virtual Channel Tab are described in 
Table 26

Table 26:  Virtual Channel Field Descriptions 

Field Descriptions
Virtual Channel Parameters

VC Priority 2 - 7 Enables fine tuning for a specific application by configuring 
the parameters for eight virtual channels. The default Virtual 
Channel priorities have already been set for optimal 
performance; changing the default settings can improve the 
performance, but can also degrade performance. For default 
values, see Table 25.
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Configure (Arbitrated Loop) Tab Example
An example of the Configure (Arbitrated Loop) Tab is shown in Figure 27.

Figure 27:  Configure (Arbitrated Loop) Tab of the Switch Admin Window
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Configure (Arbitrated Loop) Field Descriptions
The fields available on the Configure (Arbitrated Loop) Tab are described in 
Table 27.
 

Table 27:  Configure (Arbitrated Loop) Field Descriptions 

Field Descriptions
Arbitrated Loop Parameters

Send FAN Frames Specify that Fabric Access Notification frames be sent to 
public loop devices and notify them of their node ID and 
address. Default is enabled. 

Always Send RCSN Check this box to issue a Remote State Change notification; 
following the completion of loop initialization, FL_Ports detect 
the presence of new devices or the absence of preexisting 
devices.

Do Not Allow 
ALPA_0x00

Check box to specify that AL_PA value 0x00 is not allowed.
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Configure (System) Tab Example
An example of the Configure (System) Tab is shown in Figure 28.

Figure 28:  Configure (System) Tab of the Switch Admin Window
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Configure (System) Field Descriptions
The fields available in the Configure System Tab are described in Table 28.

Table 28:  Configure (System) Field Descriptions 

Field Descriptions
System Parameters

rstatd Check box to dynamically enable or disable a server that 
returns information about system operation information 
through remote procedure calls.

rapid Check box to enable rapid system service. Default is enabled. 
ruserd Check box to dynamically enable or disable a server that 

returns information about the user who is logged into the 
system through remote procedure calls.

RLS Probing Check box to enable Read Link Status probing of AL_PAs. 
Default is enabled. 
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Using the Configure Tab to Configure FAN Frame Notification 
Parameters

To configure FAN frame notification parameters:

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Configure tab.

4. Select the Arbitrated Loop tab. 

5. Check or uncheck the FAN Frame Notification box in the Arbitrated Loop 
Parameters section. 

6. Click the Apply button. 
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About the Routing Tab
Use the Routing Tab of the Administrative Interface to perform tasks such as:

■ View the Fabric Shortest Path First (FSPF) routing information.

■ Add or delete a static route.

■ Set the link cost for the selected ports.

Note:  If a switch has one or more ISLs attached to itself, and no attached devices, the 
Routing tab will not display any information. 

Navigation Tree
The Routing tab contains a Routing Navigation Tree, from which you can access 
the specific routing areas. Fields will change depending on the routing interface 
you have chosen to view. For information regarding using the Routing Tab, see 
“Using the Routing Tab” on page 139.

Dynamic Load Sharing
Dynamic Load Sharing (DLS) can be enabled using the Routing tab. DLS refers to 
a dynamic distribution of traffic over available paths. Enabling this feature allows 
a path to be discovered automatically by the FSPF path selection protocol. See 
“Routing (FSPF Route) Field Descriptions” on page 133.

In-Order Delivery
In-Order Delivery (IOD) can be enabled using the Routing tab. Enabling IOD 
guarantees that frames are either delivered in order or dropped.
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Routing (FSPF Route) Tab Example
An example of the Routing (FSPF Route) Tab is shown in Figure 29.

Figure 29:  Routing (FSPF Route) Tab of the Switch Admin Window
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Routing Field Descriptions
Descriptions of the fields available in the Routing Tab are shown in Table 29. 
These fields are displayed for all the routing tabs.

Routing (FSPF Route) Field Descriptions
Select FSFP Route Tab on the Routing Navigation tree to display the fields 
described in Table 30.

Table 29:  Routing Field Descriptions 

Fields Descriptions
Dynamic Load 
Sharing (DLS)

Click the appropriate radio button to turn Dynamic Load 
Sharing on or off.

In-Order Delivery 
(IOD)

Click the radio button to turn In-Order Delivery on or off. 
Enabling IOD guarantees that frames are either delivered in 
order or dropped.

Routing Navigation 
Tree

Select the item in the Routing Navigation tree to be viewed, 
either FSPF, Static Route, or Link Cost. 

Table 30:  Routing (FSPF Route) Field Descriptions 

Field Description

Note:  No information appears in the Routing tab if the switch has one of more ISLs 
attached to itself, and no attached devices. 

In Port Displays the Port number to which you want frames to come 
in. 

Destination Displays the destination domain ID for the participating static 
routes for a particular In Port. The destination domain IDs 
match the Out Ports in the cell.

Out Port Displays the Out Port. It should be within the range of ports 
that are available for static routes for the current domain. 
More than one Out Port can be used for any In port with a 
different domain ID. Each domain ID requires an Out Port. 

Metric Displays the cost of reaching the destination domain. 
Hops Displays the number of hops in the “shortest path” route. 
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Flags Displays whether the route is Static (S) or Dynamic (D). See 
“About the Routing Tab” on page 131.

Next Domain Displays the next domain ID in the routing path. The Next 
Domain is the switch that the Out Port is connected to. 

Next Port Displays the next Port in the routing path. The Next Port is the 
port number that the Out Port is connected to. 

Table 30:  Routing (FSPF Route) Field Descriptions  (Continued)

Field Description
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Routing (Static Route) Tab Example
An example of the Routing (Static Route) Tab is shown in Figure 30.

Figure 30:  Routing (Static Route) Tab of the Switch Admin Window
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Routing (Static Route) Field Descriptions
Select Static Route from the Routing Navigation tree to display the fields 
described in Table 31.

Table 31:  Routing (Static Route) Field Descriptions 

Field Description
In Port Enter the number of the port by which frames come in. 
Destination 
Domain

Displays the destination domain ID for the 
“comma-separated” participating static routes for a particular 
In Port. The destination domain IDs match the Out Ports in the 
cell.

Out Port Enter the Out Port. It should be within the range of ports that 
are available for static routes for the current domain. More 
than one Out Port can be used for any In Port with a different 
domain ID. Each domain ID requires an Out Port. 

Add Click to create a new static route. A new column appears in 
the window. The Add button only modifies the static route 
table, click Apply to apply these changes to the switch.

Delete Click to delete a selected route. This button is grayed if no 
static route is selected.
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Routing (Link Cost) Tab Example
An example of the Routing (Link Cost) Tab is shown in Figure 31.

Figure 31:  Routing (Link Cost) Tab of the Switch Admin Window
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Routing (Link Cost) Field Descriptions
Select Link Cost from the Routing Navigation tree to display the fields described 
in Table 32. 

Table 32:  Routing (Link Cost) Field Descriptions 

Fields Descriptions
Port Number Displays the port number.
Cost Displays the link cost for the associated port. Select to change 

the link cost. For a 1 Gbit/sec per second ISL, the default cost 
is 1000. For a 2 Gbit/sec ISL, the default cost is 500. Valid 
values for link cost are from 1 to 9999.
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Using the Routing Tab
The Routing tab is used to configure and view routing as described in the 
following sections.

Viewing FSPF Routing
For information regarding FSPF, see “About the Routing Tab” on page 131.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Routing tab.

4. Click on the word FSFP from the Navigation tree. 

The FSFP window appears. If no information appears, see “Routing (FSPF 
Route) Field Descriptions” on page 133.

5. View Hops and Metrics.

Setting up a Static Route
Perform the following procedure to set up a Static Route.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Routing tab.

4. Click on the words Static Route in the Navigation tree.

The Static Route window appears. 

5. Click the Add button.

A new blank line appears in the window. 

6. Enter the In Port number for the route. 

7. Enter the Destination Domain. The destination domain IDs match the out 
ports in the cell.

8. Enter the Out Port number for the route. 

9. Click the Apply button.
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Enabling/Disabling Dynamic Load Sharing
For information regarding Dynamic Load Sharing (DLS), see “About the Routing 
Tab” on page 131.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Routing tab.

4. Select the On radio button to enable Dynamic Load Sharing;
or, Select the Off radio button to disable Dynamic Load Sharing. 

5. Click the Apply button.

Enabling/Disabling In-Order Delivery
For information regarding Dynamic Load Sharing (DLS), see “About the Routing 
Tab” on page 131.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Routing tab.

4. Highlight a type of routing from the navigation tree.

5. Select the On radio button to enable In-Order Delivery;
or, Select the Off radio button to disable In-Order Delivery. 

6. Click the Apply button.

Configuring Link Cost
For information regarding Dynamic Load Sharing (DLS), see “About the Routing 
Tab” on page 131.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Routing tab.

4. Click Link Cost from the navigation tree. 

5. Click in the Link column that corresponds to the appropriate port. 
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6. Enter the desired link cost. For a 1 Gbit/sec per second ISL, the default cost is 
1000. For a 2 Gbit/sec ISL, the default cost is 500. Valid values for link cost 
are from 1 to 9999.

7. Click the Apply button.
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About the Extended Fabric Tab
Use the Extended Fabric tab to manage the Extended Fabric feature. From the 
Extended Fabric tab you can specify which ports to be configured for distance and 
at what level. All switches come with L0 and LE (extended normal) settings. An 
Extended Fabric license allows additional settings of L1 and L2. For ports that are 
disabled, the rows appear grayed-out in the table within the Extended Fabric tab.

For more detailed information regarding the Extended Fabric feature, see the HP 
StorageWorks Extended Fabric Version 3.1.x/4.1.x User Guide. 

VCXLT Initiation
Enabling Virtual Channel link translation mode allocates enough full-size frame 
buffers on a particular port to support a long-distance link up to 100km. See the 
portcfglongdistance command in the HP StorageWorks Fabric OS 
Version 3.1.x/4.1.x Reference Guide for more information. 

Port Speed
The port speed is displayed as follows:

■ 1G - 1 Gbit/sec

■ 2G - 2 Gbit/sec

■ N1 - Negotiated 1 Gbit/sec 

■ N2 - Negotiated 2 Gbit/sec

Long Distance Settings
The below values do not require an Extended Fabric license:

■ L0 - No long distance setting enabled.

■ LE - Extended Normal setting enabled, less than 10 km or 6 miles.

The below values require an Extended Fabric license:

■ L0.5 - Less than 25 km. 

■ L1 - Medium long distance setting enabled, less than 50 km or 31 miles. 

■ L2 - Long distance setting enabled, less than 100 km or 62 miles. 

■ LD - Dynamic setting. 
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Extended Fabric Tab Example
An example of the Extended Fabric tab is shown in Figure 32.

Figure 32:  Extended Fabric Tab of the Switch Admin Window

Extended Fabric Field Descriptions
The fields available in the Extended Fabric Tab are described in Table 33.
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Table 33:  Extended Fabric Field Descriptions 

Fields Descriptions
Extended Fabric Mode

Enable Click the radio button to enable the Extended Fabric mode. 
The switch must be disabled to enable the Extended Fabric 
mode.

Disable Click to disable the Extended Fabric Mode. 
Port Number Displays the port number being used for the Extended 

Fabric.
VCXLT Link Init 
Enabled

Check the box to enable Virtual Channel link translation. See 
“About the Upload/Download Tab” on page 103.

Port Speed Displays the current port speed. The possible port speeds are 
described in “About the Upload/Download Tab” on 
page 103. 

Long Distance 
Setting

Display or configure the long distance setting. Change by 
selecting from the drop-down menu. 
The below values do not require an Extended Fabric license:
■ L0 - No long distance setting enabled.
■ LE - Extended Normal setting enabled, less than 10 km 

or 6 miles.
The below values require an Extended Fabric license:
■ L0.5 - Less than 25 km. 
■ L1 - Medium long distance setting enabled, less than 50 

km or 31 miles. 
■ L2 - Long distance setting enabled, less than 100 km or 

62 miles. 
■ LD - Dynamic setting. 
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Using the Extended Fabric Tab to Configure a Port For 
Long-Distance

Perform the following steps to configure a port for Long-Distance.

1. Access the Switch Admin Window (see “About the Switch Admin Window” 
on page 92).

2. Enter the admin user name and password. 

3. Select the Extended Fabric tab.

4. Click the Enable radio button. 

5. Check the VCXLT box. 

6. Select the desired distance from the Long-Distance Setting drop-down menu. 

Depending on the distance selected, this may require an optional license. For 
information about the various distances, see “About the Upload/Download 
Tab” on page 103.

7. Click the Apply button. 
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About the Trunk Information Tab
The Trunk Information tab is a read-only tab and has only the Close and Refresh 
button functions. 

■ For information regarding enabling Trunking, see “Using the Port Setting 
Tab” on page 118.

■ For more information regarding Trunking, see the HP StorageWorks ISL 
Trunking Version 3.1.x/4.1.x User Guide. 

Trunk Information Tab Example 
An example of the Trunk Information Tab is shown in Figure 33.

Figure 33:  Trunk Information Tab of the Switch Admin Window
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Trunk Information Field Descriptions
Descriptions of the fields available in the Trunk Information tab are shown in 
Table 34.

Table 34:  Trunk Information Field Descriptions

Field Description
Trunk Group Displays all the Trunking Groups on a switch. All of the ports 

that are part of the Trunking Group are displayed. 
Master Port Displays whether the trunking port connection is the Master 

Port connection for this trunking group. 
Member Ports 
(Area ID)

Displays a list of Member Ports. Ports are identified by area 
ID.
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Using the Trunk Information Tab
The Trunk tab is a read-only tab. Trunking is enabled through the Port Setting tab 
of the Administrative Interface; see “Using the Port Setting Tab” on page 118.

Accessing the Trunk Information Tab
1. Access the Switch Admin Window (see “About the Switch Admin Window” 

on page 92).

2. Enter the admin user name and password. 

3. Select the Trunk tab.
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6Performance Monitoring

This chapter provides the following information:

■ About Performance Monitor, page 150

■ Using the Performance Monitor, page 153
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About Performance Monitor
The Performance Monitor provides SAN performance management through an 
end-to-end monitoring system that provides:

■ Increased end-to-end visibility into the fabric.

■ More accurate reporting for service level agreements and charged access 
applications. 

■ Increased performance tuning and resource optimization. 

■ Shortened troubleshooting time.

■ Better capacity planning.

■ Increased productivity with pre-formatted and customizable screens and 
reports. 

The Performance Monitor graphically displays throughput (megabytes per 
second) for each port and for the entire switch. 

Port Throughput
Port throughput is the rate of bytes received at a port plus the number of bytes 
transmitted.

Switch Throughput
Switch throughput is the sum of the throughput for all the ports. The Performance 
Monitor also allows the graphing of traffic based on the Source ID and the 
Destination ID hardware filtering mechanism. 

Basic Monitoring
The Performance Monitor (in Basic mode—see “About Basic Monitoring” on 
page 164) is standard in the Web Tools software. 

Advanced Monitoring
The Advanced Monitoring menu in Performance Monitor is an optionally licensed 
software feature.

Features
Some of the features available in the Performance Monitor include:
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■ An existing report can be selected from a list of reports that are predefined. In 
some cases, you can supply the object to be monitored and graphed (such as 
port number, SID/DID pair, AL_PA, or switch domain number).

■ Graphs are displayed on a canvas, which can hold a maximum of eight graphs 
simultaneously. An individual graph can be maximized to occupy the entire 
canvas. The size of the graphs on the canvas is determined by the number of 
graphs being displayed. The window does not need to be scrolled to view all 
the selected graphs.

■ The collection of graphs in the canvas can be stored for later retrieval on the 
switch. Up to 20 individual canvases can be saved. Each canvas is saved with 
its name, a brief description, and up to 8 graphs which comprise the canvas. 

■ Any graph can Zoom In, or be magnified and detached from the main canvas 
or Removed from the main canvas using a pop-up menu. The pop-up menu is 
displayed by pointing the mouse at any graph on the main canvas and clicking 
the right mouse button. To re-attach the (Zoomed Out) detached graph back to 
the main canvas, you can point the mouse to the detached graph, click the 
right button and select Zoom Out.

■ Each graph can be printed to a printer of choice.

For more information about the Performance Monitor, see the HP StorageWorks 
Advanced Performance Monitoring Version 3.1.x/4.1.x User Guide. 
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Performance Monitor Example
An example of the Performance Monitor window is displayed in Figure 34.

Figure 34:  Performance Monitor Window
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Using the Performance Monitor
Perform the following steps to access the Performance Monitor.

1. Launch Web Tools, displaying the Switch Explorer.

2. Select the desired switch from the Fabric Tree. 

The Switch View of that switch displays.

3. Click the Performance button.

For more information, see “Switch Graphic Buttons” on page 54.

The Performance Monitor displays, as shown in “Performance Monitor Window” 
on page 152.
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About the Actions Menu
Use the Actions Menu to access the following options:

■ Save Current Canvas Configuration

■ Display Canvas Configurations

■ Display Resource Usage (This option requires a Performance Monitor 
license)

■ Print All Graphs

Actions Menu Example
The Actions menu is shown in Figure 35.

Figure 35:  Performance Monitor Actions Menu

Actions Menu Descriptions
The options available on the Actions menu are shown in Table 35. 
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Display Canvas Configurations Example
An example of the Display Canvas Configurations window is shown in Figure 36.

Table 35:  Actions Menu Options Descriptions 

Option Description
Save Current 
Canvas 
Configuration

Select this menu option to save the current Canvas 
Configuration to the switch. A dialog box appears; enter a 
canvas name and a brief description to save the Canvas 
Configuration. 

Display Canvas 
Configurations

Select this menu option to view all the Canvas Configurations 
that have been saved on the switch. A dialog box appears if 
graphs have been previously saved to the switch (see 
Figure 36). Select a Canvas Configuration name from the 
dialog box.

Display Resource 
Usage

Select this menu option to display all the ports in the switch 
and which ports are monitored and which ports are free. This 
option requires a Performance Monitor license.

Print All Graphs Use to print all the graphs on a selected canvas. 
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Figure 36:  Display Canvas Configuration Example

Display Canvas Configuration Descriptions
The Display Canvas Configuration Field Descriptions are listed in Table 36. 

Table 36:  Display Canvas Configuration 

Field Description
Canvas Name Displays the name of the saved canvas configuration. 
Description Displays the saved description of the canvas.
Load Select a canvas name from the list, and click the Load button 

to load that canvas. 
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Save Canvas Configuration Example
An example of the Save Canvas Configuration option is shown in Figure 37.

Figure 37:  Save Canvas Configuration Example

Save Canvas Configuration Descriptions
The Save Canvas Configuration options are displayed in Table 37. 

Edit Select to edit the highlighted canvas configuration. A dialog 
box appears, containing the following options:
■ Save - Saves a selected canvas.
■ Edit - Change specifications of a selected canvas.
■ Add - Add a graph to a canvas.
■ Remove - Remove a graph from the main canvas.
■ Cancel - Closes the Edit Canvas window. 

Copy Use to make a copy of a selected canvas and save it to the 
switch. The copied canvas appears in the list of canvases. 

Remove Use this button to remove a selected canvas from the switch. 
Close Use this button to close this dialog box. 

Table 36:  Display Canvas Configuration  (Continued)

Field Description
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Display Resource Usage Example
An example of the Display Resource Usage window is shown in Figure 36.

This screen requires a Performance Monitor License to display. 

Table 37:  Save Canvas Configuration Descriptions 

Field Description
Name Enter a name of the canvas to be saved.
Description Enter a description that will help you remember the 

information on the canvas.
Save Canvas Select to save the canvas after entering name and 

description.
Cancel Select to exit the Save Canvas Configuration window without 

saving changes. 
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Figure 38:  Display Resource Usage Example for Core Switch 2/64

Display Resource Usage Descriptions
The Display Resource Usage Field Descriptions are listed in Table 36. 
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Print All Graphs
Use the Print All Graphs option in the Actions menu to print all the graphs 
displayed on the selected canvas configuration. Only one canvas configuration can 
be opened at a time. Each Canvas Configuration can have a total of 8 monitors.

Table 38:  Display Resource Usage 

Field Description
Port This column displays all the ports available for monitoring in 

the switch.
EE 0-7 Displays the number of End-to-End Monitors configured for a 

particular port. Each port can have a maximum of 8 
monitors.

FL24-31 Displays the number of Filter Monitors configured for a 
particular port. Each port can have a maximum of 8 
monitors.
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Using the Actions Menu
The following sections describe the operations supported by the Actions Menu.

Adding a Graph to a Canvas
1. Access the Performance Monitor functionality. See “Launch Web Tools, 

displaying the Switch Explorer.” on page 153 for more information.

2. Select Actions > Display Canvas Configurations.

The Canvas Configuration List appears (see the example: “Creating an 
SID/DID Performance Graph” on page 170 if a graph has not yet been 
created). 

3. Highlight the desired graph in the list. 

4. Click the Load Button.

The graph appears on the main canvas. 

5. Repeat steps 3 and 4 for each graph you want to add to the canvas. 

You can add up to 8 graphs to a canvas. 

Changing an Existing Graph
1. Access the Performance Monitor functionality. See “Launch Web Tools, 

displaying the Switch Explorer.” on page 153 for more information.

2. Select Actions > Display Canvas Configurations.

The Canvas Configuration List appears (see the example: “Creating a Port 
Throughput Graph” on page 167 if a graph has not yet been created). 

3. Select the desired graph from the list. 

4. Click the Edit button. 

The Edit Graph dialog box appears. 

5. Click the Edit button.

6. Make necessary changes. 

7. Click the OK button.
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Printing Graphs
1. Access the Performance Monitor functionality. Refer to “Launch Web Tools, 

displaying the Switch Explorer.” page 153 on for more information

2. Select Actions > Display Canvas Configurations.

The Canvas Configuration List appears (see “Creating a Port Throughput 
Graph” on page 167 if a graph has not yet been created). 

3. Select the desired graph from the list. 

4. Click the Load Canvas button. 

The graph appears on the canvas. 

5. Repeat to add more graphs to the canvas (add up to 8 graphs).

6. Select the Actions > Print All Graphs option. 

The print dialog box appears. 

7. Click Ok. 
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About the Performance Graphs Menu
The Performance Graphs drop-down menu provides Performance Graph 
operations as described in the following sections.

■ About Basic Monitoring on page 164

■ About Advanced Monitoring (Optional) on page 168
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About Basic Monitoring
The Performance Graphs > Basic Monitoring menu provides the following 
types of graphs:

■ Port Throughput Graph

■ Switch Aggregate Throughput Graph

■ Blade Aggregate Throughput Graph (Core Switch 2/64 only)

■ Switch Throughput Utilization Graph

■ Port Error Graph

■ Switch Percent Utilization Graph

■ Port SnapShot Error Graph

Basic Monitoring Example
An example of a Port Throughput Setup window is shown in Figure 39. 

Figure 39:  Port Throughput Setup Example on a Core Switch 2/64
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Basic Monitoring Descriptions
The Basic Monitoring options are described in Table 39. 

Table 39:  Basic Monitoring Graph Descriptions 

Name of Basic 
Monitoring 

Graph

Scope 
of 

Graph
Graph 
Type Graph Description

Port Throughput 
Graph

Port Line Displays the performance of a port 
based on four-byte frames received 
and transmitted. The snapshot rate 
for this graph is every 15 seconds 
with a 60 minute lifespan for each 
snapshot.

Switch Aggregate 
Throughput Graph

Switch Line Displays the aggregate 
performance of all ports of a 
switch. The snapshot rate for this 
graph is every 15 seconds with a 
60 minute lifespan for each 
snapshot.

Blade Aggregate 
Throughput Graph

Switch Line Displays the aggregate 
performance of all blades of a 
switch. The snapshot rate for this 
graph is every 15 seconds with a 
60 minute life span for each 
snapshot. Available for the Core 
Switch 2/64 only.

Switch Throughput 
Utilization Graph

Switch Horizontal 
Bar

Displays the port throughput at the 
time the sample is taken. The 
snapshot rate for this graph is 
every 5 seconds.
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Port Error Graph Port Line Displays the CRC error rate over 
time for a given port. The snapshot 
rate for this graph is every 15 
seconds with a 60 minute lifespan 
for each snapshot.

Switch Percent 
Utilization Graph

Switch Horizontal 
Bar

Displays the percentage of usage 
of a chosen switch at the time the 
sample is taken. The snapshot rate 
for this graph is every 5 seconds.

Ports SnapShot 
Error Graph

Switch Vertical Bar Displays the CRC error rate 
between sampling periods for all 
the ports on a switch. The snapshot 
rate for this graph is every 15 
seconds with a 60 minute lifespan 
for each snapshot.

Table 39:  Basic Monitoring Graph Descriptions  (Continued)

Name of Basic 
Monitoring 

Graph

Scope 
of 

Graph
Graph 
Type Graph Description
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Using Basic Performance Monitoring
The Basic Performance Monitoring are described in the following sections.

Creating a Port Throughput Graph
Perform the following steps to create a Port Throughput graph.

1. Access the Performance Monitor functionality. See “Launch Web Tools, 
displaying the Switch Explorer.” on page 153 for more information.

2. Select the Performance Graphs drop-down menu.

3. Select Performance Graphs > Basic Monitoring.

4. Select the Port Throughput Graph.

The Port Throughput setup window is displayed.

5. Double-click on a switch folder to see available ports.

6. Type or click and drag the selected port number from the Port Selection list to 
the Enter/Drag Port window. 

7. Click the Ok button.

Creating a Snapshot of Port Errors
Create a snapshot of port error by performing the following procedure.

1. Access the Performance Monitor functionality. See “Launch Web Tools, 
displaying the Switch Explorer.” on page 153 for more information.

2. Select the Performance Graphs drop-down menu.

3. Select Performance Graphs > Basic Monitoring.

4. Select Port Snapshot Errors.

The Port Snapshot errors graph is displayed on the canvas.

5. Select Actions > Save Current Canvas Configuration to save the graphs on 
the canvas. 
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About Advanced Monitoring (Optional)
The Advanced Monitoring menu provides the following graphs:

■ SID/DID Performance Graph

■ SCSI Commands Graph

■ SCSI vs. IP Graph

■ AL_PA Error Graph

Advanced Monitoring Example
An example of the SCSI Write on a LUN Per Port Setup window is shown in 
Figure 40. 

Figure 40:  SCSI Write on a LUN Per Port Setup Example on a SAN Switch 2/32

Advanced Monitoring Descriptions
The Advanced Monitoring graphs are described in Table 40.
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Table 40:  Advanced Monitoring Graph Descriptions

Name of 
Advanced 

Monitoring Graph
Scope of 
Graph Graph Type Graph Description

SID/DID 
Performance Graph

Switch Line Charts the traffic between a SID and a 
DID pair on the switch being managed. 
The snapshot rate for this graph is every 
15 seconds with a 60 minute life span 
for each snapshot. See “Creating an 
SID/DID Performance Graph” on 
page 170. 

SCSI Commands 
Graph

Switch Line Displays the total number of Read/Write 
commands per second on a given port 
to a specific LUN.
Provides the following choices:
SCSI Read/Write on a LUN per port.
SCSI Read on a LUN per port.
SCSI Write on a LUN per port.
SCSI Read/Write per port.
SCSI Read per port.
SCSI Write per port. 
The snapshot rate for this graph is every 
15 seconds with a 60 minute lifespan 
for each snapshot.

SCSI vs IP Graph Switch Vertical Bar Shows percentage of SCSI vs. IP frame 
traffic on each individual port. See 
“Creating an SCSI vs. IP Traffic Graph” 
on page 170. The snapshot rate for this 
graph is every 5 seconds.

AL_PA Error Graph Switch Line Displays the CRC error rate over time for 
a given port and a given AL_PA. The 
snapshot rate for this graph is every 15 
seconds with a 60 minute lifespan for 
each snapshot.
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Using Advanced Performance Monitoring
The following sections show the use of Advanced Performance Monitoring to 
create SID/DID Performance and SCSI vs. IP Traffic graphs.

Creating an SID/DID Performance Graph
Perform the following steps to create an SID/DID Performance graph.

1. Access the Performance Monitor functionality. See “Launch Web Tools, 
displaying the Switch Explorer.” on page 153 for more information.

2. Select the Performance Graphs drop-down menu.

3. Select Performance Graphs > Advanced Monitoring.

4. Select SID/DID Performance Graph.

The SID/DID Performance Monitor setup window appears. 

5. Double-click on a folder in the Port Selection List window. 

A drop-down list of ports appears.

6. Type or drag/drop the port that you want to monitor or change. 

7. Select the port “folder”, or the small icon that appears next to it. A drop-down 
list of SID/DID files appear. 

8. Type or drag/drop the SID/DID that you want to monitor or change. 

9. Click the OK button. 

Creating an SCSI vs. IP Traffic Graph
Perform the following steps to create an SCSI vs. IP Traffic graph.

1. Access the Performance Monitor functionality. See “Launch Web Tools, 
displaying the Switch Explorer.” on page 153 for more information.

2. Select the Performance Graphs drop-down menu.

3. Select Performance Graphs > Advanced Monitoring.

4. Select SCSI vs. IP Traffic.
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7Fabric Watch

This chapter provides the following information:

■ About Fabric Watch, page 172

■ Accessing Fabric Watch, page 173
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About Fabric Watch
The Fabric Watch icon only appears when a Fabric Watch license is installed on 
the switch. Use the Fabric Watch Software to monitor fabric elements for potential 
problem conditions through Alarms and setting the desired thresholds for various 
conditions. 

For more detailed information regarding Fabric Watch, see the HP StorageWorks 
Fabric Watch Version 3.1.x/4.1.x User Guide. 

Navigation Tree The Fabric Watch software contains a Navigation tree on 
the left side of the screen (see “Alarm Notification Tab of 
Fabric Watch” on page 174). Use the navigation tree to 
select the class. This changes the options available in the 
area to the right.

Threshold A threshold is a value or range of values to which Fabric 
Watch computes a behavior counter to determine if the 
behavior value is correct or warrants alarm. 

Boundaries Boundaries are the characteristics that define a threshold. 
Boundaries are area-based; when you configure a 
boundary, that boundary applies to every element in an 
area. 
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Accessing Fabric Watch
Access Fabric Watch by performing the following steps.

1. Launch Web Tools.

2. Select the Switch icon from which you want to view or configure alarms. 

3. Select the Fabric Watch (magnifying glass) button. 

Note:  The Fabric Watch icon only appears in the switch view if the Fabric Watch 
license has been activated.

A password dialog box appears.

4. Enter an Admin level user name and password. 

The Fabric Watch window appears. 
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About the Alarm Notification Tab
Use the Alarm Notifications tab of the Fabric Watch software to view the 
information for all elements of the Fabric Watch, Fabric, Switch, Ports, or 
Performance Monitor classes. 

The Alarm Notification tab polls current events from Fabric Watch, and refreshes 
the displayed information according to the threshold configuration. 

Alarm Notification Tab Example
An example of the Fabric Watch tab is shown in Figure 41.

Figure 41:  Alarm Notification Tab of Fabric Watch
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Alarm Notification Field Descriptions
The Alarm Notification fields are described in Table 41.

Table 41:  Alarm Notification Field Descriptions 

Field Description
Selected Area Displays the configurable areas in the drop-down menu. The 

items listed will change depending on the item selected in the 
Navigation tree. 

Name Displays the name of the alarm.
The name of the alarm is a combination of the fabric element 
whose behavior set off the alarm:
■ Class
■ Area
■ Index number 

State Displays the severity of the alarm that governs what kind of 
traps Fabric Watch employs in a response to an event. The 
State of the alarm can be Informative, Normal, or Faulty.

Reason Displays the reason that an alarm notification was sent, such 
as Started, Changed, Exceeded, Below, Above, or In 
between.

Last Value Displays the value of a counter (behavior variable) prior to 
the alarm. 

Current Value Displays the value of the counter (behavior variable) that set 
off the alarms. 

Time Displays the time and date the notification was sent from the 
switch. 
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Using the Alarm Notification Tab
Access the Alarm Notification tab and view alarms by performing the following 
steps.

1. Launch Fabric Watch (see “Launch Web Tools.” on page 173).

2. Select the Alarm Notification tab.

3. Highlight a device in the navigation tree. 

You can select a whole device (such as a Switch) or an element of that device 
(such as Security). 

4. Select an alarm area to be viewed from the Select Area drop-down menu. 

The items available depend on what you have selected in the navigation tree.

5. View current alarm information. 
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About the Threshold Configuration Tab
Use the Threshold Configuration tab to view and configure Fabric Watch 
thresholds for the Fabric Watch class currently selected in the Navigation tree on 
the left side of the window. 

The Threshold Configuration tab has the following sub-tabs:

■ Area Configuration (Table 42).

■ Element Configuration (Table 43).

■ Configuration Report (Table 44). 

Threshold Configuration Tab Example
The Threshold Configuration Tab > Area Configuration Tab is shown in 
Figure 42.

Figure 42:  Threshold Configuration Area Configuration Tab
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Threshold Notification Fields Descriptions
The Fabric Watch > Threshold Configuration > Area Configuration fields are 
described in Table 42

Table 42:  Threshold Configuration Area Configuration Field Descriptions 

Field Description
Boundary 

Unit Set or display the selected unit values used for the chosen 
area. Depending on the area of interest, this is figured in 
units of “downs, reconfigs, errors, changes, logins,” etc.

High Set or display the number of high boundaries (the highest 
limit at which an element will not trigger an event) for the 
selected area. 

BufferSize Set or display the threshold boundry buffer size of the 
selected area. 

TimeBase Set or display the basic unit of time in which events are 
recorded for the selected area. The units available from the 
drop-down menu are: none, second, minute, hour, or day. 

Low Set or display the number of low boundaries (the lowest limit 
at which an element will not trigger an event) for the selected 
area. 

Select Boundry Level Select either a default or custom setting for the boundry levels 
from the drop-down menu. The default values are shown in 
parenthesis. 

Alarm Setting
Alarm Notification 
Mechanisms

Select Alarm settings for Errorlog, SNMP, RAN, Portlog and 
Email to be active on the switch side.

Select Alarm Level Select either a custom or default setting for the alarm level 
from the drop-down; this setting will be active on the switch 
side menu. 

Update Flash Check box to update Flash Memory. From Web Tools, when 
you set new threshold values and click Apply, these new 
values are sent to the Fabric Watch daemon on the switch 
and activated at once. These values are not however saved in 
RAM and can be lost after a switch reboot. 
When you check the update flash box, the current set of 
threshold values will be committed to flash memory, which is 
persistent storage. Those values are then saved over a switch 
reboot.
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The Fabric Watch > Threshold Configuration > Element Configuration fields 
are described in Table 43.

The Fabric Watch > Threshold Configuration > Configuration Report fields 
are described in Table 44.

Table 43:  Threshold Configuration Element Configuration Field Descriptions 

Field Description
Select Area Use the drop-down menu to select the specific area to 

configure, such as E-Ports. The items that appear in this menu 
will vary depending on the item selected in the Navigation 
tree. 

Select Element Use the drop-down menu to chose the element to configure, 
such as a fabric. 

Status
Enable Select the radio button to enable alarms. 
Disable Select the radio button to disable alarms. 

Behavior Type
Triggered Select the Triggered Behavior mode if you want Fabric Watch 

to register an event when a variable exceeds a threshold. An 
event will not be triggered again until the variable falls and 
exceeds the threshold again. 

Continuous Select Continuous mode if you want Fabric Watch to register 
an event when a variable exceeds a threshold and continue 
to register an event for every time interval. 

Time Interval (in 
secs)

Select the amount of time (in seconds) that you want Fabric 
Watch to poll for a new event. 

Table 44:  Threshold Configuration Report Field Descriptions 

Field Description
Configuration for 
Class

Describes the class that is being reported. The item selected in 
the Navigation tree appears here. 

Begin Area Describes the current settings configured for the selected 
area. See Table 43.

Begin Element Describes the current settings configured for the selected 
area.

Changed Displays thresholds that have changed.
Exceeded Displays thresholds that have been exceeded. 
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Below Displays thresholds that have fallen below the configured 
level. 

Above Displays thresholds that have risen above the configured 
levels. 

In between Displays thresholds that have are in within the configured 
level. 

Table 44:  Threshold Configuration Report Field Descriptions  (Continued)

Field Description
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Using the Threshold Configuration Tab
Use the Configuration tab to configure and view alarms as shown in the following 
sections.

Configuring Boundary and Alarm Settings
1. Launch Fabric Watch (see “Launch Web Tools.” on page 173).

2. Select the Threshold Configuration tab.

3. Select the Area Configuration sub-tab.

4. Highlight an element in the navigation tree. 

You can select a whole device (such as a Switch) or an element of that device 
(such as Security). 

5. Select an Area (such as temperature or fan) from the Area drop-down menu. 

6. Configure the Threshold Settings. 

7. Configure the Alarm Settings. 

8. (Optional) Check the Flash box to update the flash memory. 

9. Click the Apply button. 

10. Enable Alarms (see “Enable/Disable Alarm Configurations” on page 181). 

Enable/Disable Alarm Configurations
1. Launch Fabric Watch (see “Launch Web Tools.” on page 173).

2. Select the Threshold Configuration tab.

3. Select the Element Configuration sub-tab. 

4. Select a previously configured element from the navigation tree (see 
“Configuring Boundary and Alarm Settings” on page 181).

5. Select the alarm area to be enabled or disabled from the Area drop-down 
menu. 

6. Select the Element Configuration tab. 

7. Select the alarm Element to be enabled/disabled from the Select Element 
drop-down menu. 

8. Select the Enable or Disable radio button. 

9. Click the Apply button. 
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Setting the Behavior Type of an Alarm
1. Launch Fabric Watch (see “Launch Web Tools.” on page 173).

2. Select the Threshold Configuration tab.

3. Select the Element Configuration sub-tab. 

4. Select a previously configured element from the navigation tree (see 
“Configuring Boundary and Alarm Settings” on page 181).

5. Select the alarm area to be configured from the Area drop-down menu. 

6. Select the Element Configuration sub-tab. 

7. Select the alarm Element to be configured from the Select Element drop-down 
menu. 

8. Select the Continuous or Triggered radio buttons (see Table 43 on page 179 
for descriptions). 

9. Click the Apply button. 

View an Alarm Configuration Report
1. Launch Fabric Watch (see “Launch Web Tools.” on page 173).

2. Select the Threshold Configuration tab.

3. Select the Configuration Report sub-tab. 

4. Select a previously configured element from the navigation tree (see 
“Configuring Boundary and Alarm Settings” on page 181).

5. Select the alarm area report to be viewed from the Area drop-down menu. 

6. Select the Configuration Report sub-tab. 
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About the Email Configuration Tab
Use the Email Configuration tab to enable and configure Email alarm 
notifications. A different Email Configuration can be set for each Class. For 
example, one Email notification can be set for SFPs and another can be set for 
E-Ports (see the navigation tree).

Email Configuration Tab Example
An example of the Email Configuration Tab is shown in Figure 43.

Figure 43:  Email Configuration Tab



Fabric Watch

184 Web Tools Version 3.1.x/4.1.x User Guide

Email Configuration Field Descriptions
The Fabric Watch Email Configuration fields are described in Table 45,

Table 45:  Email Configuration Field Descriptions 

Field Description
Mail Configuration

Mail Server Enter the mail server to which you want the alarm notification 
to be sent. 

Domain Name Enter the local Domain name. 
Mail From: Enter a valid switch name; information will be sent from this 

switch to the User. 
Mail To: Enter a valid mail receiver’s email address.

Mail Status
Enabled/Disabled Select the Enabled or Disabled radio button to enable or 

disable email alarm notifications. 
Mail Validation

Send a test email to 
the recipient

Check box to receive a validation email. 
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Using the Email Configuration Tab
Use the Email Configuration tab to set up the Alarm Email Notification.

1. Select the Fabric Watch icon (appears only when a Fabric Watch license is 
installed).

2. Enter an Admin level user name and password.

The Fabric Watch software appears.

3. Select the Email Configuration tab.

4. Select the Class to which you want to set the Email Configuration from the 
navigation tree; for example, E-Ports. 

5. Enter your domain primary name server IP address in the Name Server 1 field.

6. Enter your secondary Name Server IP address in the Name Server 2 field. 

7. Enter the domain name in the Domain Name field. 

8. Enter a valid mail recipient email address in the Mail To field.

9. Click the Enabled radio button in the Mail Status area. This enables Mail 
Sending alarms for the selected Class.

10. Check the “Send a Test Email to Recipient” box to validate the email 
configuration. 
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8Fabric Management

This chapter provides the following information:

■ About Fabric Management, page 188

■ Using Fabric Management, page 189



Fabric Management

188 Web Tools Version 3.1.x/4.1.x User Guide

About Fabric Management
Fabric Management is performed using the Fabric Management toolbar. 

Fabric Toolbar Example
An example of the Fabric Management toolbar is shown in Figure 44.

Figure 44:  Fabric Management Toolbar

Fabric Toolbar Descriptions
The Fabric Toolbar Buttons are referenced in “Fabric Toolbar” on page 49. 

Table 46:  Fabric Toolbar Descriptions 

Icon Description
Fabric Events Button See “About Fabric Management” on page 188.
Fabric Topology 
Button

See “About the Fabric Topology” on page 192.

Name Server 
Button

See “About the Name Server” on page 195.

Zoning Button See “About Zone Administration” on page 200.
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Using Fabric Management
Perform the following steps to access Fabric Management.

1. Launch Web Tools.

The Switch Explorer appears. 

2. Select an icon from the Fabric Toolbar to access fabric-wide management (see 
“Fabric Toolbar” on page 49).

The selected fabric management window appears. 
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About Fabric Events
The Fabric Events window provides a running log of events for all switches in the 
fabric.

Fabric Events Example
The Fabric Events window is shown in Figure 45.

Figure 45:  The Fabric Events Window 

Fabric Events Descriptions
The Fabric Events fields are described in Table 47.
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Accessing Fabric Events
To view events in the fabric, perform the following steps:

1. Access Web Tools. 

2. Find the Fabric toolbar.

See “Perform the following steps to access Fabric Management.” on 
page 189.

3. Select the Fabric Events icon in the lower corner of the Fabric Tree.

See “Fabric Toolbar” on page 49.

The Fabric Events window will display. 

To sort the events by a particular column, select the column header. To resize a 
column, drag the column divider.

Table 47:  Fabric Events Description of Fields 

Field Description
Switch Displays the name of the switch.
Number Displays the event number for the affected switch.
Time Displays the time of the event.
Count Displays the number of consecutive occurrences of the same 

event.
Level Displays the severity level of event:

0 panic (switch reboots)
1 critical
2 error
3 warning
4 information
5 debug

Message Displays the description of the event.
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About the Fabric Topology
The Fabric Topology View summarizes the physical configuration of the fabric 
from the perspective of the “local domain” (the domain of the switch currently 
being displayed in the Switch View). The Fabric Topology includes information 
about the “destination domains” (all other domains in the fabric) and the paths 
between each destination domain and the local domain.

Fabric Topology Example
An example of the Fabric Topology is shown in Figure 46.

Figure 46:  Fabric Topology Window
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Fabric Topology Descriptions
The Fabric Topology fields are described in Table 48.

Printing a Fabric Topology Report
To view a list of the fabric topology, perform the following steps:

1. Access the Switch Explorer.

See “Perform the following steps to access Fabric Management.” on 
page 189.

Table 48:  Fabric Topology Description of Fields 

Field Description
View Fabric 
Topology from 
Switch 
<switchname>:

Lists the switch in the domain that is assumed to be the local 
domain.

Print Select to print a Fabric Topology report of the local domain 
switch. 

There are a total of 
[n] domains in the 
fabric.

Displays the number of domains in the fabric.

Local domain ID: Displays a number that uniquely identifies the local switch 
within the fabric, and the name of the switch.

Domain ID: 
(may be more than 
one)

Displays a number that uniquely identifies each switch within 
the fabric, and the name of the switch.

Active Paths: This line is followed by information about each destination 
domain, including information about each of the paths 
between that domain and the local domain.

Destination Domain 
ID:

The ID of the destination domain that is described in the lines 
following the ID. This information and the two lines following 
it display for each destination domain in the fabric.

Destination’s 
Worldwide Name:

The WWN of the destination domain.

Number of Paths: The number of active paths between the destination domain 
and the local domain.

Print Button Select to print a Fabric Topology report of the destination 
domain. 
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2. Select the Fabric Events icon in Fabric Tree.

See “Fabric Toolbar” on page 49.

The Fabric Topology window displays. 

3. Select the top print button to print a topology report of the local domain.

4. Select the bottom print button to print a topology report of the destination 
domain. 
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About the Name Server
The Name Server Table View provides the name server entries listed in the Simple 
Name Server database. This includes all name server entries for the fabric, not 
only those that are local to the local domain. Each row in the table represents a 
different device.

Name Server Example
The Name Server Table window is shown in Figure 47.

Figure 47:  Name Server Table Window

Name Server Field Descriptions
The Name Server fields and buttons are described in Table 49. 
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Name Server column descriptions are in Table 50. 

Table 49:  Name Server Description of Fields and Buttons 

Field Description
Auto Refresh Check to enable Auto Refresh or uncheck to disable.
Auto Refresh 
Interval

If Auto Refresh is checked, enter the number of seconds for 
the refresh interval.

Number of Devices Displays the number of devices in the fabric.
Refresh Select to refresh the window immediately.
Print Select to print the Name Server table. 
Close Select to close the window.

Table 50:  Name Server Description of Columns 

Column Description
Domain # Displays the domain ID of the switch to which the device is 

connected.
Port # Displays the number of the switch port to which the device is 

connected.
Port Name Displays the name of the port. 
Port ID Displays the port ID of the device (24-bit hexadecimal value).
Port Type Displays the port type of the device (N for fabric direct 

attached port or NL for fabric direct attached loop port).
Fabric Port WWN Displays the worldwide name of the fabric port.
Device Port WWN Displays the worldwide name of the device port.
Device Node 
WWN

Displays the worldwide name of the device node.

Device Name Displays the symbolic name of the device assigned through 
the SCSI INQUIRY command.

FC4 Types Displays the Fibre Channel FC4 layer types supported by the 
device, such as IP or FCP.

COS Displays the Fibre Channel classes of service supported by 
the device.

Fabric Port Name Displays the name of the fabric port in use by the device.
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Viewing the Name Server
To view a list of the switches in the Name Server, perform the following steps:

1. Access the switch explorer View.

See “Perform the following steps to access Fabric Management.” on 
page 189.

2. Select the Name Server icon in the Fabric Toolbar.

See “Fabric Toolbar” on page 49.

The Name Server window displays. 

3. To sort the events by a particular column, select the column header. To resize a 
column, drag the column divider.

Port IP Address Displays the IP address of the fabric port.
Hard Address Displays the hard address of the fabric port.
Member of Zones Displays the zones to which this device belongs. This column 

does not update when the table is refreshed. To view updated 
zoning information, close and reopen the Name Server 
Table.

Table 50:  Name Server Description of Columns  (Continued)

Column Description
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About Zoning
An HP Zoning license and administrative privileges are required to access the 
Zone Administration view. If a switch or device is added or removed from the 
network, it is necessary to save the changes and relaunch the Zone Administration 
view for the changes to take effect.

For information regarding Zoning, see “Zone Administration” on page 199, or the 
HP StorageWorks Zoning Version 3.1.x/4.1.x User Guide. 
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9Zone Administration

This chapter provides the following information:

■ About Zone Administration, page 200

■ About the File Menu, page 205

■ About the Edit Menu, page 207

■ About the View Menu, page 210

■ About the Actions Menu, page 213

■ About the Alias Tab, page 217

■ About the Zone Tab, page 223

■ About the QuickLoop Tab, page 229

■ About the Fabric Assist Tab, page 234

■ About the Config Tab, page 240
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About Zone Administration
HP Zoning enables you to partition your Storage Area Network (SAN) into 
logical groupings of devices that can access each other. For example, you can 
partition your SAN into two zones, winzone and unixzone, so that your Windows 
servers and storage do not interact with your UNIX servers and storage. 

Alias Description
An alias is a logical group of ports, WWNs, or AL_PAs. Specifying groups of 
ports or devices as an alias makes zone configuration easier, by enabling you to 
configure zones using an alias rather than a long string of individual members. 
You can specify members of an alias using the following methods:

■ A switch domain and port area number pair, for example, "2, 20."

■ WWN (device)

■ QuickLoop AL_PAs (device)

Zone Description
A zone is a region within the fabric, where switches and devices can 
communicate. A device can only communicate with other devices connected to 
the fabric within its specified zone. You can specify members of a Zone using the 
following methods:

■ Alias names

■ Switch domain and port area number pair, for example, "2, 20." 

■ WWN (device)

■ QuickLoop AL_PAs (device)

Configuration Description
A configuration (often called a config) is a group of zones; Zoning is enabled on a 
fabric by enabling a specific config. You can specify members of a config using 
the following methods:

■ Zone names

■ QuickLoop names

■ FA (Fabric Assist) zone names
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Sample Configuration
Table 51 shows a sample zoning configuration:

Zoning Schemes
Various levels of zoning (or Zoning schemes) are created to isolate systems that 
have different operating environments. For example, you can create a zone of all 
ports connected to UNIX Servers, or another zone of all ports connected to 
Windows Servers. Zones are created to limit access of devices to other devices 
connected to the fabric within the same zone. 

Zones can be configured dynamically. They can vary in size depending on the 
number of fabric connected devices, and devices can belong to more than one 
zone. Because zone members can access only other members of the same zone, a 
device not included in a zone is not available to members of that zone.

Security
Zoning can only be managed or accessed by the primary FCS switch when 
security is enabled; the Zoning icon only appears on the primary FCS switch. If 
security is not enabled, the Zone icon appears in the Fabric Toolbar of every 
licensed switch. 

For specific information regarding Secure Fabrics, refer to the HP StorageWorks 
Secure Fabric OS Version 1.0 User Guide. 

Table 51:  Sample Zoning Database 

Alias Zone Config
alias1 = WWN; WWN; 
WWN
alias2 = WWN; 
<domain, port>
alias3 = WWN; <AL_PA> zone1 = alias1; alias2; 

WWN; <domain, port>; 
<ALPA>

alias4 = WWN; WWN; 
WWN

zone2 = alias3, alias4, 
WWN

myconfig = zone1, 
zone2
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Zoning Methods
There are four methods of defining members for zoning:

For more specific information about Zoning, or for configuring Zoning using 
Fabric OS command line interface, see the HP StorageWorks Zoning Version 
3.1.x/4.1.x User Guide. 

Selecting the Zoning Method
The Zoning method you select determines what will be displayed in the 
subsequent Zone Administration windows. The Zone method you choose is 
displayed in the header of the Zone Administration window.

An example of the View Menu is shown in Figure 48.

Figure 48:  View drop-down Menu of the Zone Administration Window

Zoning Method and Tabs Available
Depending on the method you use to zone certain tabs are may or may not be 
available on the Zone Administration window.

Mixed Zoning This method enables you to define members using the port 
area number, device WWNs, QuickLoop AL_PAs. This 
method is considered soft zoning.

Port Zoning This method enables you to define members using port 
area number only. This method is considered hard zoning.

WWN Zoning This method enables you to define members of zone using 
device WWNs. This method is considered hard zoning.

AL_PA Zoning This method enables you to define members of zone using 
QuickLoop AL_PAs only. This method is considered hard 
zoning.
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Zoning Method and Hard or Soft Zoning Enforcement
Whether you are using soft zoning or hard zoning is determined by the way the 
zone objects are defined.

Table 52:  Zone Methods and Tabs Available 

Zone Level Available Tabs
Mixed Zoning Alias Zone QuickLoop Fabric 

Assist
Config

Port Zoning Alias Zone QuickLoop Fabric 
Assist

Config

WWN Zoning Alias Zone QuickLoop Fabric 
Assist

Config

AL_PA Zoning Alias  Zone QuickLoop Config

Hard Zoning <domain, portID> exclusively or WWNs exclusively. That 
is, using only one of these methods to define all objects in 
the zoning database. 

Soft Zoning In software enforced zoning, zone or alias members can be 
defined by a mixture of port IDs and WWNs.
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Using the Zone Administration Window
The following sections present the use of the Zone Administration window.

Accessing the Zone Administration Window
The following steps show how to access the Zone Administration window.

1. Launch Web Tools.

The Switch Explorer appears.

2. Click the Zone Administration icon. See “Fabric Toolbar” on page 49.

The login dialog box appears. 

3. Enter the admin level user name and password. 

The Zone Administration window appears. 

Viewing the Enabled Zone Configuration
To view the enabled zone configuration, perform the following steps.

1. Launch Web Tools.

The Switch Explorer appears.

2. Highlight the desired switch icon in the fabric.

The current zone configuration (if one is enabled) is displayed in the lower 
portion of the Switch Information Panel. If no zone configuration is enabled 
the field displays “none.” See “Switch Information Window” on page 57 for 
more information.
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About the File Menu
The options available in the File Menu of the Zone Administration window are 
described in Table 53.

Table 53:  File Menu Options 

Option Description
Print Summary Select to print a zoning configuration report. A window 

displays both the effective configuration and the defined 
zoning configuration, if one exists. (see Figure 49). 

Close Select to close the Zone Administration window. 
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Using the File Menu
The following steps display the Zoning Configuration summary.

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select File > Print Summary. The Zoning Configuration summary dialog 
box is displayed. An example of the Zoning Configuration summary is 
displayed in Figure 49. 

Figure 49:  Zoning Configuration summary
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About the Edit Menu
The options available in the Edit Menu of the Zone Administration window are 
described in Table 54.

Table 54:  Edit Menu Options 

Option Description
Add WWN Select to add a WWN across Aliases, Zones or Fabric Assist 

Zones. A dialog box appears; enter the WWN number.
Delete WWN Select to delete a WWN across Aliases, Zones or Fabric Assist 

Zones. A dialog box appears; enter the WWN number.
Replace WWN Select to replace one WWN with another. A dialog box 

appears; enter first the WWN to be replaced, and then the 
new WWN. 

Search Member Select to search for a member of a zone. A dialog box 
appears; Enter any element that appears in the Member 
Selection List: Domain Name, Port name, Port ID, WWN, 
Device, Zone Name, or Alias Name.
Narrow searches by checking one or more of the following 
boxes:
■ Match Case
■ Match Whole Words Only
■ Wrap around. Check the Wrap around box if you want 

the search engine to restart after it hits the end of the 
string. Leave unchecked if you want the search engine to 
stop once it hits the end of the string; a message appears 
to indicate the search is complete. 
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Using the Edit Menu
The Edit menu is used to perform the functions described in the following 
sections.

Adding a WWN in the Zoning Database
To add a WWN to the Zoning database, perform the following procedure.

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select Edit > Add a WWN. The Add WWN... dialog box is displayed.

3. Enter a WWN value in the WWN field.

4. Click the OK button. The WWN is added to the Zoning database and can be 
used as a member. 

Note:  This WWN added does not need to currently exist in the fabric. This procedure 
enables you to configure a WWN as a member in a Zone Configuration prior to 
adding that device to the fabric.

Deleting a WWN in the Zoning Database
This procedure deletes a WWN from the Zoning database.

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select Edit > Delete a WWN. The Delete WWN... dialog box is displayed.

3. Enter a WWN value in the WWN field.

4. Click the OK button. The WWN is deleted from the Zoning database and as a 
member from any alias or zone. 
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Replacing a WWN in the Zoning Database
This procedure enables you to replace a WWN throughout the zoning database. 
This is helpful when exchanging devices in your fabric, and easily maintaining 
your current Configuration.

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select Edit > Replace a WWN. The Replace WWN... dialog box is 
displayed.

3. Enter the WWN to be replaced in the Replace field.

4. Enter the new WWN in the By field.

5. Click the OK button. The old WWN is replaced in the Zoning database by the 
new WWN, including within any Alias or Zone where the old WWN was a 
member. 

Searching For a Zone Member
Perform the following steps to search for a zone member.

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select Edit > Search Member.

3. Type the zone member name in the Member Name field.

4. Narrow the search by selecting one or more of the check boxes, such as Match 
Case (optional).

5. Click the Next button to begin the zone member search. 
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About the View Menu
The options available in the View Menu of the Zone Administration window are 
described in Table 55. 

Table 55:  View Menu Options 

Option Description
Mixed Zoning Use the Mixed Zoning option when you want various objects 

to be selected as member of an alias, zone, or configuration 
file. 

Port Zoning Select the Port Zoning option when you want to include only 
ports in a group. Grouping zones by port alone is considered 
“hard zoning.”

WWN Zoning Select the WWN Zoning option when you want to zone by 
grouping World Wide Names. Grouping zones by WWN 
alone is considered “hard zoning.”

AL_PA Zoning Select the AL_PA Zoning option when you want to create or 
manage a zone of devices. 

Refresh Zoning Select the Refresh Zoning option to refresh the zoning 
database. This will overwrite any unsaved zoning database 
changes you have made. 

Refresh Fabric Select the Refresh Fabric option to display the latest fabric 
changes. 
Each type of View provides the following tabs (depending on 
the chosen Zone level):
■ About the Alias Tab, page 217
■ About the Zone Tab, page 223
■ About the QuickLoop Tab, page 229
■ About the Fabric Assist Tab, page 234
■ About the Config Tab, page 240
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Using the View Menu
The View menu is used to select the type of zoning and to refresh the zoning 
database as shown in the following sections.

Select a Zoning Method
The zoning method you choose determines how members are displayed in the 
various member selection windows. It also determines whether you are using 
Hard zoning or Soft zoning.

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the View drop-down menu. 

3. Select one of the following: 

— Mixed Zoning

— Port Zoning

— WWN Zoning 

— AL_PA Zoning 

The zoning method you choose determines how members are displayed in the 
various member selection windows. See “Zoning Methods” on page 202 for 
more information.

Refresh Zoning
To refresh the zoning database, perform the following steps.

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select View > Refresh Zoning. This refreshes the Zoning Database. Any 
unsaved zoning changes are deleted. The current Zoning database can be 
viewed from the Zone Configuration Summary window. See “Using the File 
Menu” on page 206 for more information.
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Refresh the Fabric
To refresh the fabric, perform the following procedure.

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select View > Refresh Fabric. This refreshes the Enabled Zone 
Configuration on the fabric. Any unsaved zoning changes are deleted. The 
current Zoning database can be viewed from the Zone Configuration 
Summary window. See “Using the File Menu” on page 206 for more 
information.
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About the Actions Menu
The options available in the Action Menu of the Zone Administration window are 
described in Table 56.

Enable a Config Option
The Actions > Enable a Config option is used to enable a configuration that has 
previously been created (see “Creating a Configuration” on page 243). A dialog 
box appears; select the desired configuration from the drop-down menu. 

Several configurations can reside on a switch at once and you can quickly 
alternate between configurations. For instance, you may want to have one 
configuration enabled during the business hours, and another enabled overnight. 
Only one zone configuration can be enabled at a time. 

Disable Zoning Option
The Actions > Disable Zoning option is used to disable the enabled 
configuration. The Disable Config dialog box appears. When the Zoning feature is 
disabled, the fabric is in non-zoning mode and all devices can freely access other 
devices in the fabric. 

Table 56:  Actions Menu Options 

Menu Item Description
Enable Config Select to save and enable the configuration selected from the 

Config tab Name field. This command also saves all other 
configurations in the zoning database.

Disable Zoning Select to disable the Configuration that is currently enabled. 
A dialog box provides a warning before disabling. 

Save Config Only Select to save all defined zoning configurations. The saved 
changes will only apply to the defined configurations. 
Changes can be made to a Configuration that is currently 
enabled; changes will not appear until the Configuration is 
disabled and re-enabled. 

Clear All Select to delete all Aliases, Zones, Fabric Assist Zones, and 
Configurations; the cleared configuration is saved. Any 
enabled configuration will be disabled. 
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Using the Actions Menu
The Actions menu is used to perform the functions described in the following 
sections.

Enabling a Configuration
To create a new Configuration, see “Creating a Configuration” on page 243.

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Click the View drop-down Menu.

3. Select the desired level of zoning.

4. Select the Config tab.

5. Select Actions > Enable Config to activate a configuration. 

The Enable Config dialog box appears. An example of the Enable Config 
dialog box is shown in Figure 50. 

Figure 50:  Enable Config Dialog Box

6. Select the configuration to be enabled from the drop-down menu. 

A warning dialog box appears. 

7. Click the Yes button if you want to enable the selected Configuration. 
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Disabling Zoning
When you disable the active configuration, the Zoning feature is disabled on the 
fabric and all devices within the fabric can communicate with all other devices. 
This does not mean that the Zoning database is deleted however, only that there is 
no Configuration active on the fabric.

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select Actions > Disable Zoning to disable the current enabled 
Configuration. 

The Disable Config warning appears. 

3. Click the Yes button if you want to disable the current Configuration. 

Saving Changes to an Existing Configuration
To save changes to an existing configuration, perform the following procedure.

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Config tab.

3. Make desired changes to Configuration (see “Creating a Zone” on page 226). 

You can make changes to a Configuration that is currently enabled; changes 
will not appear until the Configuration is disabled and re-enabled. 

4. Select the Actions > Save Config Only option. 

The Configuration changes will be saved. Changes will not take effect until 
the Configuration is re-enabled. 

To enable the configuration, see “Enabling a Configuration” on page 214.

Clearing the Zoning Database
The following procedure disables any active Configuration, and deletes the entire 
zoning database.

1. Access the Zone Administration window.
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See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Actions > Clear All option. 

Caution:  This action will not only disable zoning on the fabric, but will deleted 
the entire Zoning database.

The Disable Config warning appears. 

3. Click the Yes button if you want to disable the current Configuration.
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About the Alias Tab
Use the Alias tab to create, modify, rename, or delete aliases in the zoning 
database.

Alias Tab Example 
An example of the Alias tab is shown in Figure 51.

Figure 51:  Alias Tab in the Zone Administration Window
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Alias Tab Descriptions
The fields that appear in the following Alias tab are described in Figure 57.

Table 57:  Alias Tab Field Descriptions 

Field Description
Zoning Method This displays the method you have selected to add members 

to the Zoning database. Choose the Zoning method in the 
View menu. Valid options are:
■ Mixed Zoning
■ Port Zoning
■ WWN Zoning
■ AL_PA Zoning
The Zoning method determines the information displayed in 
the Member Selection List.

Enabled Config This field displays the currently enabled Zone Configuration.
Name Displays existing alias names from the drop-down menu. 
Create Button Click to create a new alias. A dialog box displays. Enter the 

name of the new alias. All names must be unique and 
contain no spaces.

Delete Button Click to delete the alias selected in the Name field. Deleting 
an alias automatically removes it from all zones, and configs.

Rename Button Click to rename the alias selected in the Name field. A dialog 
displays in which you can rename the alias. Renaming an 
alias automatically renames it in all zones, and configs.

Member Selection 
List

Select available items from the Member Selection List. 
In Mixed Zones you can select Ports, WWNs and AL_PAs. 

Alias Members Displays the current members of an Alias. 
Add FA Host Button Click to add a Fabric Assist Host to the member list. 
Add Member 
Button

Click to add a member from the Member Selection List to the 
Alias Members. You must select a member within the 
Member Selection List for this button to become active.

Remove Member 
Button

Click to remove a member from the Alias Members list. You 
must select a member within Alias Members for this button to 
become active.
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Add Other Button
■ Other
■ Other Port
■ Other WWN
■ Other AL_PA

Click to add a Port, WWN or AL_PA that is not currently part 
of the fabric. A dialog box will display for you to type in the 
host that is not a member of the fabric. 

Add Other Host 
Button
■ Other Host
■ Other Port Host
■ Other WWN 

Host

Click to add a host that is not currently part of the fabric. The 
button displayed depends on the zoning method that you 
have selected. 

Message area Displays zoning commit messages on the switch. 
QuickHelp Status 
Bar

Appears at the bottom of the window. Displays information 
for the current window. 

Table 57:  Alias Tab Field Descriptions  (Continued)

Field Description



Zone Administration

220 Web Tools Version 3.1.x/4.1.x User Guide

Using the Alias Tab
The following sections describe the functions and information available on the 
Alias tab.

Creating an Alias
To create an alias, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the View menu to determine the method used to view members. The 
different methods are:

— Mixed Zoning

— Port Zoning

— WWN Zoning 

— AL_PA Zoning 

The member view method you choose determines how members are displayed 
in the Member Selection List window. See “About the View Menu” on 
page 210 for more information.

3. Select the Alias tab (selected by default). 

4. Click the Create Alias button.

The Create New Alias dialog box appears. 

5. Enter a name for the new Alias. 

6. Click the OK button.

7. Click on any “+” signs in the Member Selection List to view the nested 
elements. 

The choices available in the Member Selection List depend on the selection 
made in the View Menu. 

8. Highlight an element in the Member Selection List that you want to include in 
your Alias. 

The Add Member button becomes active. 

9. Click the Add Member button or use Drag and Drop to add alias members. 
Selected members are moved to the Alias Members window. 
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10. Repeat steps 10 and 11 to add more elements to your Alias. 

11. Use the Add Other button to include a WWN, port, or QuickLoop (AL_PA) 
that is not currently a part of the fabric (optional).

The new Alias appears in the Name drop-down list. 

Modifying the Members of an Alias
To modify the members of an alias, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Alias tab (selected by default). 

3. From the Name drop-down menu, select the Alias you want to modify.

4. Highlight an element in the Member Selection List that you want to include in 
your Alias; or,
highlight an element in the Alias Members that you want to delete.

5. Click the Add Member button to add an alias member; or,
Click the Remove Member button to remove an alias member.

Deleting an Alias
To delete an alias, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Alias tab (selected by default). 

3. From the Name drop-down menu, select the Alias you want to delete.

4. Click the Delete button. The Confirm Deleting Alias dialog opens.

5. Click the OK button. The selected Alias is deleted from the zoning database.

Renaming an Alias
To rename an alias, perform the following steps:

1. Access the Zone Administration window.
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See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Alias tab (selected by default). 

3. From the Name drop-down menu, select the Alias you want to rename. 

4. Click the Rename button. The Rename an Alias dialog box appears. 

5. Enter a new alias name. 

6. Click the OK button. The Alias is renamed in the zoning database.
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About the Zone Tab
Use the Zone tab to create, modify, rename, or delete zones in the zoning 
database.

Zone Tab Example
An example of a Zone tab is displayed in Figure 52.

Figure 52:  Zone Tab in the Zone Administration Window

Zone Tab Descriptions
The Zone buttons and fields are described in Table 58.
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Table 58:  Zone Tab Field Descriptions

Field Descriptions
Zoning Method This displays the method you have selected to add members 

to the Zoning database. Choose the Zoning method in the 
View menu. Valid options are:
■ Mixed Zoning
■ Port Zoning
■ WWN Zoning
■ AL_PA Zoning
The Zoning method determines the information displayed in 
the Member Selection List.

Enabled Config This field displays the currently enabled Zone Configuration.
Name Displays existing zones from the drop-down menu. 
Create Button Click to create a new zone. A dialog box displays. Enter the 

name of the new zone. All zone names must be unique and 
must consist of letters, numbers or the underscore character. 
Spaces or special characters are not allowed in zone names, 
and a name cannot start with a number.

Delete Button Click to delete the zone selected in the Zone Name field. 
Deleting a zone automatically removes it from all configs.

Rename Button Click to rename the Zone selected in the Zone Name field. A 
dialog box displays in which you can edit the zone name. 
Renaming a zone in the zone tab automatically renames it in 
all configurations.

Member Selection 
List

Select available items from the Member Selection List. 

Zone Members Displays the current members of a zone. 
Add Member Button Click to add a member from the Member Selection List to the 

Zone Members. You must select a member within the 
Member Selection List for this button to become active.

Remove Member 
Button

Click to remove a member from the Zone Members list. You 
must select a member within the Zone Members list for this 
button to become active.
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Add Other
■ Other Port
■ Other WWN
■ Other AL_PA

Click to add a Port, WWN or AL_PA that is not currently part 
of the fabric. A dialog box will display for you to type in the 
host that is not a member of the fabric. 

Message area Displays zoning commit messages on the switch. 
QuickHelp Status 
Bar

Appears at the bottom of the window. Displays information 
for the current window. 

Table 58:  Zone Tab Field Descriptions

Field Descriptions
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Using the Zone Tab
The use of the Zone tab to create, modify, rename, or delete zones in the zoning 
database is shown in the following sections.

Creating a Zone
To create a zone, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the View menu to determine the method used to view members. The 
different methods are:

— Mixed Zoning

— Port Zoning

— WWN Zoning 

— AL_PA Zoning 

The member view method you choose determines how members are displayed 
in the Member Selection List window. See “About the View Menu” on 
page 210 for more information.

3. Select the Zone tab. 

4. Click the Create button.

The Create New Zone dialog box appears. 

5. Enter a name for the new zone. 

6. Click the OK button.

7. Click on any “+” signs in the Member Selection List to view the nested 
elements. 

The choices available in the Member Selection List depend on the selection 
made in the View Menu. 

8. Highlight an element in the Member Selection List that you want to include in 
your Zone. 

The Add Member button becomes active. 

9. Click the Add Member button or use drag and drop to add zone members. 
Selected members are moved to the Zone Members window. 
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10. Repeat steps 10 and 11 to add more elements to your Zone. 

11. Use the Add Other button to include a WWN, port, or QuickLoop (AL_PA) 
that is not currently a part of the fabric (optional).

The new Zone appears in the Name drop-down list. 

Modifying the Members of a Zone
To modify the members of a zone, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Zone tab. 

3. From the Name drop-down menu, select the Zone you want to modify.

4. Highlight an element in the Member Selection List that you want to include in 
your zone; or,
highlight an element in the Zone Members that you want to delete.

5. Click the Add Member button to add a zone member; or,
Click the Remove Member button to remove a zone member.

Deleting an Zone
To delete a zone, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Zone tab. 

3. From the Name drop-down menu, select the zone you want to delete.

4. Click the Delete button. The Confirm Deleting Zone dialog opens.

5. Click the OK button. The selected zone is deleted from the zoning database.

Renaming a Zone
To rename a zone, perform the following steps:

1. Access the Zone Administration window.
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See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Zone tab. 

3. From the Name drop-down menu, select the zone you want to rename. 

4. Click the Rename button. The Rename a Zone dialog box appears. 

5. Enter a new zone name. 

6. Click the OK button. The zone is renamed in the zoning database.
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About the QuickLoop Tab
Use the QuickLoop tab to manage QuickLoops in the zoning database. For more 
information regarding QuickLoops, see the HP StorageWorks QuickLoop Fabric 
Assist Version 3.1.x User Guide. 

QuickLoop Tab Example
An example of the QuickLoop tab is shown in Figure 53.

Figure 53:  QuickLoop Tab in the Zone Administration Window

QuickLoop Tab Descriptions
The QuickLoop tab is described in Table 59.
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Table 59:  QuickLoop Tab Field Descriptions

Field Description
Zoning Method This displays the method you have selected to add members 

to the Zoning database. Choose the zoning method in the 
View menu. Valid options are:
■ Mixed Zoning
■ Port Zoning
■ WWN Zoning
■ AL_PA Zoning
The Zoning method determines the information displayed in 
the Member Selection List.

Enabled Config This field displays the currently enabled zone configuration.
Name Displays existing QuickLoops from this drop-down menu. 
Create Button Click to create a new QuickLoop. A dialog box displays; 

Enter the name of the new QuickLoop. All names must be 
unique and contain no spaces.

Delete Button Click to delete the QuickLoop selected in the Name 
drop-down menu. Deleting a QuickLoop automatically 
removes it from all configurations.

Rename Button Click to rename the QuickLoop selected in the Name field. A 
dialog displays in which you can edit the QuickLoop name. 
Renaming a QuickLoop automatically renames it in all 
configurations.

Member Selection 
List

Select available members from the Member Selection List. 
QuickLoop is not supported on either the Core Switch 2/64 
or SAN Switch 2/32 switches. However you can manage a 
QuickLoop from these switches if it is attached to another 
switch in the fabric.

QuickLoop 
Members

Displays the current members of a QuickLoop. 

Add Member 
Button

Click to add a member from the Member Selection List to the 
QuickLoop Members. You must select a member within the 
Member Selection List for this button to become active.

Remove Member 
Button

Click to remove a member from the QuickLoop Members list. 
You must select a member within the QuickLoop Members list 
for this button to become active.

Message area Displays zoning commit messages on the switch. 
QuickHelp Status 
Bar

Appears at the bottom of the window. Displays information 
for the current window. 
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Using the QuickLoop Tab
Use the QuickLoop tab to perform the QuickLoop operations described in the 
following sections.

Creating a QuickLoop
To create an alias, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the View menu to determine the method used to view members. The 
different methods are:

— Mixed Zoning

— Port Zoning

— WWN Zoning

— AL_PA Zoning

The member view method you choose determines how members are displayed 
in the Member Selection List window. See “About the View Menu” on 
page 210 for more information.

3. Select the QuickLoop tab. 

4. Click the Create button.

The Create New QuickLoop dialog box appears. 

5. Enter a name for the new QuickLoop. 

6. Click the OK button.

7. Click on any “+” signs in the Member Selection List to view the nested 
elements. 

The choices available in the Member Selection List depend on the selection 
made in the View menu. 

8. Highlight an element in the Member Selection List that you want to include in 
your QuickLoop. 

The Add Member button becomes active. 
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Note:  There is a limit of two members per QuickLoop.

9. Click the Add Member button or use drag and drop to add QuickLoop 
members. Selected members are moved to the QuickLoop Members 
Window. 

10. Repeat steps 10 and 11 to add more elements to your QuickLoop. 

11. Use the Add Other button to include a WWN, port, or QuickLoop (AL_PA) 
that is not currently a part of the fabric (optional).

The new QuickLoop appears in the Name drop-down list. 

Modifying the Members of a QuickLoop
To modify the members of a QuickLoop, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the QuickLoop tab. 

3. From the Name drop-down menu, select the QuickLoop you want to modify.

4. Highlight an element in the Member Selection List that you want to include in 
your QuickLoop; or,
highlight an element in the QuickLoop Members list that you want to delete.

5. Click the Add Member button to add a QuickLoop member; or,
Click the Remove Member button to remove an QuickLoop member.

Deleting an QuickLoop
To delete a QuickLoop, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on “Searching For a Zone 
Member” for more information.

2. Select the QuickLoop tab. 

3. From the Name drop-down menu, select the QuickLoop you want to delete.

4. Click the Delete button. The Confirm Deleting QuickLoop dialog opens.
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5. Click the OK button. The selected QuickLoop is deleted from the zoning 
database.

Renaming a QuickLoop
To rename a QuickLoop, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the QuickLoop tab. 

3. From the Name drop-down menu, select the QuickLoop you want to rename. 

4. Click the Rename button. The Rename a QuickLoop dialog box appears. 

5. Enter a new QuickLoop name. 

6. Click the OK button. The QuickLoop is renamed in the zoning database.
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About the Fabric Assist Tab
Use the Fabric Assist tab to create and manage Fabric Assist zones. Fabric Assist 
is a means of allowing private hosts to communicate with public targets across a 
switched fabric. Fabric Assist also allows private hosts to communicate with 
public targets that are not resident in the same switched fabric. 

Requirement: Creating a Fabric Zone requires a fabric host. 

The Fabric Assist tab is not available if you selected View > AL_PA Zoning.

Fabric Assist Example
An example of a Fabric Assist tab is shown in Figure 54. 

Figure 54:  Fabric Assist Tab in the Zone Administration Window
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Fabric Assist Descriptions
The Fabric Assist fields are described in Table 60.

Table 60:  Fabric Assist Fields Descriptions 

Fields Descriptions
Zoning Method This displays the method you have selected to add members 

to the Zoning database. Choose the zoning method in the 
View menu. Valid options are:
■ Mixed Zoning
■ Port Zoning
■ WWN Zoning
■ AL_PA Zoning
The Zoning method determines the information displayed in 
the Member Selection List.

Enabled Config This field displays the currently enabled Configuration.
Name Displays existing Fabric Assist zones from the drop-down 

menu. 
Create Button Click to create a new Fabric Assist zone. A dialog box 

displays; Enter the name of the new Fabric Assist zone. All 
names must be unique and contain no spaces.

Delete Button Click to delete the Fabric Assist zone selected in the Name 
drop-down menu. Deleting a Fabric Assist zone 
automatically removes it from configs.

Rename Button Click to rename the Fabric Assist zone selected in the Name 
drop-down menu. A dialog displays in which you can edit 
the Fabric Assist name. Renaming a Fabric Assist zone 
automatically renames it in all configs.

Member Selection 
List

Select available items from the Member Selection List. 

Fabric Assist 
Members

Displays the current members of a Fabric Assist zone. 

Add FA Host Button Click to Add a Fabric Assist Host that is not currently part of 
the fabric.

Add Member Button Click to add a member from the Member Selection List to the 
Fabric Assist Members. You must select a member within the 
Member Selection List for this button to become active.

Remove Member 
Button

Click to remove a member from the Fabric Assist Members 
list. You must select a member within the Fabric Assist 
Members list for this button to become active.
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Add Other Button
■ Other
■ Other Port
■ Other WWN
■ Other AL_PA

Click to add a Fabric Assist zone that is not currently part of 
the fabric. A dialog box will display for you to type in the 
host that is not a member of the fabric. 

Add Other Host 
Button
■ Other Host
■ Other Port Host
■ Other WWN 

Host

Click to add a host that is not currently part of the fabric. The 
button displayed depends on the zoning method that you 
have selected. 

Message area Displays zoning commit messages on the switch. 
QuickHelp Status 
Bar

Appears at the bottom of the window. Displays information 
for the current window. 

Table 60:  Fabric Assist Fields Descriptions  (Continued)

Fields Descriptions
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Using the Fabric Assist Tab
The functions provided on the Fabric Assist tab are shown in the following 
sections.

Creating a Fabric Assist Zone
For this example, the Mixed Zone level is used. 

1. Access the Zone Administration window; see “Accessing the Zone 
Administration Window” on page 204.

The Zone Administration window appears.

2. Enter the admin level user name and password. 

3. Select View > Mixed Zoning. You can select any view except the Device 
View. 

The Mixed View tab appears. 

4. Select the Fabric Assist tab.

5. Select the Create button. 

The Create New FA dialog box appears.

6. Enter a name for the new FA zone and Click the OK button. 

A fabric host is required.

7. Highlight the desired Fabric Assist zone members from the Member Selection 
list.

8. Click the Add Member button.

The new members appear in the Fabric Assist Members window. 

The newly created FA zone also appears in the Config tab. 

Modifying the Members of a Fabric Assist Zone
To modify the members of a Fabric Assist Zone, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Fabric Assist tab. 
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3. From the Name drop-down menu, select the Fabric Assist zone you want to 
modify.

4. Highlight an element in the Member Selection list that you want to include in 
your Fabric Assist zone or highlight an element in the Fabric Assist Zone 
Members list that you want to delete.

5. Click the Add Member button to add a Fabric Assist zone member; or,
Click the Remove Member button to remove an Fabric Assist zone member.

Deleting an Fabric Assist Zone
To delete a Fabric Assist Zone, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Fabric Assist Zone tab. 

3. From the Name drop-down menu, select the Fabric Assist Zone you want to 
delete.

4. Click the Delete button. The Confirm Deleting Fabric Assist Zone dialog 
opens.

5. Click the OK button. The selected Fabric Assist Zone is deleted from the 
zoning database.

Renaming a Fabric Assist Zone
To rename a Fabric Assist zone, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Fabric Assist tab. 

3. From the Name drop-down menu, select the Fabric Assist Zone you want to 
rename. 
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4. Click the Rename button. The Rename a Fabric Assist Zone dialog box 
appears. 

5. Enter a new Fabric Assist zone name. 

6. Click the OK button. The Fabric Assist zone is renamed in the zoning 
database.
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About the Config Tab
Use the Config tab to create and manage configurations. 

Config Tab Example
An example of the Config tab is shown in Figure 55.

Figure 55:  Config tab in the Zone Administration window

Config Tab Descriptions
The Config tab fields are described in Table 61.
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Table 61:  Config Tab Field Descriptions 

Field Description
Zoning Method This displays the method you have selected to add members 

to the Zoning database. Choose the zoning method in the 
View menu. Valid options are:
■ Mixed Zoning
■ Port Zoning
■ WWN Zoning
■ AL_PA Zoning
The Zoning method determines the information displayed in 
the Member Selection List.

Enabled Config This field displays the currently enabled configuration.
Name Select an existing configuration from the drop-down menu to 

display or modify.
Create Button Click to create a new configuration. A dialog displays; enter 

the name of the new configuration. All names must be unique 
and contain no spaces.

Delete Button Click to delete the configuration selected in the Name 
drop-down menu. Deleting a configuration does not delete 
any of the elements contained in that configuration.

Rename Button Click to rename the configuration selected in the Name 
drop-down menu. A dialog displays in which you can edit 
the Config name. 

Member Selection 
List

Select available items from the Member Selection list. 

Config Members Displays the current config members. 
Add Member 
Button

Click to add a member from the Member Selection list to the 
Config Members list. You must select a member within the 
Member Selection List for this button to become active.

Remove Member 
Button

Click to remove a member from the Config Members list. You 
must select a member within the Config Members list for this 
button to become active.
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Analyze Config 
Button

Analyzes the configuration that is selected along with its 
member zones. A report is created that lists:
■ SAN components (Ports, WWNs, and AL_PAs) that are 

not included in the configuration. 
■ SAN components (Ports, WWNs, and AL_PAs) that are 

contained in the configuration but not in the fabric. 
Message area Displays zoning commit messages on the switch. 
QuickHelp Status 
Bar

Appears at the bottom of the window. Displays information 
for the current window. 

Table 61:  Config Tab Field Descriptions  (Continued)

Field Description
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Using the Config Tab
The operations available on the Config tab are shown in the following sections.

Creating a Configuration
To create a Configuration, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the View menu to determine the method used to view members. The 
different methods are:

— Mixed Zoning

— Port Zoning

— WWN Zoning

— AL_PA Zoning

The member view method you choose determines how members are displayed 
in the Member Selection List window. See “About the View Menu” on 
page 210 for more information.

3. Select the Config tab. 

4. Click the Create button.

The Create New Config dialog box appears. 

5. Enter a name for the new Config. 

6. Click the OK button.

7. Click on any “+” signs in the Member Selection List to view the nested 
elements. 

The choices available in the Member Selection List depend on the selection 
made in the View Menu. 

8. Highlight an element in the Member Selection List that you want to include in 
your Config. 

The Add Member button becomes active. 

9. Click the Add Member button or use drag and drop to add Config members. 
Selected members are moved to the Config Members window. 

10. Repeat steps 10 and 11 to add more elements to your Config. 
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11. Select the Actions > Save Config Only option. The new Config appears in 
the Name drop-down list. To enable the configuration, see “Enabling a 
Configuration” on page 214.

Note:  Any changes made to the currently enabled configuration will not appear until 
the configuration is re-enabled. 

Modifying the Members of a Config
To modify the members of a Config, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Config tab. 

3. From the Name drop-down menu, select the Config you want to modify.

4. Highlight an element in the Member Selection List that you want to include in 
your Config or
highlight an element in the Config Members list that you want to delete.

5. Click the Add Member button to add a Config member or
Click the Remove Member button to remove a Config member.

Note:  You can make changes to a Configuration that is currently enabled; changes will 
not appear until the Configuration is disabled and re-enabled. 

6. Select the Actions > Save Config Only option. 

Note:  The Configuration changes will be saved. Changes will not take effect until the 
Configuration is re-enabled. 

To enable the configuration, see “Enabling a Configuration” on page 214.
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Deleting a Config
You cannot delete a currently enabled configuration. 

To delete a config, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Config tab. 

3. From the Name drop-down menu, select the Config you want to delete.

4. Click the Delete button. The Confirm Deleting Config dialog opens.

5. Click the OK button. The selected Config is deleted from the Config 
database.

Renaming a Config
To rename a Config, perform the following steps:

1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Config tab. 

3. From the Name drop-down menu, select the Config you want to rename. 

4. Click the Rename button. The Rename a Config dialog box appears. 

5. Enter a new Config name. 

6. Click the OK button. The Config is renamed in the Config database.

Note:  You can make changes to a Configuration that is currently enabled; changes will 
not appear until the Configuration is disabled and re-enabled. 

7. Select the Actions > Save Config Only option. 

Note:  The Configuration changes will be saved. Changes will not take effect until the 
Configuration is re-enabled. 
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To enable the configuration, see “Enabling a Configuration” on page 214.

Creating a Configuration Analysis Report
1. Access the Zone Administration window.

See “Accessing the Zone Administration Window” on page 204 for more 
information.

2. Select the Config tab. 

3. Select a Configuration to be analyzed from the Name drop-down menu. 

4. Select the Analyze Config button.

An analysis window appears. An example of an Analyze Config report is 
shown in Figure 56.

Figure 56:  Analyze Config Report Example

5. View the Configuration Analysis. A report is created that lists:
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— SAN components (Ports, WWNs, and AL_PAs) that are not included in 
the configuration. 

— SAN components (Ports, WWNs, and AL_PAs) that are contained in the 
configuration but not in the fabric. 
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10Port Management

This chapter provides the following information:

■ About Port Management, page 250

■ Using Port Management, page 251
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About Port Management
Port Management is performed through several different areas of Web Tools:

■ The Port graphic located on the Switch View. 

■ The Admin tabs. See the individual tabs in “About the Switch Admin 
Window” on page 92.

■ The Port Information window. See “Using the Port Graphic” on page 254.

■ The Zone Administration window. See “About Zone Administration” on 
page 200.
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Using Port Management
The operations available on the Port Management tab are described in the 
following sections.

Enabling or Disabling a Port
When you disable a port, if that port is an ISL, the fabric reconfigures. If the port 
was connected to a device, that device is no longer accessible from the fabric.

To enable or disable a port, perform the following steps.

1. Access the Admin Interface. See “Accessing the Switch Admin Window” on 
page 94 for more information.

2. Select the Admin icon from the switch graphic. See “Switch Graphic Buttons” 
on page 54.

The login dialog box appears. 

3. Enter the admin level user name and password. 

4. Select the Port Setting tab.

5. Check or uncheck the Enabled box that corresponds to the Port you wish to 
enable/disable. 

6. Click the Apply button. 

7. Check the log at the bottom of the screen for information regarding the switch 
configuration changes. 

Enabling Trunking on a Port
To enable trunking on a port, perform the following steps.

1. Access the Admin Interface. See “Accessing the Switch Admin Window” on 
page 94 for more information.

2. Select the Admin icon from the switch graphic. See “Switch Graphic Buttons” 
on page 54.

The login dialog box appears. 

3. Enter the admin level user name and password. 

4. Select the Port Setting tab.

5. Check the Trunk box that corresponds to the port you wish to trunk. 

6. Click the Apply button. 
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Configuring Port Speed
1. Access the Admin Interface. See “Accessing the Switch Admin Window” on 

page 94 for more information.

2. Select the Admin icon from the switch graphic. See “Switch Graphic Buttons” 
on page 54.

The login dialog box appears. 

3. Enter the admin level user name and password. 

4. Select the Port Setting tab.

5. Select the desired speed for the corresponding port (see “About the Port 
Setting Tab” on page 115).

6. Click the Apply button. 

Assigning a Name to a Port
1. Access the Admin Interface. See “Accessing the Switch Admin Window” on 

page 94 for more information.

2. Select the Admin icon from the switch graphic. See “Switch Graphic Buttons” 
on page 54.

The login dialog box appears. 

3. Enter the admin level user name and password. 

4. Select the Port Setting tab.

5. Click in the Name column; select the field that corresponds to the Port you 
want to name. 

6. Type a name for the port. 

7. Click the Apply button. 
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About the Port Graphic
Click on the Port graphic in the Switch view to access the Port Information View. 
For information regarding the Port Information view, see “About the Port 
Information View” on page 255. 

The Port graphics are numbered and have blinking LEDs. For LED status 
information, refer to the switch installation guide supplied with your specific 
switch (the installation guide is also available on the v3.1.x or v4.1.x Software 
CD).

Port Graphic Example
The port graphic on the Switch Explorer page is interactive. You can manage a 
port by clicking on the port graphic in the Switch Explorer screen. An example of 
the Port graphic is shown in Figure 57.

Figure 57:  Example port graphics (located within the Switch Graphic)



Port Management

254 Web Tools Version 3.1.x/4.1.x User Guide

Using the Port Graphic
To access the Port Information View, perform the following steps:

1. Launch Web Tools.

The Switch Explorer appears.

2. Click on the switch graphic from which you want to access port information. 

The port graphics appear at the top of the Switch graphic (see Figure 57). 

3. Click on the port icon to which you want to view information. 

The Port Information View window appears. 

4. Select the desired information tab (see “About the Port Information View” on 
page 255).

5. View other tabs by clicking the numbered tabs. 
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About the Port Information View
The following information appears at the top of the Port Information window, 
regardless of which tab is selected:

The Port Information View provides the following tabs for each port:

■ Port Stats Tab—Provides information about transmission speed, reception 
speed, and the volume of traffic through the selected port.

■ SFP Tab—Provides information about the SFP (Small form factor pluggable) 
installed in the selected port. The information displayed depends on the type 
of SFP installed. 

■ Loop Tab—Provides information about any loop on the selected port. 

PortStats Tab Example
An example of the PortStats tab is shown in Figure 58.

Table 62:  Port Information Window 

Field Description
Port Name Displays the port name. 
Port WWN Displays the WWN assigned to the port. 
Port Module Displays the type of SFP.
Port Status Displays the status of the port.
Port Type Displays the type of port, such as U_Port or E_Port. 
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Figure 58:  PortStats tab of the Port Information window

PortStats Tab Descriptions
The fields in the Port Information view > PortStats tab are described in 
Table 63. 

Table 63:  Port Information Window PortStats Tab Field Descriptions 

Field Description
4-Byte Word 
Transmitted

Displays the number of four-byte words transmitted.

4-Byte Word 
Received

Displays the number of four-byte words received.

Frames Transmitted Displays the number of frames transmitted.
Frames Received Displays the number of frames received.
C2 Frames Received Displays the number of class 2 frames received.
C3 Frames Received Displays the number of class 3 frames received.
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Link Control Frames 
Received

Displays the number of link control frames received.

Mcast Frames 
Received

Displays the number of multicast frames received.

Mcast Time-outs Displays the number of multicast time-outs.
Mcast Frames 
Transmitted

Displays the number of multicast frames transmitted.

Time R_RDY Priority Displays the number of times R_RDY has priority over frames 
to be sent.

Time BB_Credit 
Zero

Displays the number of times BB_Credit went to zero.

Encd Errs Inside 
Frames

Displays the number of encoding errors inside frames.

Frames with CRC 
Errs

Displays the number of frames with CRC errors.

Short Frames Displays the number of frames shorter than minimum.
Long Frames Displays the number of frames longer than maximum.
Bad End-of-Frames Displays the number of frames with faulty end-of-frames.
Encd Errs Outside 
Frames

Displays the number of frames with encoding errors outside 
frames.

C3 Frames 
Discarded

Displays the number of class 3 frames discarded.

LIP Ins Displays the number of LIPs received.
LIP Outs Displays the number of times loop initialized by FL_Port.
Last LIP Received Displays the last LIP received: AL_PD, AL_PS.
Frames Rejected Displays the number of F_RJTs sent.
Frames Busied Displays the number of F_BSYs sent.
Link Failure Displays the number of times NOS received/sent.
Loss of Sync Displays the number of times loss of sync occurred.
Loss of Signal Displays the number of times loss of signal occurred.
Port Speed Displays the port speed. 
Port Trunked Displays Port Trunking information. 

Table 63:  Port Information Window PortStats Tab Field Descriptions  (Continued)

Field Description



Port Management

258 Web Tools Version 3.1.x/4.1.x User Guide

SFP Tab Example
An example of the Port Information View > SFP tab is shown in Figure 59. 

Figure 59:  SFP Tab of the Port Information Window

SFP Tab Descriptions
The fields in the Port Information view > SFP tab are described in Table 64. 

Table 64:  Port Information Window SFP Tab Field Descriptions 

Field Description
Identifier Indicates the type of serial transceiver. 
Connector Indicates the external connector type, which can be one of 

the following:
■ LC (for 3800 and above).
■ GBIC (for 3600 and earlier).

ID Name Indicates the SFP model type. 
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Speed Indicates the speed of the SFP in 100, 200, or 400 MB/sec.
Media Indicates transmission mode, which can be one of the 

following:
■ SM - single mode 
■ M5 - multi-mode, 50u
■ M6 - multi-mode, 62.5u
■ TV - video coax
■ MI - miniature coax
■ TP - twisted pair coax
■ TW - twin axial pair

Distance Indicates the length of the Fibre Channel link, which can be 
one of the following
■ long distance
■ intermediate distance
■ short distance

Encoding Indicates the serial coding mechanism, which can be one of 
the following:
■ 8B10B
■ 4B5B
■ NRZ

Baud Rate Indicates the nominal baud rate in units of 100 Megabaud.
BR Max Indicates the upper limit at which the SFP meets its 

specifications (in units of one percent above nominal baud 
rate).

BR Min Indicates the lower limit at which the SFP meets its 
specifications (in units of one percent above nominal baud 
rate).

Options May indicate any of the following:
■ Loss of signal
■ Loss of signal inverted
■ Transmission fault
■ Transmission disable

Length 9u Indicates the length of link using single form fiber.
Length 50u Indicates the length of link using 50um multi-mode fiber.

Table 64:  Port Information Window SFP Tab Field Descriptions  (Continued)

Field Description
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Loop Tab Example
An example of the Port Information View > Loop tab is shown in Figure 60. 

Length 62.4u Indicates the length of link using 62.5um multi-mode fiber.
Length cu Indicates the minimum length of link using copper cable. 
Vendor Name Indicates the number of the SFP vendor.
Vendor OUI Indicates the unique identifier for the SFP vendor. 
Vendor PN Indicates the SFP vendor part number. 
Vendor Rev Indicates the SFP vendor revision number. 
Serial No: Indicates the SFP vendor serial number. 
Date Code Indicates the SFP vendor date code.
Temperature Indicates the module temperature (in Centigrade).
RX Power Indicates the received optical power in micro Watts.
TX Power Indicates the transmitted optical power in micro Watts 

(longwave only).
Current Indicates the current laser diode in mAmps.
Voltage Indicates the current voltage in mVolts. 

Table 64:  Port Information Window SFP Tab Field Descriptions  (Continued)

Field Description
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Figure 60:  Loop Tab of the Port Information Window

Loop Tab Descriptions
The fields in the Port Information view > Loop tab are described in Table 65.

Table 65:  Port Information Window Loop Tab Field Descriptions 

Field Description
FL Port Transfer Displays the number of times FL_Port used transfer state.
FL Tenancies Displays the number of times FL_Port opens loop tenancy.
NL Tenancies Displays the number of times NL_Port opens loop tenancy.
QL/Zone Inits 
Caused

Displays the number of times looplet has caused QuickLoop 
to be initialized.

Successful 
QL/Zones Inits

Displays the number of times looplet has successfully 
initialized.

Failed QL/Zone 
Inits

Displays the number of times looplet failed to successfully 
initialize.
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Times Being 
Bypassed

Displays the number of times looplet was not included as part 
of QuickLoop.

Last Time bypassed Displays the time that looplet was last bypassed.
Local AL_PA List Displays the list of AL_PAs associated with devices connected 

to loop.
QL Init Attempts Displays the number of times QuickLoop attempted 

initialization.
Successful QL Inits Displays the number of time QuickLoop successfully 

initialized.
Times in Single 
Switch Mode

Displays the number of times switch reverted to single switch 
mode.

Times in Dual 
Switch Mode

Displays the number of times switch operated in dual switch 
mode.

Time of Last QL Init Displays the time of latest QuickLoop initialization.
Switch, Port Caused 
the Last Init

Displays the number of switch, port that caused the latest 
initialization.

Table 65:  Port Information Window Loop Tab Field Descriptions  (Continued)

Field Description
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11Troubleshooting Web Tools

This chapter provides the following information: 

■ Web Tools Limitations, page 264

■ Web Tools and Firmware Download, page 269
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Web Tools Limitations
This section provides information on limitations of Web Tools.

Core Switch 2/64 in Web Tools
Listed below are the known limitations in Web Tools, relating to the Core Switch 
2/64:

■ For the Core Switch 2/64 neither CP is updated in the “Switch View” when 
switch 0 is being rebooted. The CP data displayed on this “Switch View” is 
dependent on Switch 0, and that data is not available when Switch 0 is 
rebooting. 
Workaround: Refresh or relaunch Switch View after either switch is 
rebooted.

■ Rarely during a failover event, independent Web Tools clients operating on 
different machines may see slight differences in the management of those 
Core Switch 2/64 switches participating in the failover event. 
Workaround: There is no workaround. 

■ Under some circumstances where the 1 Gb SAN or 2 Gb SAN switches may 
be experiencing high memory usage, the Core Switch 2/64 Fabric View will 
display a fixed gray background area that says “Loading Java Applet....” This 
may also occur when a switch leaves the fabric simultaneous with a network 
problem. The period of loss of network connectivity for Web Tools is varied 
for different configurations. 
Workaround: Ensure that any 1 Gb SAN or 2 Gb SAN switches are 
upgraded with the recommended code versions to work optimally with the 
Core Switch 2/64 switches. 

■ Occasionally, other switches that are not Core Switch 2/64 switches may 
display the port ICONs correctly, but, be missing one or more control button 
icons. 
Workaround: Close the Switch View of the 1 Gb SAN or 2 Gb SAN switch 
and reopen it.

Zoning in Web Tools
Listed below are the known limitations in Web Tools, relating to zoning.
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■ While doing an add, delete, or replace WWN from Web Tools zoning, in 
confirm window, if you select different single entries twice or more, the 
"select all" button may stop functioning. This can be seen on both Java plug in 
1.2.2 and 1.3.1, but is fixed in 1.4.x. 
Workaround: Click "deselect all" and then click "select all" again.

Refresh Limitations in Web Tools
Listed below are the known limitations in Web Tools, relating to the browser:

■ Rarely, when viewing the Web Tools Fabric View screen the browser may stop 
responding.
Workaround: Restart the browser. 

■ When you have a large number of Web Tools pages open with a heavy 
workload, you may occasionally see remnants of other pages or incomplete 
graphics on the screen. 
Workaround: Refresh the Switch Explorer window.

■ Occasionally, users may request reports such as Fabric Events, Switch Report, 
Port Settings and others that may not display information or display partial 
information for a given switch believed to be in the fabric. 
Workaround: Refresh the page or close the specific web page and request it 
again.

■ When a pop-up window requesting a user response is pushed into the 
background and refresh is requested, a fatal Internet Explorer error may occur. 
Workaround: Restart the browser.

■ Web Tools must be restarted when the Ethernet IP address is changed using 
the NetworkConfig View command. Web Tools will appear to freeze or 
hang if it is not restarted after this operation is executed. 
Workaround: Restart the browser.

■ If the user changes the Switch Name and Domain ID using CLI after the Web 
Tools Switch Admin has started, the new Switch Name and Domain ID will 
not be updated on the header of Switch Admin. Clicking on Refresh button 
will not fix the problem. 
Workaround: Activate the Switch Information tab and the Switch Admin 
header will update. 

■ Following a switch enable or disable, it is necessary to wait at least 25-30 
seconds for the fabric to reconfigure and for FSPF route calculations to 
complete before requesting routing information. If accessed too early, routing 
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information will not be shown. 
Workaround: Following a switch enable or disable, wait at least 25-30 
seconds before further action.

Telnet Button and Web Tools
Listed below are the known limitations in Web Tools, relating to the Telnet button:

■ On a Solaris OS v8.0 system, a telnet session cannot be launched using the 
Telnet button in Web Tools if the path of the "xterm" application is not 
included in the PATH environment variable.
Workaround: This path will vary from machine to machine, so contact your 
system administrator to find out the correct path of the "xterm" application 
and include this variable in the default environment setup file.

■ When using the Web Tools Fabric View or Switch View to open a telnet 
session from within Netscape, the telnet session is not automatically closed 
when exiting. 
Workaround: The telnet window must be closed manually. 

Web Tools and Windows
Listed here are issues using Web Tools in a Windows environment.

■ There is a problem that files created by Internet Explorer 5.5 with plugin 
1.3.1_04 may grow too large and cause Web Tools to not operate properly. 
Workaround: On Windows 2000 or Windows NT, make sure to delete the 
browser temp files periodically. Note that the Temp folder may be in a 
different location. Contact your system administrator if you have problems 
locating temp internet files. In the temp internet file folder delete the TLBxxx 
files.

■ Intermittently, you will not see the "Lost connection to the switch" message 
on the Switch View even though the Ethernet connection has been lost. You 
may still be able to invoke various features from Switch View such as Status, 
Info, Fan Temp, Power and Beacon. This problem may be seen in the Core 
Switch 2/64, for example, when you see the Lost connection to the switch 
error for a single switch in the chassis, when a lost connection affects both 
logical switches. 
Workaround: Verify Ethernet connection to the switch by pinging the logical 
switch IP address.



Troubleshooting Web Tools

267Web Tools Version 3.1.x/4.1.x User Guide

■ In Web Tools under the Admin- Routing page, when viewing the details of the 
Routing Table in a pop up window, the open window locks out all other input 
on other views that are open for any switch. 
Workaround: If you are locked out of adding input to Web Tools windows, 
verify that you do not have a pop up window open. You must close this 
window using the windows "X" close icon. 

Web Tools and Netscape on Solaris
Listed below are the known limitations in Web Tools, relating to Netscape on 
Solaris.

■ When you use Netscape 4.77 and a network-attached printer, Web Tools may 
not be able to print properly if the network has been interrupted, causing the 
printer to become unavailable after the browser was started. 
Workaround: Once the network problem is identified, close the Netscape 
browser and attempt the print operation once again. The browser must be shut 
down and restarted.

■ There may occasionally be problems with Netscape 4.77 on Solaris 2.8 with 
plug-in 1.3.1_04 that Web Tools crashes after the browser is resized. 
Workaround: Restart Web Tools application.

■ Occasionally, on a Solaris OS v8.0 system, Netscape 4.77, Java Plug-in 
1.3.1_04, after the Web License has been added, the Fabric View may still 
show the Switch icon in the missing license state. 
Workaround: Refresh the Fabric View to see it properly displayed.

■ When running firmware download under Web Tools on a Solaris/Netscape 
browser, the firmware download completion pop-up window can be easily put 
into background. This can give the appearance of Web Tools sessions that are 
locked out. 
Workaround: If a user is apparently locked out of other windows in the 
Solaris/Netscape environment, look for a pop-up window that needs to be 
dismissed before proceeding further. 

■ Occasionally, on a Solaris OS v8.0 system, the java console process may die 
and cause Web Tools features to lock up. 
Workaround: Close all windows and restart the web browser.

■ Occasionally, on a Solaris OS v8.0 system, Netscape 4.75, Java Plug-in 
1.3.1_04 when adding a license, the pop-up confirmation window does not 
display the complete message. 
Workaround: Resize the pop-up confirmation window to view the entire 
message.
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Web Tools and the JRE
Listed below are the known limitations in Web Tools, relating to the JRE.

■ Under some circumstances, users may see a rectangular black area 
corresponding to an applet ICON graphic. 
Workaround: In the Solaris environment, this situation is sometimes 
traceable to a mismatch between the Java Plug-in and the version of Netscape. 
Ensure that the proper JRE has been installed and the correct version of 
Netscape is being executed. 

■ Older versions of the 1.2.2_02 and the 1.3.1 Java Plug-in for Solaris do not 
support creation of the Fabric Event display. 
Workaround: Ensure the correct JRE version that supplies the correct patch 
version of the Java Plug-in is installed.

■ The Refresh View button in Fabric View may start blinking 15 seconds after 
the fabric has been refreshed, when actually the fabric has not been changed. 
Workaround: Ensure the correct JRE version that supplies the correct patch 
version of the Java Plug-in is installed.

■ When using Java Plug-in v1.2.2_008, the jar_cache files can grow too large, 
and may make Web Tools not operate properly. 
Workaround: When using Web Tools with plug-in 1.2.2_008, occasionally 
go into the Temp folder, in Windows 2000 or Windows NT, and delete the 
jar_cache files created by the browser to cache applet information. The 
location of the temp files vary depending on which platform, browser and 
plug-in is used. Discuss with your system administrator where to locate these 
temp files and delete them.
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Web Tools and Firmware Download
There are multiple phases involved with firmware download and activation. When 
Web Tools reports that firmware download has been completed successfully, this 
indicates that a basic sanity check, package retrieval, package unloading, and 
verification was successful. 

Note:  Web Tools currently forces a full package install. To perform an incremental 
upgrade use the Fabric OS command line interface. 

A reboot is required to activate the newly downloaded firmware. The reboot is 
done automatically from the Web Tools user perspective and results in a loss of 
network connectivity with Web Tools. Web Tools screens will continue to be 
visible during the reboot, but not available. Wait approximately 10 minutes to 
ensure that all of the application windows have been restored. If Web Tools fails to 
respond after 20 minutes, you may need to close all Web Tools applications 
windows and restart them, or contact their system administrator for network 
assistance.

The Web Tools loss of network connectivity during a failover or reboot (initiated 
though the firmwaredownload) varies for different configurations:

■ Core Switch 2/64 with dual CP—loss of network connectivity due to failover 
is approximately 1 minute.

■ Core Switch 2/64 with single CP—loss of network connectivity due to reboot 
is approximately 4 minutes if diagpost is disabled and up to 16 minutes if 
diagpost is enabled.

■ SAN Switch 2/32—loss of network connectivity due to reboot is 
approximately 4 minutes if diagpost is disabled and 8 minutes if 
diagpost is enabled.
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glossary

Glossary
Glossary

This glossary defines terms used in this guide or related to this product and is not 
a comprehensive glossary of computer terms.

16-port card
The Fibre Channel port card provided with the StorageWorks Core switch. Contains 16 Fibre 
Channel ports and the corresponding LEDs indicating port status and speed. 

See also port card.

8b/10b Encoding
An encoding scheme that converts each 8-bit byte into 10 bits. Used to balance ones and zeros in 
high-speed transports.

Access Control List
Enables an organization to bind a specific WWN to a specific switch port or set of ports, preventing 
a port in another physical location from assuming the identity of a real WWN. May also refer to a 
list of the Read/Write access of a particular community string. 

See also device connection controls. 

Account Level Switches
Refers to switches that have four login accounts into the operating system (in descending order): 
root, factory, admin, and user. 

See also root account, factory account, admin account, and user account.

Address Identifier
A 24-bit or 8-bit value used to identify the source or destination of a frame.

Admin Account
A login account intended for use by the customer to control switch operation.

See also account level switches.

AL_PA
Arbitrated Loop Physical Address. A unique 8-bit value assigned during loop initialization to a 
port in an arbitrated loop.
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Alias
An alternate name for an element or group of elements in the fabric. Aliases can be used to 
simplify the entry of port numbers and WWNs when creating zones.

Alias Address Identifier
An address identifier recognized by a port in addition to its standard identifier. An alias address 
identifier may be shared by multiple ports. 

See also alias.

Alias AL_PA
An AL_PA value recognized by an L_Port in addition to the AL_PA assigned to the port. 

See also AL_PA.

Alias Server
A fabric software facility that supports multicast group management.

ANSI
American National Standards Institute. The governing body for Fibre Channel standards in the 
U.S.A.

API
Application Programming Interface. Defined protocol that allows applications to interface with a 
set of services.

Arbitrated Loop
A shared 100 or 200 MBps Fibre Channel transport structured as a loop. Can support up to 126 
devices and one fabric attachment. 

See also topology.

Arbitrating State
The state in which a port has become the loop master. This state is only available from the Open 
state.

Area Number
A number assigned to each potential port location in the StorageWorks Core switch. Used to 
distinguish StorageWorks Core switch ports that have the same port number but are on different 
port blades.

ASIC
Application Specific Integrated Circuit.
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ATM
Asynchronous Transfer Mode. A transport used for transmitting data over LANs or WANs that 
transmit fixed-length units of data. Provides any-to-any connectivity, and allows nodes to transmit 
simultaneously.

Auto-negotiate Speed
Process that allows two devices at either end of a link segment to negotiate common features, speed 
(e.g., 1 or 2 Gbps) and functions.

Autosense
Process during which a network device automatically senses the speed of another device.

AW_TOV
Arbitration Wait Time-out Value. The minimum time an arbitrating L_Port waits for a response 
before beginning loop initialization.

Backup FCS Switch
Backup fabric configuration server switch. The switch or switches assigned as backup in case the 
primary FCS switch fails. 

See also FCS switch, primary FCS switch.

Bandwidth
The total transmission capacity of a cable, link, or system. Usually measured in bps (bits per 
second). May also refer to the range of transmission frequencies available to a network. 

See also throughput.

BB_Credit
Buffer-to-buffer credit. The number of frames that can be transmitted to a directly connected 
recipient or within an arbitrated loop. Determined by the number of receive buffers available. 

See also Buffer-to-buffer Flow Control, EE_Credit.

Beacon
When all the port LEDs on a switch are set to flash from one side of the switch to the other, to 
enable identification of an individual switch in a large fabric. A switch can be set to beacon by 
telnet command or through Web Tools.

Beaconing
The state of the switches LEDs when the switch is set to Beacon. 

See also Beacon.
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Beginning Running Disparity
The disparity at the transmitter or receiver when the special character associated with an ordered 
set is encoded or decoded. 

See also disparity.

BER
Bit Error Rate. The rate at which bits are expected to be received in error. Expressed as the ratio of 
error bits to total bits transmitted. 

See also error.

BISR
Built-In Self Repair. Refers to the range of algorithms and circuit techniques to replace fault 
elements in a VLSI circuit with redundant fault-free ones.

See also BIST, CMBISR.

BIST
Built-In Self Test. The technique of designing circuits with additional logic which can be used to 
test proper operation of the primary (functional) logic. 

See also BISR, CMBISR.

Bit Synchronization
See BER.

Blade
See 16-port card.

Blind-mate Connector
A two-way connector used in some switches to provide a connection between the motherboard and 
the power supply.

Block
As applies to Fibre Channel, upper-level application data that is transferred in a single sequence.

Blower Assembly
A fan that prevents a switch (or individual elements within a switch) from overheating.

Boot Flash
Flash memory that stores the boot code and boot parameters. The processor executes its first 
instructions from boot flash. Data is cached in RAM.
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Boot Monitor
Code used to initialize the CP (control processor) environment after powering on. Identifies the 
amount of memory available and how to access it, and retrieves information about system buses.

Broadcast
The transmission of data from a single source to all devices in the fabric, regardless of zoning. 

See also multicast, unicast.

Buffer-to-buffer Flow Control
Management of the frame transmission rate in either a point-to-point topology or in an arbitrated 
loop. 

See also BB_Credit.

Cascade
Two or more interconnected Fibre Channel switches. StorageWorks 1 Gb SAN switches (running 
Fabric OS V2) and later can be cascaded up to 239 switches, with a recommended maximum of 
seven interswitch links (no path longer than eight switches). 

See also fabric, ISL.

Chassis
The metal frame in which the switch and switch components are mounted. 

Circuit
An established communication path between two ports. Consists of two virtual circuits capable of 
transmitting in opposite directions. 

See also link.

Class 1
Service that provides a dedicated connection between two ports (also called connection-oriented 
service), with notification of delivery or non-delivery.

Class 2
Service that provides multiplex and connectionless frame switching service between two ports, 
with notification of delivery or non-delivery. 

Class 3
Service that provides a connectionless frame switching service between two ports, without 
notification of delivery or non-delivery of data. This service can also be used to provide a multicast 
connection between the originator and recipients, with notification of delivery or non-delivery.
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Class F
Connectionless service for control traffic between switches, with notification of delivery or 
non-delivery of data between the E_Ports.

Class of Service
A specified set of delivery characteristics and attributes for frame delivery.

CLI
Command line interface. Interface that depends entirely on the use of commands, such as through 
telnet or SNMP, and does not involve a Graphic User Interface (GUI).

CLS
Close Primitive Signal. Only in an Arbitrated Loop; sent by an L_Port that is currently 
communicating on the loop, to close communication to an other L_Port.

CMBISR
Central Memory Built-In Self Repair. Test and repair bad cells in the central memory. If a "fail" is 
reported, inform Tech Support and replace the board.

See also BIST, BISR.

Comma
A unique pattern (either 1100000 or 0011111) used in 8b/10b encoding to specify character 
alignment within a data stream. 

See also K28.5.

Community (SNMP)
A relationship between a group of SNMP managers and an SNMP agent, in which authentication, 
access control, and proxy characteristics are defined. 

See also SNMP.

Compact Flash
Flash memory that stores the run-time operating system and is used like hard disk storage. Not 
visible within the processor's memory space. Data is stored in file system format.
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Configuration
How a system is set up. May refer to hardware or software.

■ Hardware: The number, type, and arrangement of components that make up a system or 
network. 

■ Software: The set of parameters that guide switch operation. May include general system 
parameters, IP address information, Domain ID, and other information. Modifiable by any 
login with administrative privileges. 

May also refer to a set of zones. 

See also zone configuration.

Connection Initiator
A port that has originated a Class 1 dedicated connection and received a response from the 
recipient.

Connection Recipient
A port that has received a Class 1 dedicated connection request and transmitted a response to the 
originator.

Control Panel
Refers to the left-side panel of Web Tools, which accesses fabric-wide functions such as Zoning 
and Events.

Core Switch
A switch whose main task is to interconnect other switches. 

See also SAN switch.

CP Card
Control Processor Card. The central processing unit of the StorageWorks Core switch, which 
contains two CP Card slots to provide redundancy. Provides Ethernet, serial, and modem ports with 
the corresponding LEDs.

CRC
Cyclic Redundancy Check. A check for transmission errors included in every data frame.

Credit
As applies to Fibre Channel, the number of receive buffers available for transmission of frames 
between ports. 

See also BB_Credit, EE_Credit.
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CT_HDR
Common Transport Header. A header that conforms to the Fibre Channel Common Transport 
(FC_CT) protocol.

CT_IU
Common Transport Information Unit. An information unit that conforms to the Fibre Channel 
Common Transport (FC_CT) protocol.

Current Fill Word
The fill word currently selected by the LPSM. 

See also fill word, LPSM.

Cut-through
A switching technique that allows the route for a frame to be selected as soon as the destination 
address is received. 

See also route.

Data Word
Type of transmission word that occurs within frames. The frame header, data field, and CRC all 
consist of data words. 

See also frame, ordered set, transmission word.

DB-9 connector
A 9-pin version of the RS-232C port interface. May be either the male of female interface. 

See also RS-232 port.

dBm
Logarithmic unit of power used in electronics. Indicates signal strength in decibels above the 
reference level, which is 1 milliwatt for dBm. An increase of 10 dBm or represents a 10-fold 
increase in power.

DCE port
A data communications equipment port capable of interfacing between a DTE (data terminal 
equipment) port and a transmission circuit. DTE devices with an RS-232 (or EIA-232) port 
interface transmit on pin 3, and receive on pin 2. 

See also DTE port, RS-232 port.

Defined Zone Configuration
The set of all zone objects defined in the fabric. May include multiple zone configurations. 

See also enabled zone configuration, zone configuration.
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Device Connection Controls
Enables organizations to bind an individual device port to a set of one or more switch ports. Device 
ports are specified by a WWN and typically represent HBAs (servers). 

See also access control lists.

Device
A disk, a RAID, or an HBA.

Disparity
The relationship of ones and zeros in an encoded character. “Neutral disparity” means an equal 
number of each, “positive disparity” means a majority of ones, and “negative disparity” means a 
majority of zeros.

DLS
Dynamic Load Sharing. Dynamic distribution of traffic over available paths. Allows for 
recomputing of routes when an Fx_Port or E_Port changes status.

Domain ID
As applies to HP StorageWorks switches, a unique number between 1 and 239 that identifies the 
switch to the fabric and is used in routing frames. Usually automatically assigned by the switch, but 
can be manually assigned.

DTE port
A data terminal equipment port capable of interfacing to a transmission circuit through a 
connection to a DCE (data communications equipment) port. DTE devices with an RS-232 (or 
EIA-232) port interface transmit on pin 3, and receive on pin 2 in a 9-pin connector (reversed in 
25-pin connectors). 

See also DCE port, RS-232 port.

DWDM
Dense Wavelength Multiplexing. A means to concurrently transmit more than one stream of data 
through a single fiber by modulating each stream of data onto a different wavelength of light.

E_D_TOV
Error Detect Time-out Value. The minimum amount of time a target waits for a sequence to 
complete before initiating recovery. Can also be defined as the maximum time allowed for a 
round-trip transmission before an error condition is declared. 

See also R_A_TOV, RR_TOV.
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E_Port
Expansion Port. A type of switch port that can be connected to an E_Port on another switch to 
create an ISL. 

See also ISL.

EE_Credit
End-to-end Credit. The number of receive buffers allocated by a recipient port to an originating 
port. Used by Class 1 and 2 services to manage the exchange of frames across the fabric between 
source and destination. 

See also End-to-end Flow Control, BB_Credit.

EIA Rack
A storage rack that meets the standards set by the Electronics Industry Association.

ELWL
Extra Long Wavelength. Laser light with a periodic length greater than 1300 nm (e.g., 1420 or 
1550). ELWL lasers are used to transmit Fibre Channel data over distances greater than 10 Km. 

Also known as XLWL.

Enabled Zone Configuration
The currently enabled zone configuration. Only one configuration can be enabled at a time. 

See also defined zone configuration, zone configuration.

End-to-end Flow Control
Governs flow of class 1 and 2 frames between N_Ports. 

See also EE_Credit.

Entry Fabric
Basic HP license that allows one E_Port per switch. Not supported by StorageWorks Core 
switches.

Error
As applies to Fibre Channel, a missing or corrupted frame, time-out, loss of synchronization, or 
loss of signal (link errors). 

See also loop failure.

ESD
Electrostatic Discharge.



Glossary

281Web Tools Version 3.1.x/4.1.x User Guide

Exchange
The highest level Fibre Channel mechanism used for communication between N_Ports. Composed 
of one or more related sequences, and can work in either one or both directions.

Extended Fabric
An HP product that runs on Fabric OS and allows creation of a Fibre Channel fabric interconnected 
over distances of up to 100 kilometers.

Extended Fabric is a means of allowing the implementation and management of SANs over 
extended distances. This is achieved by adjusting the Buffer-to-Buffer Credits to guaranteed 
allocation of buffers to specific ports.

F_Port
Fabric Port. A port that is able to transmit under fabric protocol and interface over links. Can be 
used to connect an N_Port to a switch. 

See also FL_Port, Fx_Port.

Fabric
A Fibre Channel network containing two or more interconnected switches in addition to hosts and 
devices. May also be referred to as a switched fabric. 

See also topology, SAN, cascade.

Fabric Access
An HP product that consists of a set of APIs that allow third party applications to interface with 
Fabric OS. 

Fabric Access allows the application to control the fabric directly for functions such as discovery, 
access (zoning), management, performance, and switch control. Consists of a host-based library 
that interfaces the application to switches in the fabric over an out-of-band TCP/IP connection or 
in-band using an IP-capable Host Bus Adapter (HBA).

Fabric Assist
An HP feature that enables private and public hosts to access public targets anywhere on the fabric, 
provided they are in the same Fabric Assist zone. This feature is available only when both 
QuickLoop and Zoning are installed on the switch. 

Fabric Assist is a means of allowing private hosts to communicate with public targets across a 
switched fabric. Fabric Assist also allows private hosts to communicate with private targets that are 
not resident on the same switch across a switched fabric. 

See also QuickLoop.
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Fabric Configuration Server
One or more designated HP switches that store and manage the configuration and security 
parameters for all other switches in the fabric. These switches are designated by WWN, and the list 
of designated switches is known fabric-wide.

Fabric Manager
An HP product that works in conjunction with Web Tools to provide a graphical user interface for 
managing switch groups (such as the SAN Switch Integrated/32) as a single unit, instead of as 
separate switches. Fabric Manager is installed on and run from a computer workstation. 

Fabric Name
The unique identifier assigned to a fabric and communicated during login and port discovery.

Fabric OS
The proprietary operating system on HP StorageWorks switches.

Fabric Watch
An HP product that runs on Fabric OS and allows monitoring and configuration of fabric and 
switch elements. 

Allows the SAN manager to monitor key fabric and switch elements, making it easy to quickly 
identify and escalate potential problems. It monitors each element for out-of-boundary values or 
counters and provides notification when defined boundaries are exceeded. The SAN manager can 
configure which elements, such as error, status, and performance counters, are monitored within an 
HP switch. 

See also Fabric Manager.

Factory Account
A login used during manufacturing to initialize and test a switch and is not intended for customer 
use. 

See also account level switches.

Failover
The act that causes control to pass from one redundant unit to another. In the StorageWorks Core 
switch one may failover from the currently Active Control Processor (CP) to the Standby CP. 

FAN
Fabric access notification. Retains the AL_PA and fabric address when loop re-initializes (if the 
switch supports FAN).

FC-AL-3
The Fibre Channel Arbitrated Loop standard defined by ANSI. Defined on top of the FC-PH 
standards.
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FC-FLA
The Fibre Channel Fabric Loop Attach standard defined by ANSI.

FCIA
Fibre Channel Industry Association. An international organization of Fibre Channel industry 
professionals. Among other things, provides oversight of ANSI and industry developed standards.

FCP
Fibre Channel Protocol. Mapping of protocols onto the Fibre Channel standard protocols. For 
example, SCSI FCP maps SCSI-3 onto Fibre Channel.

FC-PH-1, 2, 3
The Fibre Channel Physical and Signaling Interface standards defined by ANSI.

FC-PI
The Fibre Channel Physical Interface standard defined by ANSI.

FC-PLDA
The Fibre Channel Private Loop Direct Attach standard defined by ANSI. Applies to the operation 
of peripheral devices on a private loop.

FCS switch
Fabric configuration server switch. One or more designated HP switches that store and manage the 
configuration and security parameters for all switches in the fabric. FCS switches are designated by 
WWN, and the list of designated switches is communicated fabric-wide. 

See also backup FCS switch, primary FCS switch.

FC-SW-2
The second generation of the Fibre Channel Switch Fabric standard defined by ANSI. Specifies 
tools and algorithms for the interconnection and initialization of Fibre Channel switches in order to 
create a multi-switch Fibre Channel fabric. 

Fibre Channel Transport
A protocol service that supports communication between Fibre Channel service providers. 

See also FSP.

FIFO
First In, First Out. May also refer to a data buffer that follows the first in, first out rule.

Fill Word
An IDLE or ARB ordered set that is transmitted during breaks between data frames to keep the 
Fibre Channel link active. 
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Firmware Download
Loading firmware down from a server into a switch.

Firmware
The basic operating system provided with the hardware.

FL_Port
Fabric Loop Port. A port that is able to transmit under fabric protocol and also has arbitrated loop 
capabilities. Can be used to connect an NL_Port to a switch. 

See also F_Port, Fx_Port.

Flash Partition
Two redundant usable areas, called “partitions,” into which firmware can be downloaded in the 
StorageWorks Core switch.

Flash
Programmable NVRAM memory that maintains its contents.

FLOGI
Fabric Login. The process by which an N_Port determines whether a fabric is present, and if so, 
exchanges service parameters with it. 

See also PLOGI.

Frame
The Fibre Channel structure used to transmit data between ports. Consists of a start-of-frame 
delimiter, header, any optional headers, the data payload, a cyclic redundancy check (CRC), and an 
end-of-frame delimiter. There are two types of frames: Link control frames (transmission 
acknowledgements, etc.) and data frames. 

See also Data Word.

FRU
Field Replaceable Unit. A component that can be replaced on site.

FS_ACC
Fibre Channel Services Accept. The information unit used to indicate acceptance of a request for a 
Fibre Channel service.

FS_IU
Fibre Channel Services Information Unit. An information unit that has been defined by a Fibre 
Channel service.
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FS_REQ
Fibre Channel Services Request. A request for a Fibre Channel services function, or notification of 
a fabric condition or event.

FS_RJT
Fibre Channel Services Reject. An indication that a request for Fibre Channel services could not be 
processed.

FS
Fibre Channel Service. A service that is defined by Fibre Channel standards and exists at a 
well-known address. For example, the Simple Name Server is a Fibre Channel service. 

See also FSP.

FSPF
Fabric Shortest Path First. HP routing protocol for Fibre Channel switches.

FSP
Fibre Channel Service Protocol. The common protocol for all fabric services, transparent to the 
fabric type or topology. 

See also FS.

Full Fabric
The HP license that allows multiple E_Ports on a switch, making it possible to create multiple ISL 
links.

Full-duplex
A mode of communication that allows the same port to simultaneously transmit and receive 
frames. 

See also half-duplex.

Fx_Port
A fabric port that can operate as either an F_Port or FL_Port. 

See also F_Port, FL_Port.

G_Port
Generic Port. A port that can operate as either an E_Port or F_Port. A port is defined as a G_Port 
when it is not yet connected or has not yet assumed a specific function in the fabric.

Gateway
Hardware that connects incompatible networks by providing translation for both hardware and 
software. For example, an ATM gateway can be used to connect a Fibre Channel link to an ATM 
connection.
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GBIC
Gigabit interface converter. A removable serial transceiver module that allows gigabaud 
physical-level transport for Fibre Channel and gigabit Ethernet. Typically refers only to the 
SC-form factor transceivers. 

See also SFP.

Gbps
Gigabits per second (1,062,500,000 bits/second).

GBps
Gigabytes per second (1,062,500,000 bytes/second).

Half-duplex
A mode of communication that allows a port to either transmit or receive frames at any time, but 
not simultaneously (with the exception of link control frames, which can be transmitted at any 
time). 

See also full-duplex.

Hard Address
The AL_PA that an NL_Port attempts to acquire during loop initialization.

Hardware Translative Mode
A method for achieving address translation. The following two hardware translative modes are 
available to a QuickLoop-enabled switch:

■ Standard Translative Mode: Allows public devices to communicate with private devices that 
are directly connected to the fabric.

■ QuickLoop Mode: Allows initiator devices to communicate with private or public devices that 
are not in the same loop.

HBA
Host Bus Adapter. The interface card between a server or workstation bus and the Fibre Channel 
network.

High Availability
An attribute of equipment that identifies it as being capable of conducting customer operations well 
in excess of 99% of the time. Typically High Availability is identified by the number of nines in 
that percentage. “Five Nines” means the equipment is rated as being capable of conducting 
customer operations 99.999% of the time without failure.
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Host
A computer that accesses storage devices over the fabric. May also be referred to as a server. 

See also workstation. 

Hot Pluggable
A FRU capability that indicates it may be extracted or installed while customer data is otherwise 
flowing in the chassis.

Hub
A Fibre Channel wiring concentrator that collapses a loop topology into a physical star topology. 
Nodes are automatically added to the loop when active and removed when inactive.

IBTA
The InfiniBand Trade Association (IBTA). The IBTA is an industry consortium of more than 200 
companies working together to develop a new common I/O specification designed to bring greater 
scalability and performance to server I/O. InfiniBand defines a new channel based, switched-fabric 
technology for server-to-server and server-to-I/O interconnection that is expected to improve 
scalability and performance over existing PCI Bus technologies. 

Idle
Continuous transmission of an ordered set over a Fibre Channel link when no data is being 
transmitted, to keep the link active and maintain bit, byte, and word synchronization.

InfiniBand
See IBTA.

Initiator
A server or workstation on a Fibre Channel network that initiates communications with storage 
devices. 

See also Target.

Integrated Fabric
The fabric created by a SAN Switch Integrated/32 and SAN Switch Integrated/64, consisting of six 
SAN Switch 16-EL switches cabled together and configured to handle traffic as a seamless group.

IOD
In-order Delivery. A parameter that, when set, guarantees that frames are either delivered in order 
or dropped.

IPA
Initial Process Associator. An identifier associated with a process at an N_Port.
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Isolated E_Port
An E_Port that is online but not operational due to overlapping Domain IDs or nonidentical 
parameters (such as E_D_TOVs). 

See also E_Port.

ISL
Interswitch Link. a Fibre Channel link from the E_Port of one switch to the E_Port of another. 

See also E_Port, cascade, ISL Trunking.

ISL Trunking
An HP feature that enables distribution of traffic over the combined bandwidth of up to four ISLs 
(between adjacent switches), while preserving in-order delivery. A set of trunked ISLs is called a 
trunking group; each port employed in a trunking group is called a trunking port. 

See also Master Port.

IU
Information Unit. A set of information as defined by either upper-level process protocol definition 
or upper-level protocol mapping.

JBOD
Just a Bunch Of Disks. Indicates a number of disks connected in a single chassis to one or more 
controllers. 

See also RAID.

K28.5
A special 10-bit character used to indicate the beginning of a transmission word that performs 
Fibre Channel control and signaling functions. The first seven bits of the character are the comma 
pattern. 

See also comma.

Kernel Flash
Flash memory that stores the bootable kernel code and is visible within the processor's memory 
space. Data is stored as raw bits.

Key Pair
In public key cryptography, a pair of keys consisting of an entity's public and private key. The 
public key can be publicized, but the private key must be kept secret. 
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L_Port
Loop Port. A node port (NL_Port) or fabric port (FL_Port) that has arbitrated loop capabilities. An 
L_Port can be in one of two modes:

■ Fabric mode: Connected to a port that is not loop capable, and using fabric protocol.

■ Loop mode: In an arbitrated loop and using loop protocol. An L_Port in loop mode can also be 
in participating mode or non-participating mode. 

See also Non-participating Mode, Participating Mode.

Latency
The period of time required to transmit a frame, from the time it is sent until it arrives. Together, 
latency and bandwidth define the speed and capacity of a link or system.

LED
Light Emitting Diode. Used on HP switches to indicate the status of various switch elements.

Link Services
A protocol for link-related actions.

Link
As applies to Fibre Channel, a physical connection between two ports, consisting of both transmit 
and receive fibers. 

See also Circuit.

LIP
Loop Initialization Primitive. The signal used to begin initialization in a loop. Indicates either loop 
failure or resetting of a node.

LIS_HOLD_TIME
Loop Initialization Sequence Hold Time. The maximum period of time for a node to forward a 
loop initialization sequence.

LM_TOV
Loop Master Time-out Value. The minimum time that the loop master waits for a loop initialization 
sequence to return.

Login BB_Credit
The number of receive buffers a receiving L_Port has available when a circuit is first established. 

See also BB_Credit.

Loop Circuit
A temporary bidirectional communication path established between L_Ports.
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Loop Failure
Loss of signal within a loop for any period of time, or loss of synchronization for longer than the 
time-out value. 

See also error.

Loop Initialization
The logical procedure used by an L_Port to discover its environment. Can be used to assign AL_PA 
addresses, detect loop failure, or reset a node.

Loop_ID
A hex value representing one of the 127 possible AL_PA values in an arbitrated loop. 

Looplet
A set of devices connected in a loop to a port that is a member of another loop.

LPSM
Loop Port State Machine. The logical entity that performs arbitrated loop protocols and defines the 
behavior of L_Ports when they require access to an arbitrated loop.

LWL
Long Wavelength. A type of fiber optic cabling that is based on 1300-mm lasers and supports link 
speeds of 1.0625 Gbps. May also refer to the type of GBIC or SFP. 

See also SWL.

Master Port
As relates to trunking, the port that determines the routing paths for all traffic flowing through the 
trunking group. One of the ports in the first ISL in the trunking group is designated as the master 
port for that group. 

See also ISL Trunking.

Media
See transceiver.

MIB
Management Information Base. An SNMP structure to help with device management, providing 
configuration and device information.



Glossary

291Web Tools Version 3.1.x/4.1.x User Guide

Modem Serial Port 
The upper serial port on the CP Card of the StorageWorks Core switch. Can be used to connect the 
CP Card to a modem with a standard 9-pin modem cable. Consists of a DB-9 connector wired as a 
RS-232 device, and can be connected by serial cable to a DCE device. A Hayes-compatible modem 
or Hayes-emulation is required. The device name is ttyS1. 

See also DB-9 connector, DCE port, terminal serial port.

Monitoring State
The state in which a port is monitoring the flow of information for data relevant to the port.

Multicast
The transmission of data from a single source to multiple specified N_Ports (as opposed to all the 
ports on the network). 

See also broadcast, unicast.

Multimode
A fiber optic cabling specification that allows up to 500 meters between devices for 1 Gb, or 300 
meters between devices for 2 Gb.

N_Port
Node Port. A port on a node that can connect to a Fibre Channel port or to another N_Port in a 
point-to-point connection. 

See also NL_Port, Nx_Port.

NAA
Network Address Authority. An identifier that indicates the format of a network address.

Name Server
Frequently used to indicate Simple Name Server. 

See also SNS.

Native Address Identifier
A unique, 64-bit address is assigned to each port, and is referred to as its World-Wide Name 
(WWN). If a port connects to an arbitrated loop, it will also be assigned a dynamic 8-bit address, 
referred to as its arbitrated loop physical address, or AL_PA. If it connects to a fabric, it will be 
assigned a dynamic 24-bit address, referred to as its Native Address Identifier. 

Negotiate
See auto-negotiate speed and autosense. 
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NL_Port
Node Loop Port. A node port that has arbitrated loop capabilities. Used to connect an equipment 
port to the fabric in a loop configuration through an FL_Port. 

See also N_Port, Nx_Port.

Node Name
The unique identifier for a node, communicated during login and port discovery.

Node
A Fibre Channel device that contains an N_Port or NL_Port.

Non-participating Mode
A mode in which an L_Port in a loop is inactive and cannot arbitrate or send frames, but can 
retransmit any received transmissions. This mode is entered if there are more than 127 devices in a 
loop and an AL_PA cannot be acquired. 

See also L_Port, Participating Mode.

Nx_Port
A node port that can operate as either an N_Port or NL_Port.

Open Originator
The L_Port that wins arbitration in an arbitrated loop and sends an OPN ordered set to the 
destination port, then enters the Open state.

Open Recipient
The L_Port that receives the OPN ordered set from the open originator, and then enters the Open 
state.

Open State
The state in which a port can establish a circuit with another port. A port must be in the Open state 
before it can arbitrate.

OPN
Open Primitive Signal. 
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Ordered Set
A transmission word that uses 8B/10B mapping and begins with the K28.5 character. Ordered sets 
occur outside of frames, and include the following items:

■ Frame delimiters: Mark frame boundaries and describe frame contents.

■ Primitive signals: Indicate events.

■ Primitive sequences: Indicate or initiate port states.

Ordered sets are used to differentiate Fibre Channel control information from data frames and to 
manage the transport of frames.

Packet
A set of information transmitted across a network. 

See also Frame.

Participating Mode
A mode in which an L_Port in a loop has a valid AL_PA and can arbitrate, send frames, and 
retransmit received transmissions. 

See also L_Port, Non-participating Mode.

Path Selection
The selection of a transmission path through the fabric. HP StorageWorks switches use the FSPF 
protocol.

Performance Monitor
Comprehensive HP tool for monitoring the performance of networked storage resources.

Performance Monitoring
An HP product that provides error and performance information to the administrator and end user 
for use in storage management.

Phantom Address
An AL_PA value that is assigned to an device that is not physically in the loop. 

Also known as phantom AL_PA.

Phantom Device
A device that is not physically in an arbitrated loop, but is logically included through the use of a 
phantom address.

PLOGI
Port Login. The port-to-port login process by which initiators establish sessions with targets. 

See also FLOGI.
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Point-to-point
A Fibre Channel topology that employs direct links between each pair of communicating entities. 

See also topology.

Port Cage
The metal casing extending out of the optical port on the switch, and in which the SFP can be 
inserted.

Port Card
A Fibre Channel card that contains optical or copper port interfaces, and acts like a switch module. 

See also 16-port card.

Port Module
A collection of ports in a switch.

Port_Name
The unique identifier assigned to a Fibre Channel port. Communicated during login and port 
discovery.

POST
Power On Self-Test. A series of tests run by a switch after it is turned on.

Primary FCS Switch
Primary fabric configuration server switch. The switch that actively manages the configuration and 
security parameters for all switches in the fabric. 

See also backup FCS switch, FCS switch.

Private Device
A device that supports arbitrated loop protocol and can interpret 8-bit addresses, but cannot log 
into the fabric.

Private Loop
An arbitrated loop that does not include a participating FL_Port.

Private NL_Port
An NL_Port that communicates only with other private NL_Ports in the same loop and does not 
log into the fabric.

Protocol
A defined method and a set of standards for communication.

PSU
Power Supply Unit.
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Public Device
A device that supports arbitrated loop protocol, can interpret 8-bit addresses, and can log into the 
fabric.

Public Loop
An arbitrated loop that includes a participating FL_Port, and may contain both public and private 
NL_Ports.

Public NL_Port
An NL_Port that logs into the fabric, can function within either a public or a private loop, and can 
communicate with either private or public NL_Ports.

Quad
A group of four adjacent ports that share a common pool of frame buffers.

QuickLoop
An HP StorageWorks product that makes it possible to allow private devices within loops to 
communicate with public and private devices across the fabric through the creation of a larger loop.

May also refer to the arbitrated loop created using this software. A QuickLoop can contain a 
number of devices or looplets; all devices in the same QuickLoop share a single AL_PA space.

A means of allowing private hosts to communicate with private targets across a switched fabric. 

The QuickLoop/Fabric Assist feature also allows:

■ Private hosts to communicate with public targets across a switched fabric

■ Private hosts to communicate with private targets that are not resident on the same switch 
across a switched fabric

See also Fabric Access, fabric assist, and translative mode.

QuickLoop Zoning
Protects devices from disruption by unrelated devices during critical processes; for example, 
during a tape backup session.

R_A_TOV
Resource Allocation Time-out Value. The maximum time a frame can be delayed in the fabric and 
still be delivered. 

See also E_D_TOV, RR_TOV.

R_RDY
Receiver ready. A primitive signal indicating that the port is ready to receive a frame.
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RAID
Redundant Array of Independent Disks. A collection of disk drives that appear as a single volume 
to the server and are fault tolerant through mirroring or parity checking. 

See also JBOD.

Remote Fabric
A fabric that spans across WANs by using protocol translation (a process also known as tunneling) 
such as Fibre Channel over ATM or Fibre Channel over IP.

Remote Switch
Bridges two switches into a SAN as large as 3000KM or more through protocol encapsulation in 
ATM networks via the Computer Network Technologies (CNT) UltraNet Open Systems Gateway.

Request Rate
The rate at which requests arrive at a servicing entity. 

See also service rate.

RLS Probing
Read link status of the AL_PAs.

Root Account
A login used for debugging purposes by HP engineers and is not intended for customer use. 

See also account level switches.

Route
As applies to a fabric, the communication path between two switches. May also apply to the 
specific path taken by an individual frame, from source to destination. 

See also FSPF.

Routing
The assignment of frames to specific switch ports, according to frame destination.

RR_TOV
Resource Recovery Time-out Value. The minimum time a target device in a loop waits after a LIP 
before logging out a SCSI initiator. 

See also E_D_TOV, R_A_TOV.

RS-232 port
A port that conforms to a set of Electrical Industries Association (EIA) standards. Used to connect 
DTE and DCE devices for communication between computers, terminals, and modems. 

See also DCE port, DTE port.
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RSCN
Registered State Change Notification. A switch function that allows notification of fabric changes 
to be sent from the switch to specified nodes.

RX_ID
Responder Exchange Identifier. A 2-byte field in the frame header used by the responder of the 
Exchange to identify frames as being part of a particular exchange.

SAN
Storage Area Network. A network of systems and storage devices that communicate using Fibre 
Channel protocols. 

See also fabric.

SAN Switch
A switch whose main task is to connect nodes into the fabric. 

See also core switch.

SCSI
Small Computer Systems Interface. A parallel bus architecture and protocol for transmitting large 
data blocks to a distance of 15 - 25 meters.

SDRAM
Synchronous Dynamic Random Access Memory. The main memory for the switch. Used for 
volatile storage during switch operation. 

See also flash.

Sequence
A group of related frames transmitted in the same direction between two N_Ports.

Service Rate
The rate at which an entity can service requests. 

See also request rate.

SFF
Small Form Factor.

SFP Cable
The latest innovation in high-speed copper cabling for Fibre Channel and InfiniBand. It 
incorporates the SFP module directly onto the cable assembly, eliminating the need for a separate 
SFP copper module and an HSSDC2 cable assembly. 
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SFP
Small form factor pluggable. A transceiver used on 2 Gbps switches that replaces the GBIC. Refers 
to the LC-form factor transceiver. 

See also GBIC.

SID/DID
Source identifier/Destination identifier. S_ID is a 3-byte field in the frame header that is used to 
indicate the address identifier of the N_Port from which the frame was sent.

Single Mode
The fiber optic cabling standard that, when used in conjunction with a 1300 nm laser light, can 
transfer data up to 10 km between devices. When used in conjunction with a 1550 nm laser light, 
single mode cabling can transfer data over 10 km. 

See also multimode, LWL, ELWL, and XLWL.

SI
Sequence Initiative.

SNMP
Simple Network Management Protocol. An internet management protocol that uses either IP for 
network-level functions and UDP for transport-level functions, or TCP/IP for both. Can be made 
available over other protocols, such as UDP/IP, because it does not rely on the underlying 
communication protocols. 

See also Community (SNMP).

SNMPv1
The original SNMP, now labeled v1.

SNS
Simple Name Server. A switch service that stores names, addresses, and attributes for up to 15 
minutes, and provides them as required to other devices in the fabric. SNS is defined by Fibre 
Channel standards and exists at a well-known address. May also be referred to as directory service. 

See also FS.

StorageWorks SAN switch
The brand name for the HP family of switches.

Switch Name
The arbitrary name assigned to a switch.

Switch Port
A port on a switch. Switch ports can be E_Ports, F_Ports, or FL_Ports.
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Switch
Hardware that routes frames according to Fibre Channel protocol and is controlled by software.

SWL
Short Wavelength. A type of fiber optic cabling that is based on 850-mm lasers and supports 
1.0625-Gbps link speeds. May also refer to the type of GBIC or SFP. 

See also LWL.

Tachyon
A chip developed by Hewlett-Packard, and used in various devices. This chip has FC-0 through 
FC-2 on one chip.

Target
A storage device on a Fibre Channel network. 

See also Initiator.

Tenancy
The time from when a port wins arbitration in a loop until the same port returns to the monitoring 
state. Also referred to as loop tenancy.

Terminal Serial Port
May also be referred to as the console port. The lower serial port on the CP Card of the 
StorageWorks Core switch. This port sends switch information messages and can receive 
commands. Can be used to connect the CP Card to a computer terminal. Has an RS-232 connector 
wired as a DTE device, and can be connected by serial cable to a DCE device. The connector pins 
two and three are swapped so that a straight-through cable can be used to connect to a terminal. 
The device name is ttyS0. 

See also DCE port, modem serial port.

Throughput
The rate of data flow achieved within a cable, link, or system. Usually measured in bps (bits per 
second). 

See also bandwidth.

Topology
As applies to Fibre Channel, the configuration of the Fibre Channel network and the resulting 
communication paths allowed. There are three possible topologies:

■ Point to point: A direct link between two communication ports.

■ Switched fabric: Multiple N_Ports linked to a switch by F_Ports.

■ Arbitrated loop: Multiple NL_Ports connected in a loop.
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Transceiver
Device that converts one form of signaling to another for transmission and reception; in fiber 
optics, it refers to optical and electrical.

Transfer State
The state in which a port can establish circuits with multiple ports without reentering the 
arbitration cycle for each circuit. This state can only be accessed by an L_Port in the Open state.

Translative Mode
A mode in which private devices can communicate with public devices across the fabric.

Transmission Character
A 10-bit character encoded according to the rules of the 8B/10B algorithm.

Transmission Word
A group of four transmission characters. 

See also data word.

Trap (SNMP)
The message sent by an SNMP agent to inform the SNMP management station of a critical error. 

See also SNMP.

Trunking
See ISL Trunking.

Tunneling
A technique for enabling two networks to communicate when the source and destination hosts are 
both on the same type of network, but are connected by a different type of network.

U_Port
Universal Port. A switch port that can operate as a G_Port, E_Port, F_Port, or FL_Port. A port is 
defined as a U_Port when it is not connected or has not yet assumed a specific function in the 
fabric.

UDP
User Datagram Protocol. A protocol that runs on top of IP and provides port multiplexing for 
upper-level protocols.

ULP_TOV
Upper-level Time-out Value. The minimum time that a SCSI ULP process waits for SCSI status 
before initiating ULP recovery.
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ULP
Upper-level Protocol. The protocol that runs on top of Fibre Channel. Typical upper-level protocols 
are SCSI, IP, HIPPI, and IPI.

Unicast
The transmission of data from a single source to a single destination. 

See also broadcast, multicast.

user account
A login intended for use by the customer to monitor, but not control, switch operation. 

See also account level switches.

VC
Virtual circuit. A one-way path between N_Ports that allows fractional bandwidth.

Web Tools
An HP product that runs on Fabric OS and provides a graphical interface to allow monitoring and 
management of individual switches or entire fabrics from a standard workstation running a 
browser.

Well-known Address
As pertaining to Fibre Channel, a logical address defined by the Fibre Channel standards as 
assigned to a specific function, and stored on the switch.

Workstation
A computer used to access and manage the fabric. May also be referred to as a management station 
or host.

WWN
World-Wide Name. An identifier that is unique worldwide. Each entity in a fabric has a separate 
WWN.

XLWL
Xtra Long Wave Length. Laser light with a periodic length greater than 1300 nm (e.g., 1420 or 
1550). XLWL lasers are used to transmit Fibre Channel data over distances greater than 10 Km. 

Also known as ELWL.

Xmitted Close State
The state in which an L_Port cannot send messages, but can retransmit messages within the loop. 
A port in the XMITTED CLOSE state cannot attempt to arbitrate.
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Zone
A set of devices and hosts attached to the same fabric and configured as being in the same zone. 
Devices and hosts within the same zone have access permission to others in the zone, but are not 
visible to any outside the zone. 

See also Zoning.

Zone Alias
A name assigned to a device or group of devices in a zone. Aliases can greatly simplify the zone 
administrative process. 

See also alias.

Zone Configuration
A specified set of zones. Enabling a configuration enables all zones in that configuration. 

See also defined zone configuration, enabled zone configuration.

Zone Member
A port, node, WWN, or alias, which is part of a zone.

Zone Schemes
The level of zoning granularity selected. For example, zoning may be done by switch/port, WWN, 
AL_PA, or a mixture. 

See also zone configuration.

Zone Set
See zone configuration.

Zoning
An HP product that runs on Fabric OS and allows partitioning of the fabric into logical groupings 
of devices. Devices in a zone can only access and be accessed by devices in the same zone. 

See also zone.
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